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1 Introduction

An optimum utilization of  machinery is  only possible  with  maximum availability.  One condition  for  this  is  a  continuous
monitoring  of  its  condition  to  detect  errors  or  damage  as  early  as  possible.  The  most  common  method  is  vibration
monitoring.

Machine  noises  are  hereby  recorded  with  a  sensor  and  evaluated  in  a  vibration  monitor.  In  conventional  vibration
monitors a mean value is formed from the broad band vibration signal, e. g. the RMS-value (root mean square). If this
exceeds a pre-defined limit an alarm is triggered.

Principle of a simple vibration monitoring

This type of vibration monitoring is not enough to reliably monitor the condition of complex machines with a number of
components since a change in the broad band RMS only occurs in the final stage of damage. Moreover, this method is
not effective with changing speeds.

An early detection of damage is only possible by frequency-selective monitoring since small  damages or errors cause
an increase in amplitude of individual characteristic frequencies. A rise in broad band characteristic values normally only
occurs in the final stage of damage. This is then often too late to plan any maintenance work. The machine has to be
switched  off  immediately.  This  type  of  unforeseeable  shutdown  frequently  entails  high  standstill  costs.  Frequency-
selective  monitoring  is  thus  the  only  way  to  implement  a  condition-based  maintenance.  The  frequency-selective
approach allows the specific monitoring of selected machine parts. This permits a differentiated vibration monitoring.

The  FAG Industrial  Services  GmbH online  monitoring  systems can  thus  be  used  to  monitor  not  only  overall  vibration
levels but  also freely adjustable frequency bands.  Characteristic  values are hereby calculated in  the frequency bands
and  compared  to  alarm  limits.  A  speed  or  load-dependent  monitoring  of  frequency  bands  and  their  alarm  limits  is
possible depending on the module version.

The online systems perform autonomous monitoring and output an alarm when appropriate. The systems are configured
with a control  computer via a  serial  interface.  The Administrator  software  is  used for  this  purpose and also allows
you to load the measuring values and trend data stored in the online system on to the control computer, save them in a
database, and display them graphically.
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Introduction

About this manual

In this manual the

principle of vibration monitoring used by the FAG Dtect X1s, FAG WiPros and FAG ProCheck device and

the functions of the FAG Administrator software

are explained. 

Symbols

In this manual the following symbols are used:

This icon indicates

helpful additional information and

Device settings or application tips that help you perform tasks more efficiently.

Cross  reference  symbol :  This  symbol  refers  to  a  manual  page  containing  further  information.  When  reading  the
manual in PDF format on the computer screen you can jump to that page by simply clicking on the word to the left of the
symbol.

7
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2 About the Administrator software

Data flow between the Administrator software components

For  convenient  and  comprehensive  configuration,  for  reading  out  current  characteristic  values  and  alarm  statuses  as
well as signals obtained from the vibration measurement system for the purposes of analysis you will require an external
computer with the Administrator software installed. The Administrator software incorporates the following components:

FAGConfiguration  Manager:  The  Configuration  Manager  serves  as  a  central  control  station  on  the  external
computer for the administration of devices, device and monitoring configurations, and managing measuring data and
users.  The  Configuration  Manager  can  manage  multiple  Dtect  X1s  or  ProCheck  devices.  Several  corresponding
configurations for various monitoring tasks may also be saved in each device. The configuration must be transferred
to  the  corresponding  device  before  use.  Since  devices  can  usually  operate  autonomously  and  can  normally  be
configured in a short space of time, one mobile control computer for several devices is sufficient.

FAG Viewer: The imported data can be displayed in graphical form and analysed in Viewer.

FAG Remote Server:  The Remote Server  automatically monitors the data recording process for any number of
devices.

FAG Data Link:  Data Link  transfers  the data recorded  by the  Remote  Server  to  the  CM database .  Further,
Data Link can send event-driven e-mails containing data.

FAG E-mail link: You can use Email Link  to receive and manage e-mails centrally, for example e-mails sent from
Data Link. The data contained in the e-mails is written into the CM database.

FAG  Notify  Link:  Notify  Link  checks  whether  there  are  any  export  data  or  non-response  alarms  in  the  CM
database and sends them automatically by e-mail.

FAG Transfer Link:Transfer Link  synchronises the local data directory of the Remote Server via the Cloud with
the local directory monitored by Data Link.

Application Guard: By default, the FAG Administrator software is delivered with Application Guard . This program
automatically monitors in the background whether a running program component is working properly.

E-MailRelay tool: With the aid of the E-MailRelay tool  you can forward the unencrypted e-mails sent by the FAG
Administrator software with encryption.

All  data  is  stored  centrally  in  the  CM  database.  This  database  uses  the  SQL  database
Microsoft SQL Express 2012, which is included free of license charges.

Application Guard uses port 11111. Please make sure that this port is open in the computer’s
firewall. If necessary, ask your system administrator.
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Installing the software

3 Installing the software

This section describes installation of the Administrator software.

Please restart your system once all installations have finished.

Important information on FAG Administrator software version 4.10.2 update

The FAG Administrator software version 4.10 is delivered with the new database program MS SQL Express 2012 (see
System requirements ). If you already use an older Administrator version and you want to continue using existing CM
databases, you have to convert them into the new format.

CAUTION Backup  your  CM databases  before  you  install  the  Administrator  software  update,  so  they
can be reinstalled if necessary.

If you have an older MS SQL database program or if you want to continue using your existing
CM databases, please note the following hints:

If  you are working with the FAG Administrator software version 4.10 and an older  database
program as MS SQL Express 2012, 

o backup  the CM database and update  the database in the database management by
using the default update script update_cm_online.xml.

If  you  are  working  with  the  FAG  Administrator  software  version  4.10  and  the  delivered
database program MS SQL Express 2012, but you want to continue using your existing data
from MS SQL Server 2005 / 2008 or Express 2005 / 2008,

o backup  the  CM  database,  then  export  your  data  with  the  older  Administrator
software version and import  data into the new installation.

or:

o our experts will perform the entire CM database update for you. For more information about
this fee-based service, please contact our support (see "Contact" ).

You will find further information in the chapter "Update software" .

3.1 System requirements
In order to use the software in an optimal way, the following minimum requirements must be met:

General system requirements

Pentium III PC with 1 GHz or higher (recommended: 2 GHz)

min. 2 GB RAM (4 GB recommended)

Hard disk memory: 16 GB (20 GB recommended)

Screen resolution: 1280x960 (pixels) at 96 dpi and normal font size (as of Windows 7: classic view)

Operating systems

Administrator software and components: Windows 7 (32 and 64-bit version), Windows 8 (32 and 64-bit version)

Database software MS SQL Express 2012: min. Windows Vista SP 2 (recommended: Windows 7 SP 1)

MS Windows Server operating systems are not supported.

Hard disk memory for installing the Administrator software

Administrator software 4.10.2 (without database and database server): 300 MB

9
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Bearing database and demo database: 20 MB

Hard disk memory for installing the database server

MS SQL Express 2012: 1.5 GB

Hard disk memory for the database

MS SQL Express 2012: min. 6 GB

Other requirements

DirectX9 graphics adapter with WDDM 1.0 (or higher driver)

Microsoft Internet Explorer 7 or newer

MS SQL database software

If  you  are  already  using  an  MS  SQL  database  program,  you  can  register  the  databases  with  this.  You  can  use  the
following versions:

MS SQL Server 2008 and 2012 (requires a commercial license)

MS SQL Express 2008 and 2012 (free version of MS SQL Server 2005 with limited functions).

If you have an older MS SQL database program or if you want to continue using your existing
CM databases, please note the following hints:

If  you are working with the FAG Administrator software version 4.10 and an older  database
program as MS SQL Express 2012, 

o backup  the CM database and update  the database in the database management by
using the default update script update_cm_online.xml.

If  you  are  working  with  the  FAG  Administrator  software  version  4.10  and  the  delivered
database program MS SQL Express 2012, but you want to continue using your existing data
from MS SQL Server 2005 / 2008 or Express 2005 / 2008,

o backup  the  CM  database,  then  export  your  data  with  the  older  Administrator
software version and import  data into the new installation.

or:

o our experts will perform the entire CM database update for you. For more information about
this fee-based service, please contact our support (see "Contact" ).

You will find further information in the chapter "Update software" .

The databases "cm_online" and "cm_bearings" delivered are backwards compatible to MS SQL
Server 2008 and cannot be registered with MS SQL Express 2005. If you are working with MS
SQL Express  2005,  the  databases  delivered  can  therefore  not  be  automatically  registered.  In
this case, select the "Create a new database"  action in database administration and select
“Administrator  database  SQL  2005"  or,  alternatively,  “Bearing  database  SQL  2005”  as  the
database type.

Tips

If you are operating a large equipment pool (e.g. more than 20 devices), we recommend using MS SQL Server 2012
Standard or Enterprise Edition. Please note the system requirements specified by Microsoft for these server editions!

Install the databases and the database administration on a central computer that is always available.

The database may need to be enabled for network access. If necessary, ask your system administrator.

3.2 User rights and write access
To install and run the Administrator software you need special access rights. In the event of problems with the security
rules of your system, please contact your system administrator.

User rights

To install the Administrator software you need administrator rights on your system.

40 42

40 133

135
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Installing the software

Tip: Install the software with administrator rights and then switch back to a normal user.

Write access

The Administrator software saves settings and log files while it is running. They are saved in the directory "c:\Users\All
Users\Application  Data\Condition  Monitoring"  (on  Windows  7,  in  the  "Common  Application  Data”  directory,  e.g.  in  "c:
\Program Data\Condition Monitoring\"). These directories require write access.
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3.3 Installation

The installation  and  the  Setup  Wizard  are  available  in  German  and  English.  You  can  change
the language settings  at any time after installing the software. There are other languages to
choose from then.

Please insert the program CD in your CD-ROM drive. Alternatively, you can download the current version Administrator
from our website (see Contact ).

You can open the installation directory on CD-ROM in Windows Explorer as follows:

Open My computer.

Under Equipment with removable media, right-click the CD-ROM drive, then 

• click Open.

Select the directory "Administrator 4.10.2" and

select the file "Administrator-Application-Setup 4.10.2.exe".

Parts of the Administrator software require the Windows component MS .NET Framework 2.0.
If this component is not installed on your system, it is installed automatically.

The software components “E-MailRelay Tool" and "Transfer Link" can be used to encrypt e-
mails  and  to  synchronise  via  the  Cloud.  The  installation  is  described  in  sections  "The  E-
MailRelay tool " and “Installing other components" .

The  software  components  "Flash  Updater",  "CM  Installer"  and  "Net  Utility"  are  required  to
start  and  configure  Dtect  X1,  Dtect  X1s,  WiPros  and  ProCheck  devices.  The  installation  is
described in section "Installing other components" .

Installation of the Administrator software is described below.

Installation method

Choose  whether  to  install  the  Administrator  software  completely  on  a  local  computer  or  divide  it  among  multiple
computers (e.g. in a network).

Install software completely on a local computer (default installation)

If you want to install  the Administrator software completely on a local  computer,  please run the application installation
(Application Setup). This installs all components of the Administrator software including the databases. 

Start the "Administrator-Application-Setup 4.10.2.exe" installation file by double clicking on it.

The Setup Wizard  guides you through the rest of the installation.

Install software on different computers

If  you  want  to  install  the  Administrator  software  on  different  computers,  e.g.  in  order  to  run  different  components  on
different computers, you must install these components separately.

Open the directory "Administrator 4.10.2" > "Setups".

Start the "Administrator-Application-Setup*.exe" installation file by double clicking on it.

Double-click to run the installation file for the appropriate component "*-Setup 4.10.2.exe".

The Setup Wizard  guides you through the rest of the installation.

If  you  want  to  install  components  individually,  e.g.  to  distribute  them  on  different  computers,
make  sure  that  these  computers  have  a  network  connection  so  that  the  components  can
communicate with each other.  In  any case the CM database must  be installed on a computer
(e.g. a server) as all data is stored there.

148
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Installing the software

3.3.1 Administrator Setup Wizard

1. Please select the language of the Setup Wizard. You can choose between English and German. You can change the
language setting  at any time after installing the Administrator software. There are other languages to choose from
then.

2. Accept the licence agreements and click Next to continue installing.

3. Select the directory where you want to install the software and click Next.

4. Optionally you can choose between different installations. Select from the list:
Full installation to install all components of the software,
 Client installation to install the Configuration Manager only,
Compact installation to install the Configuration Manager and database only,
Custom installation to install components individually un/tick the individual software components and click Next.

If CM databases are already installed on the computer, no new databases are installed. You
can add new databases from the Database administration .

If you want to install  components individually, e.g. to distribute them on different computers,
make  sure  that  these  computers  have  a  network  connection  so  that  the  components  can
communicate with each other. In any case the CM database must be installed on a computer
(e.g. a server) as all data is stored there.

148
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Please note that 

the Administrator software requires an MS SQL database program (cf. “System requirements"
 and "CM Database Setup Wizard ").

the database administration is installed on the same computer as the databases!

5. Select the Start menu folder and click Next.

6. In the next window check your settings and click Install or Back to correct your settings.

The Administrator software installation now begins.

3.3.2 CM database Setup Wizard

If no CM databases are installed on your computer yet, CM database installation runs automatically. The Setup Wizard
guides you through the installation process for the databases required to run the Administrator software.

If  no  CM database  is  configured  on  your  system  yet,  the  following  databases  are  installed
automatically:
- cm_online.mdf: empty CM database
- demo_online.mdf: demo database with example configurations and data (optional)
- cm_bearings.mdf: bearing database

Every new database you add is labelled with a serial number.

All database names are displayed without the ".mdf" extension in the software.

If you have an older MS SQL database program or if you want to continue using your existing
CM databases, please note the following hints:

If  you are working with the FAG Administrator software version 4.10 and an older  database
program as MS SQL Express 2012, 

o backup  the CM database and update  the database in the database management by
using the default update script update_cm_online.xml.

If  you  are  working  with  the  FAG  Administrator  software  version  4.10  and  the  delivered
database program MS SQL Express 2012, but you want to continue using your existing data
from MS SQL Server 2005 / 2008 or Express 2005 / 2008,

o backup  the  CM  database,  then  export  your  data  with  the  older  Administrator
software version and import  data into the new installation.

or:

o our experts will perform the entire CM database update for you. For more information about
this fee-based service, please contact our support (see "Contact" ).

You will find further information in the chapter "Update software" .
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1. Accept the licence agreements and click Next to continue installing.

2. Select which database(s) to register ) and click Next.
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Install bearing database

If you have selected “Install bearing database" you can 

install a new bearing database or 

if you already have a bearing database, select an existing database

and connect it with the Administrator software.

1. Select Install new bearing database and click Next.

Or:

1. Select Connect to an existing bearing database and

2. select the database server on which the bearing database is installed.

3. Enter user name and password.

By  default,  the  program  created  a  user  account  called  “cmuser"  (password
“CM_services$1user”)  for  accessing  the  database  server  during  installation.  For  database
servers installed with the Administrator software version 4.4 or older, the user name is "sa" and
the password "sql8".

If you were using your own (custom) password, please enter it.

4. Click Find bearing database,

5. select a bearing database and

6. click Next.
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Database program does not exist

If  no  MS  SQL  database  program  is  installed  on  your  computer  yet,  Microsoft  SQL  Express  2012  is  automatically
installed and the selected databases registered.

Click  Next  to  confirm  the  Install  local  database  instance  option  in  the  Administrator  Setup
Wizard:

Click Cancel if you are working with a server-based central database. Note that Microsoft limits
the size of the local database to 10 GB and that it is therefore not suitable for large volumes of
data.

The SQL Server 2012 installation is only available in English, regardless of the language of the
Administrator Setup Wizard.

1. In the License Terms step, activate the option I accept the license terms and click Next.

2. In the Install Setup Files step, click Install.

3. In the Feature Selection step, confirm the default settings by clicking Next.

4. In the Instance Configuration step, confirm the default settings by clicking Next.
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5. In the Server Configuration step, confirm the default settings by clicking Next.

6. In  the Database Engine Configuration step,  confirm the default  settings for  server  configuration,  data directories,
and user instances by clicking Next.

By  default,  the  program  creates  a  user  account  called  “cmuser"  (password
“CM_services$1user”) for accessing the database server during installation.

Alternatively, you can define your own (custom) password in Database Engine Configuration
> Server Configuration:

 Your  own  password  may  be  necessary,  for  example,  if  your  company  prescribes  a  certain
password length.

7. In the Error Reporting step, confirm the default settings by clicking Next.

8. The program installs Microsoft SQL Server 2012 Edition and the selected databases. An overview of the components
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installed is then displayed.

9. Click on Close.

Installation of the Administrator software is finished.

Database program exists

If an MS SQL database program is already installed on your computer (see “System requirements” ), you only need
to register the selected databases with the server. To do so, the installation program requires the connection settings for
the database server.

1. Click Continue.

2. Select the database server containing the “master” database.

By  default,  the  program  created  a  user  account  called  “cmuser"  (password
“CM_services$1user”)  for  accessing  the  database  server  during  installation.  For  database
servers installed with the Administrator software version 4.4 or older, the user name is "sa" and
the password "sql8".

If you were using your own (custom) password, please enter it.

3. Activate Default user and password to use the default settings. 
Or:
Deactivate Default user and password and enter your own password.

4. Click Continue.

This displays a list of components to install.

9
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5. Click Install.

The program installs the selected databases and registers them with the database server.

After completing installation, the program displays details of the databases that were installed and the access data.

6. Click Continue.

Installation of the Administrator software is finished.

3.3.3 Install additional components

This section describes the installation of additional components of the Administrator software.

The software components "Flash Updater", “CM-Installer" and "Net Utility" are required to start
and configure Dtect X1, Dtect X1s, and ProCheck devices.

Install E-Mail Relay tool

With the aid of the E-MailRelay tool you can forward the unencrypted e-mails sent by the FAG Administrator software
with encryption. The E-MailRelay tool acts as an e-mail server. Details on installing the E-Mail Relay tool and configuring
the Administrator software can be found in the section The E-MailRelay tool .

Install Transfer Link

Transfer  Link  synchronises  the  local  data  directory  of  the  Remote  Server  via  the  Cloud  with  the  local  directory
monitored by Data Link.

1. Please select the language to install Transfer Link.

2. Accept the licence agreements and click Next to continue installing.

3. Select the directory where you want to install the software and click Next.

4. Select the Start menu folder and click Next.

5. In the next window check your settings and click Install or Back to correct your settings.

Transfer Link installation now begins.

Install CM-Installer

CM-Installer  allows  you  to  configure  the  ProCheck  device  for  network  operation.  For  more  information  about  the
program refer to the "FAG ProCheck" manual, section “CM-Installer".

1. Please select the language to install CM-Installer.

2. Accept the licence agreements and click Next to continue installing.

3. Select the directory where you want to install the software and click Next.

4. Select the Start menu folder and click Next.

5. In the next window check your settings and click Install or Back to correct your settings.

CM-Installer installation now begins.

Install Net Utility

Net Utility allows you to configure the Dtect X1s device for network operation. For more information about the program
refer to the "FAG Dtect X1s" manual, section “Net Utility".

1. Please select the language to install Net Utility.

2. Accept the licence agreements and click Next to continue installing.

3. Select the directory where you want to install the software and click Next.

4. Select the Start menu folder and click Next.

5. In the next window check your settings and click Install or Back to correct your settings.

Net Utility installation now begins.

Install Flash Updater

Use the Flash Updater to update the firmware of the Dtect X1 device. The current configuration is retained.

If the "Flash Updater" component is already installed, please uninstall this component manually.
To  do  so,  call  up  the  Start  menu  and  click  Programs  >  FAG  >  Administrator  >  Tools  >
Uninstall > Uninstall Flash Updater.

1. Please select the language to install Flash Updater.

237
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2. Accept the licence agreements and click Next to continue installing.

3. Select the directory where you want to install the software and click Next.

4. Select the Start menu folder and click Next.

5. In the next window check your settings and click Install or Back to correct your settings.

Flash Updater installation now begins.

Please restart your system once all installations have finished.

3.4 Update

If the "Flash Updater" component is already installed, please uninstall this component manually.
To  do  so,  call  up  the  Start  menu  and  click  Programs  >  FAG  >  Administrator  >  Tools  >
Uninstall > Uninstall Flash Updater.

To update the Administrator software or individual components,

double-click to run the installation file "Administrator-Application-Setup*.exe" and

select the update installation (without database) from the drop-down box.

The Setup Wizard guides you through the rest of the installation (also see "Administrator Setup Wizard" ).

3.4.1 Update on Administrator version 4.10.2

The FAG Administrator software version 4.10 is delivered with the new database program MS SQL Express 2012 (see
System requirements ). If you already use an older Administrator version and you want to continue using existing CM
databases, you have to convert them into the new format.

CAUTION Backup  your  CM databases  before  you  install  the  Administrator  software  update,  so  they
can be reinstalled if necessary.

You have the following options:

If you want to update the FAG Administrator software to version 4.10.2 and continue using the database program MS
SQL Server 2005 / 2008 or MS SQL Express 2005 / 2008, you can use the existing CM databases as follows:

o Backup  the CM database via the database administration.

o Install  the  Administrator  software  on  your  computer  completely  (the  installed  MS  SQL  database  program  is
automatically detected).

o Update  the CM database via the database administration with the default script update_cm_online.xml.

You can still use the MS SQL Server 2005 / 2008 or MS SQL Express 2005 / 2008 without
functional limitations. 

If  you want  to  update your  database program to MS SQL Express 2012,  please contact
your IT department. 

If  you  want  to  update  the  FAG  Administrator  software  to  version  4.10.2  and  the  database  program  on  MS  SQL
Express 2012, you can use the existing CM databases as follows:

o Backup  the CM database via the database administration.

You have the following two options:

o Export  your data (or parts) with the older Administrator software version.

o Ask your IT department for installation of the Administrator software and the database program MS SQL Express
2012.

o Import  the data into the new Administrator software version.

or:

o Ask our  experts  for  updating the entire  CM database.  For  more  information  about  this  fee-based  service,  please
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contact our support (see "Contact" ).

If you want to install the FAG Administrator software on a new computer, but want to continue using your existing CM
databases, proceed as follows:

o Backup  the CM database via the database administration.

You have the following two options:

o Export  your data (or parts) with the older Administrator software version.

o Install  the Administrator software on your computer completely (the database program MS SQL Express 2012 is
automatically installed).

o Import  the data into the new Administrator software version.

or:

o Ask our  experts  for  updating the entire  CM database.  For  more  information  about  this  fee-based  service,  please
contact our support (see "Contact" ).

If you want to install the FAG Administrator software on a new computer, but want to work with new CM databases, 

o Install  the Administrator software on your computer completely (the database program MS SQL Express 2012 is
automatically installed).

3.5 Uninstalling

To uninstall  the Administrator  software please click  Programs > FAG >  Administrator  >  Uninstall  Administrator  in
the Start menu.

To  uninstall  individual  components  of  the  Administrator  software,  please  click  Programs  >  FAG  >  Administrator  >
Tools > Uninstall in the Start menu. You can select individual software components to uninstall here. 

Please note that  configuration and export  files  are left  on  your  computer.  For  your  safety,  the
database is not deleted either. To completely uninstall, you must delete these files manually.
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Vibration monitoring with online monitoring systems

4 Vibration monitoring with online monitoring systems

This  chapter  explains  the  principle  of  vibration  monitoring  using  FAG  online  monitoring  systems  and  describes  all
possible monitoring modes.

Please note that not all monitoring modes may be available in your version.

Furthermore, the terms which are important for a better understanding of the following chapters in the manual will also
be introduced.

4.1 The principle
The principle of vibration monitoring employed by FAG Industrial Services GmbH online monitoring systems is explained
taking a damage to a machine component as an example.

This type of damage can be detected at an early stage through characteristic patterns in the frequency spectra of the
machine  vibrations.  For  example,  damage  to  the  outer  ring  of  a  rolling  bearing  becomes  noticeable  through  higher
amplitudes in the demodulation frequency spectrum at the characteristic frequency at which the rolling bearing rolls over
a  point  of  damage  in  the  outer  race  (ball  pass  frequency  of  outer  race,  BPFO)  and  at  the  integral  multiples  of  this
frequency. The following illustration shows such an demodulation frequency spectrum. The peak amplitudes at around
150 Hz and multiples can be clearly seen.

Spectrum through damage to the outer race of a rolling bearing.

The  characteristic  damage  frequencies  of  a  rolling  bearing,  i.e.  outer  race,  inner  race,  roller  or  fundamental  train
frequency, depend on the bearing geometry and are proportional to the speed.

In  order  to  detect  rolling  bearing  damage  at  an  early  stage,  a  vibration  monitor  must  generate  the  demodulation
frequency  spectrum  from  the  vibration  signal  and  monitor  the  amplitude  in  selective  narrow  frequency  bands  in  this
spectrum. At variable machine speed, frequency bands must be monitored speed dependent.

The online systems allow this kind of monitoring. Different frequency bands can initially be defined at fixed speeds within
which the output is monitored. This output is described by the RMS value in conventional frequency spectra. The LDZ
value  is  used  in  the  demodulation  spectrum.  If  one  of  these  characteristic  values  exceeds  a  pre-set  limit,  the  alarm
threshold, an alarm will be triggered. A detailed description of these characteristic values as well as further details of the
frequency and demodulation analysis can be found in the manual "General information on vibration monitoring").

The following illustration shows two spectra with a representation of the characteristic values for the selected frequency
bands and the alarm limits. The situation shown on the left would trigger an alarm.
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Spectrum with two frequency bands, characteristic values as well as pre-alarm threshold (PA) and main alarm threshold (MA), 1st
frequency band: pre-alarm, 2nd frequency band: no alarm

The characteristic values can be monitored with two limits in the FAG Industrial Services GmbH online systems so that a
pre-alarm and a main alarm can be reported. Furthermore, the characteristic values in individual frequency bands can
also be combined to one common value.

You  can  also  record  other  process  parameters,  e.g.  rotational  speed,  and  thus  plot  the  positions  and  widths  of  the
frequency bands as a function of the speed. The alarm limits can also be defined as speed-dependent.

4.2 The hardware concept
The sensor signals are digitized in the online monitoring systems and processed by means of a digital signal processor.
The frequency spectrum is generated and the characteristic values calculated from this. These are then compared to the
pre-set alarm thresholds.

The layout of a full version of a single-channel Dtect X1s device might be as follows:

Block diagram of a full version of a single-channel Dtect X1s device.

A  variety  of  sensors  can  be  connected  to  the  FAG  Industrial  Services  GmbH  online  systems,  such  as  acceleration,
speed or displacement sensors or particle counters. The sensor signal  is  forwarded either directly to  a  programmable
anti-aliasing filter or after enveloping and then digitized. This digitized signal is called the time signal, or more precisely
the demodulation signal (or demodulated signal) if enveloping has taken place, otherwise it is called the raw signal. The
digital signal processor (DSP) calculates the frequency spectrum from the time signal.

Enveloping  (demodulation)  is  carried  out  in  a  high-pass  filter  and  subsequent  demodulator  in  the  form  of  a  full-wave
rectifier.  An investigation of  demodulation signals  is  particularly suitable  to  detect  and analyse impact  pulses  such  as
can  occur  for  example  with  bearing  damage (see  "General  information  on  vibration  monitoring”  in  the  manual  on  the
installation CD).
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The characteristic values from the frequency spectrum calculated in the hardware trigger a pre-alarm or main alarm if
the corresponding limit is exceeded. The alarm messages can be forwarded to analog outputs and/or switching relays.

The analog outputs differ depending on online system you are using and may also be configured to output characteristic
value levels. 

The alarm message can be delayed. The alarm will then only be triggered when the main alarm
threshold is exceeded in succession by a pre-set number of measurements.

Depending on the device configuration, the online systems can take up to eight auxiliary signals, that you can evaluate
simultaneously with the sensor signal after digitization. The additional channels can be used to track frequencies or as
triggers.

All settings and configurations of the Online Systems and the last measured time signals with corresponding frequency
spectrum are saved in a data memory. The characteristic values calculated from the spectrum are also saved in non-
volatile memory.

You  can  configure  the  online  systems  from  an  external  computer  using  the  FAG  Administrator  software  through
various interfaces (RS 232, TCP/IP). On the Dtect X1s device, you can perform minor changes using the button on the
front of the device.

Please  remember  that  the  Online  Systems  are  delivered  in  different  designs.  There  follows  a
description of a device containing all features. Your device may differ from this.

4.3 Monitoring types in the frequency domain
FAG Industrial  Services  GmbH online  systems  monitor  the  frequency  domain  of  a  vibration  signal  with  characteristic
values. The RMS value is used for the raw signal and the LDZ value for the demodulation signal.

The RMS -value (root mean square) is calculated from the frequency spectrum of the raw signal by adding together the
squares of the amplitudes over a defined range of the frequency spectrum, halving this value and then taking the square
root of this figure:

If a large part of the spectrum is taken into account, one speaks of a broad band characteristic value. If only individual
frequency bands are used, this is called a selective RMS value.

If the demodulation signal (demodulated signal) of the vibration acceleration is generated through a suitable
configuration of the Online System, the so-called LDZ value can be formed from its frequency spectrum in one
frequency band. This value is proportional to the signal strength in this frequency band. The squares of the amplitudes
in a selected frequency range are added together and the sum divided by 2 to obtain the LDZ value:

The LDZ-value is generally standardized, i.e. the level is quoted in relation to 10-6 g2. This is then called the LDZN-value.

A differentiation is also made between broad band and selective characteristic values for the LDZ-values.

The individual monitoring modes are explained in the following sections.

Please note that your device configuration may not support all of these monitoring modes.

4.3.1 Monitoring with broad band characteristic values

Monitoring the vibration velocity in the frequency band from 10 Hz to 1 kHz according to ISO 10816

The  raw  signal  obtained  from  the  vibration  velocity  is  used  for  monitoring  purposes  in  this  case.  The  RMS-value  is
calculated from the amplitudes in the frequency band from 10 Hz to 1 kHz. This characteristic value is called VDI 2056

8
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in  the  Dtect  X1s,  referring  to  the  VDI  guideline  VDI  2056  which  is  still  frequently  used  for  vibration  monitoring.  This
guideline has been amended several times since and is now called ISO 10816.

RMS value according to VDI 2056 in frequency range from 10 Hz to 1 kHz.

Monitoring the acceleration, velocity or displacement signal with a broad band RMS-value

The basic raw signal for this monitoring mode is obtained from the vibration acceleration, vibration velocity or vibration
displacement. The RMS value is determined for the frequency range from 0 Hz to the cut-off frequency of the low-pass.

Broad band RMS-value in the frequency range from 0 Hz to the cut-off frequency of the low-pass.

Monitoring with a broad band LDZ-value

The starting point  for  this  monitoring mode is  the  demodulation  signal  for  vibration  acceleration.  To  obtain  the  LDZN-

characteristic value, its frequency spectrum from 0 Hz to the cut-off frequency of the low pass is evaluated, with the DC
level being suppressed.
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Broad band LDZ-value in the frequency range from 0 Hz to the cut-off frequency of the low-pass.

4.3.2 Monitoring with fixed frequency bands and fixed alarm thresholds

For narrow-band, frequency-selective monitoring you can define up to 64 different monitors, each with a maximum of 20
frequency bands, in the online systems, depending on the particular model.

You can combine multiple characteristic values for any frequencies. For example, you can form a characteristic  value
from the base frequency and the harmonic of an outer race ball pass frequency.

The selective RMS or selective LDZN-values are used as characteristic values for monitoring, again depending on the

design.  Furthermore,  both  types  of  characteristic  value  allow  a  differentiation  between  monitoring  of  the  selected
frequency bands with one common characteristic value or whether a separate characteristic value is to be used for each
frequency band.

The following illustration shows these selection possibilities for four frequency bands when generating the RMS value.

Monitoring with selective characteristic values in four frequency bands.

An RMS value is generated for each individual frequency band, the values RMS1 to RMS4. If the frequency bands are

monitored individually, the alarm is triggered when one of these characteristic values exceeds its corresponding alarm
limit.

When monitoring with a common characteristic value, this is calculated according to the following formula:
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In this case there is only one limit value for both pre and main alarm.

Please  note:  The  sum total  of  RMS-values  for  individual  frequency  bands  does  not  generally
correspond to the calculation of the common RMS-value!

4.3.3 Monitoring with fixed frequency bands and speed-dependent alarm thresholds

If an additional speed signal is recorded via an additional channel the limits for the pre and main alarm can be defined
as a function of the speed. The limits are then called speed-dependent or speed-related.

Either  the  RMS or  LDZN  value  can  be  used  for  monitoring  just  like  the  fixed  alarm  limits  -  depending  on  the  Online

System.

4.3.4 Monitoring with speed-dependent frequency bands and alarm thresholds

In addition to the alarm limits, the frequency bands can also be speed dependent. Center frequencies and bandwidths
are both defined as a function of the speed signal then.

4.4 Order analysis
In the order analysis, a vibration signal is analysed for signal components whose frequency has a fixed correlation with
the  rotational  frequency  of  a  rotating  shaft.  The  order  analysis  is  typically  used  when  you  are  not  interested  in  the
periods per unit of time but rather per revolution of the vibration signal. An example of this are damage frequencies that
are usually referred to shaft speed and are thus orders.

The result of an order analysis may be an order spectrum, for example, in which amplitude and phase of the signal are
applied not  above the frequency but  rather  above the order.  The  order  is  dimensionless  and  indicates  the  number  of
periods  of  the  signal  per  shaft  revolution.  At  a  constant  shaft  frequency,  the  order  O  corresponds  to  the  frequency
component  of  the  signal  at  a  frequency fo  =  O •  frot.  In  this  case,  we  obtain  an  order  spectrum  by  means  of  Fourier

analysis of the time signal with subsequent normalization of the frequency axis on the rotational frequency.

In the FAG Viewer you can change the scaling of the frequency axis to "Order" when displaying
an order spectrum (see "Modifying the appearance of a diagram" ).

The following diagram shows the spectrum of a synthetic signal with the orders 1, 10 and 19, each with an amplitude of
1 and at a rotational frequency of frot = 10 Hz. The three orders are clearly visible at 10, 100 and 190 Hz.

163
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If rotational frequency frot of the measured object is not constant during measurement, frequency fo belonging to order

O also changes. If, in this case, we calculate an order spectrum based on the time signal frequency spectrum and the
average  rotational  frequency,  the  order  O  appears  "blurred"  over  several  frequency  lines.  The  greater  the  change  of
rotational speed, the more difficult it is to analyse the orders.

The following diagram shows the spectrum of the signal with the orders 1, 10 and 19, again each with an amplitude of 1.
The rotational frequency increases on a linear basis from frot = 10 Hz to frot = 20 Hz.

The "blurring" of orders in the frequency spectrum is clearly visible and increases with increasing order.  As the peaks
belonging  to  the  individual  orders  become  wider,  amplitude  also  decreases.  Both  aspects  severely  hamper  an
evaluation of rotational-speed-dependent signal components.

To improve damage pattern recognition at varying rotational speed, ProCheck offers order analysis by resampling raw
and  demodulation  time  signals.  The  time  signals  are  rescanned  at  equidistant  angle  steps  using  a  simultaneously
measured  rotary  encoder  signal.  The  frequency  analysis  of  the  angular  signals  thus  obtained  provides  the  order
spectrums  of  the  raw  and  demodulation  data.  Signal  components  whose  frequency  is  in  a  constant  relation  to  the
rotational  frequency  of  the  measured  object  do  not  appear  "blurred"  in  these  order  spectrums  even  if  rotational
frequency varies. This facilitates detection of typical roller bearing damage patterns at varying rotational speed. Signal
components whose frequency is not in a constant relation to the varying rotational frequency, in contrast, are "blurred".

As  the  result  of  a  demodulation  order  analysis,  the  following  diagram  shows  a  demodulation  order  spectrum  at  an
average rotational frequency frot = 30 Hz, that fluctuates by 15%. Despite the severe deviation of rotational speed, the

order spectrums are largely independent of the variation in rotational speed. The damage pattern is clearly visible up to
the seventh harmonic.

For  technical  reasons,  the  permissible  measurable  rotational  speed  range  is  between  0.6  Hz
and 4500 Hz at one pulse per revolution. 

The  maximum  permissible  rotational  speed  can  be  calculated  using  the  following  formula,
depending on the number of rotational speed impulses per minute:

4500/number of pulses per revolution = max. possible rotational speed (in Hz)

Example: "4500/60 (pulses per revolution) = 75 Hz or 4500 rpm"
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You can select order analysis in the Configuration Manager, in the monitoring configuration (see "Main channels" ).

You can only select the order analysis if

the ProCheck device is running with a firmware version 2.0.0.0 or newer,

no more than one sensor/filter combination is defined (raw signal or demodulation),

no characteristic values of the "time range" type exist.

In  addition,  the  number  of  measured  values  for  an  order  analysis  is  limited  to  16384  and
maximum lowpass frequency is 5 kHz.

4.5 Monitoring types in the time domain
The online systems calculate various characteristic values simultaneously from the time signal during monitoring in the
time domain. These are 

the root mean square (RMS value),

the peak,

the vibration amplitude (peak-to-peak),

the DC level, and

the crest factor, the ratio between the signal's effective value and the peak.

More details of these characteristic values can be found in the “General information on vibration monitoring” PDF in the
“Characteristic vibration values” section (see installations CD).

4.6 Triggering and validation with auxiliary signals
Depending  on  the  configuration  of  the  systems,  up  to  8  auxiliary  signals  can  be  recorded  simultaneously.  Additional
channels can be used to measure speed, torque, temperature, pressure or other physical parameters. The signals are
processed directly after digitalization and used to validate triggering, for example.

The speed signal used to adapt the monitored frequency bands and/or alarm limits as described in section "Monitoring
types in the frequency domain"  can also be recorded via an additional channel.

Triggering  means  that  monitoring  is  only  carried  out  under  certain,  predefined  operating  conditions,  e.g.  a  certain
working temperature.

In ProCheck, such a trigger may be applied to multiple vibration channels. For example, such a trigger can ensure that a
maximum of 4 channels – depending on the trigger – are recorded on a rolling stand.

On the other hand, monitoring is continuous during validation. The auxiliary signal is recorded simultaneously. However,
a  limit  transgression  for  a  characteristic  value  only  triggers  an  alarm  if  the  auxiliary  signal  has  fulfilled  a  pre-defined
condition.

For example, if an alarm is only sensible on a machine at speeds between 400 and 600 rpm, this can be controlled via
validation.

Only validations are possible with the current design of the Dtect X1s devices. Dtect X1s does
not support triggering as defined above. However, almost all monitoring tasks can be performed
just as well with validation.
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5 Configuration Manager

About the configuration manager

The Configuration Manager serves as a central control station on the external computer and allows you to

devices , device configurations  and monitoring configurations ,

Load measuring data in the FAG Viewer viewer,

Export, import or e-mail measured data,

Create an alarm or measuring value report,

Manage users .

The  program  can  manage  any  number  of  Dtect  X1s  or  ProCheck  devices  and  their  measuring  data.  Several
corresponding  configurations  for  various  monitoring  tasks  may  also  be  saved  in  each  device.  The  "demo-online"  CM
database contains a sample system with devices and configurations.

Launch the Configuration Manager as follows:

Click Start > Programs > FAG > Administrator > Configuration Manager.

Log in  with your user name.

In  order  to  use  the  Administratorsoftware,  you  must  log  in  as  a  user.  In  the  device  factory
settings  no  password  is  assigned  to  the  "admin"  user.  To  prevent  unauthorized  access  to
software  and  data  you  should  assign  a  password  for  this  user  without  delay  ().  (For  further
information refer to “Log in/switch user"  and “User management" ).

Data  Link  connects  with  the  last  database  used.  If  you  installed  a  database  during  software  installation,  the  program
automatically connects to this database when you start the program for the first time. The program uses the default user
name and the default password. Further information can be found in “Change CM database" .

The Configuration Manager is launched.
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The program window is divided into the following sections:

Click the toolbar (directly below the menu bar) to call up the most important functions.

The registered devices as well as the corresponding device and monitoring configurations are displayed in the familiar
Windows Explorer tree view on the left-hand side of the program window. You can show/hide the entries in the tree

view by clicking on  or . You can specify up to 5 planning levels at any level in the tree view. With the aid of
these planning levels, you can structure complex system configurations for a better overview.

The Configuration Manager displays the settings of the element currently selected in the tree view on the right.

The status bar at the bottom edge of the window displays the currently selected CM database and connection status.
The text "Online" or "Offline" indicates whether or not the Configuration Manager is currently connected with a device.
If a connection exists the serial number of the device is displayed next to this on the right.

The context menu in the tree view provides additional menu items.

Left-click on a tree item and

then right-click on the item.

You  can  only  invoke  Configuration  Manager  context  menu  functions  if  the  user  has  the
appropriate  permissions  and  if  the  function  makes  sense  in  the  particular  context.  Disabled
functions are greyed out and cannot be invoked.

You can copy the entire tree view to the clipboard and paste it into an editor from there:

Click on any tree item.

Press CTRL+ALT+L. All levels of the tree view are automatically expanded and copied to the
clipboard.

Open  an  editor,  e.g.  MS  Excel,  and  press  CTRL+V:  This  pastes  the  tree  view  into  the
application with all planning levels visible.

Icons in the tree view

The following icons are used in the Configuration Manager tree view:

Icon Meaning

The alarm state is green; there is no alarm.

The alarm state is yellow; there is a pre-alarm.

The alarm state is red; there is a main alarm.

There is a non-response alarm .

There is a sensor error .

There is a non-response alarm and a sensor error.

The configuration is invalid . This is the case if
a device configuration does not contain a monitoring configuration.
a device or monitoring configuration contains an invalid value.

The configuration is inactive. This is the case if
a monitoring configuration was deactivated (ProCheck only: Activate configuration ).
as long as a configuration is outdated.

The configuration is outdated . If an outdated configuration is displayed, the program shows the time when the
configuration became outdated.

There are time signal data.

There are FFT data.

There are alarm FFT data.

There are characteristic value data.

The tree item counter  (n) is activated and the number of subentries is displayed.
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Show selection information

In the Configuration Manager you can display additional information for each item in the tree view, including the type of
item (e.g. system, ProCheck or Dtect X1s), the position in the tree level (e.g. device, device configuration or monitoring
configuration), the time and user when the item was created and when it was last edited.

Click on an item in the list of devices and configurations and

select Show selection information from the context menu.

5.1 Manage databases
The FAG Administrator software uses SQL databases for condition monitoring and bearing data. The data required for
configuration, evaluation of measuring data, and user management is stored centrally in the CM database.

You may  only  use  ANSI  characters  of  the  Latin-1  codepage  for  entries  that  are  stored  in  the
database.  This  includes,  for  example,  device  and  configuration  names,  characteristic  value
names, channels and the like.

The bearing database contains  approx.  20,000  bearings  from different  manufacturers.  The  individual  programs of  the
FAG Administrator software use the following SQL databases jointly:

Icon Name Description

cm_online CM database for the FAG online monitoring systems

cm_bearings Bearing database

The Administrator software is delivered with the Microsoft SQL Server 2012 Express Edition database software, but the
size of the database is limited to 10 GB for licensing reasons. You can manage the various databases with the database
administration .

If you have an older MS SQL database program or if you want to continue using your existing
CM databases, please note the following hints:

If  you are working with the FAG Administrator software version 4.10 and an older  database
program as MS SQL Express 2012, 

o backup  the CM database and update  the database in the database management by
using the default update script update_cm_online.xml.

If  you  are  working  with  the  FAG  Administrator  software  version  4.10  and  the  delivered
database program MS SQL Express 2012, but you want to continue using your existing data
from MS SQL Server 2005 / 2008 or Express 2005 / 2008,

o backup  the  CM  database,  then  export  your  data  with  the  older  Administrator
software version and import  data into the new installation.

or:

o our experts will perform the entire CM database update for you. For more information about
this fee-based service, please contact our support (see "Contact" ).

You will find further information in the chapter "Update software" .

If you require more space in the database please consult FAG Industrial Services GmbH .

To display the memory used in the database click Extras > Options > Database > General
(see also "Program settings" ).

If there is less than 512 MB of unused space in the CM database, a warning is displayed.
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CAUTION Measured data may be lost if database is full!

If the maximum storage capacity of the CM database has been used up, a warning is displayed.
If  additional  measured  data  is  downloaded from a  device  when  the  database  is  full,  this  data
cannot be saved and will be lost!

Free up storage space in the database by

deleting unneeded data,

storing existing data to a different location using the export function and then deleting the CM
database.

5.1.1 Select CM database on server

When you first start the Administrator software, you must select the database server and a CM database.

Select a CM database on the database server as follows:

Click on File > Open database.

Or:

Click Change database in the login dialog.

Select CM database

1. Select SQL server

First select the SQL server where the database is located. You have the following options:

By default, the Server name list displays the SQL server applications running on your computer. Select the database:

Or:

Click  and enter the full server name.

Or:

Click  to search the SQL servers available in the network and display them in the server list. Then select the server
from the list.

If  the server list  is  empty – e.g. due to restricted Windows user permissions – you must  enter
"PC name\SQLEXPRESS" manually (e.g. if your PC’s name is "peters_laptop", then the server
name would  be  "peters_laptop\SQLEXPRESS").  You  can  find  your  PCs  name above  the  disk
drives  in  the  Windows  Explorer.  If  you  are  unsure  about  the  computer  name  ask  your  sys
admin.
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Database  servers  that  you  added  using   are  saved  in  the  Server  name  list  and  are
automatically available next time you run the program. Click  to delete items from the list.

2. Select user authentication

There are several options to log on to the database server:

Activate Use Windows authentication to log on with your Windows user name and your Windows password.

Or:

Activate Use user name and password and

activate Default user and password to use the default login (see note).

Or:

Activate Use user name and password,

deactivate Default user and password and

enter you own user name and password.

By  default,  the  program  created  a  user  account  called  “cmuser"  (password
“CM_services$1user”)  for  accessing  the  database  server  during  installation.  For  database
servers installed with the Administrator software version 4.4 or older, the user name is "sa" and
the password "sql8".

If you were using your own (custom) password, please enter it.

3. Select database

After selecting a database server in step 1, the program displays the databases available on the server in the Database
list.

The available databases are displayed in the Name list. Select a database or click  to refresh the list of databases.

Click   to  test  the  connection.  If  the  connection  fails,  check  your  user  data.  If  necessary,  contact  your  system
administrator.

4. Enter database alias

Optionally, you can give the selected database an alias name to make it easier to distinguish it from other databases. If
you  have  already  given  the  database  an  alias  name,  this  alias  is  displayed,  otherwise  the  name  of  the  database
including the name of the server.

Click OK to use the selected CM database.

5.1.2 Change CM database

You can connect the configuration manager with another CM database as follows:

Click on File > Open database.

Or:

Click File > Database history to select a database from the list of recently opened databases.

Or:

Double-click on the name of the currently open database in the Devices and configurations section.

You can select a CM database by clicking “Change database” in the login dialog. This dialog is
not displayed if automatic user login  (auto-login) is activated.

Further steps are described in "Select CM database on server" .

5.1.3 Database administration

With the aid of the database management of the Administrator software you can

Create new databases

Register databases on a database server

Deregister databases from a database server

Update databases (Update)

Backup databases (Backup)
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Restore databases

Delete databases.

Install  the  databases  and  the  database  administration  on  a  central  computer  that  is  always
available.

You can start the database administration as follows:

Click Start > Programs > FAG > Administrator > Tools > Database administration.

Or:

Click Extras > Database administration in the Configuration Manager menu.

You can only call up the database administration in the Configuration Manager if both software
components are installed on the same computer.
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5.1.3.1 Create database

You can create a new database as follows:

Click Actions > Create database to create a new CM database.

Select the type of database from the Database type list (currently only Administrator databases are supported).

Click Storage location and select the directory containing the database.

To avoid problems with MS SQL Express, please always use the default directory used during
installation! The default  directory for Microsoft  SQL Express is "C:\?All  Programs\Microsoft  SQL
Server\MSSQL.1\MSSQL\Data\".

To  save  a  database  in  a  directory  other  than  the  default  directory,  the  user  must  have  full
access to this directory. If you have any questions, please contact your system administrator.

Enter a name for the database in Database name.

The  database  name  must  begin  with  a  letter.  It  may  be  max.  120  characters  long  and  only
contain the following characters: 'A..Z', 'a..z', '0..9', '_', '@', '#', '$'.

Or:

Click Default name to generate a name automatically. The default name is "cm_online". If a database already exists
with this name, a serial number is appended ("cm_online1", "cm_online2", etc.).

Click on Execute.

The program creates the database and automatically appends it to the selected CM database.
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5.1.3.2 Attach database (register)

Attach a database to the SQL server as follows:

Select the database server and the database (see “Select CM database on server" ).

Click Actions > Attach database.

Click Browse... in the Data files section and select the appropriate database file (*.mdf).

Click Browse... in the Log file section and select the associated LDF file.

To avoid problems with MS SQL Express, please always use the default directory used during
installation  for  database  files!  The  default  directory  for  Microsoft  SQL  Express  is  "C:\?All
Programs\Microsoft SQL Server\MSSQL.1\MSSQL\Data\".

To attach a database from a directory other than the default directory, the “Everyone” user must
have  full  access  to  this  directory.  If  you  have  any  questions,  please  contact  your  system
administrator.

Click Clear list to remove the selected database files (MDF and LDF).

The  program  automatically  detects  the  database  name  from  the  file  name.  Alternatively,  you  can  enter  a  different
name for the database in Database name. Click Default name to undo this change and use the name from the file
name again.

The  database  name  must  begin  with  a  letter.  It  may  be  max.  120  characters  long  and  only
contain the following characters: 'A..Z', 'a..z', '0..9', '_', '@', '#', '$'.

Click on Execute. The program attaches the database.
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5.1.3.3 Detach database (deregister)

You can only  detach a database if  it  is  not  being  used  by  the  Administrator  software  or  other
programs.

You can detach a database from the SQL server as follows:

Select the database server and the database (see “Select CM database on server" ).

Click on the appropriate database in the list of Available databases.

Click Actions > Detach database.

Click on Execute.

The database is detached from the SQL server and removed from the list of available databases.
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5.1.3.4 Backup database

Secure your CM databases at regular intervals, so that they can be restored if necessary.

You can back-up a database as follows:

Select the database server and the database (see “Select CM database on server" ).

Click on the appropriate database in the list of Available databases.

Click Actions > Backup database.

Click Save Backup to and select the MS SQL backup directory and a name for the backup file.

Click on Execute.

The program saves the database.

If you wish to overwrite a backup file, you can keep it as a history. The new backup file is then
saved with a serial number.

To avoid problems with MS SQL Express, please always use the backup directory  created
during  installation!  The  backup  directory  for  Microsoft  SQL  Express  is  "C:\Programme
\Microsoft SQL Server\MSSQL.1\MSSQL\Backup\".
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5.1.3.5 Restore database

You can restore a database as follows:

Select the database server and the database (see “Select CM database on server" ).

Click Actions > Restore database.

Click Restore database from and select the backup file (*.DAT).

In order to overwrite the existing database with the backup file,  close all  other programs first.  Then click  Overwrite
existing database. 

If you select "Overwrite existing database", all data of the existing database will be lost!

Or:

Click Create new database to create a new database from the backup file and automatically append it.

The  program  automatically  detects  the  database  name  from  the  name  of  the  backup  file  as  the  default  name.
Alternatively,  you can enter  a  different  name for  the database in  Database name.  Click  Default  name  to  undo the
change and apply the name of the backup file.

Click on the Storage location list and select a directory or click Default directory.

To avoid problems with MS SQL Express, please always use the default directory used during
installation! The default  directory for Microsoft  SQL Express is "C:\?All  Programs\Microsoft  SQL
Server\MSSQL.1\MSSQL\Data\".

To  save  a  database  in  a  directory  other  than  the  default  directory,  the  user  must  have  full
access to this directory. If you have any questions, please contact your system administrator.

Click on Execute.

The program restores the database from the backup file.
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5.1.3.6 Update database

Before you update a database, make a backup  of the database.

This function allows you to

update a CM database created with Administrator version 4.2 or higher or

update a bearing database from the FAG Trendline software

for use with the current Administrator version.

You can update a database as follows:

Select the database server and the database (see “Select CM database on server" ).

Click on the appropriate database in the list of Available databases.

Click Actions > Update database.

The database type and version number are displayed.

Click in the update script and select the appropriate script file for the database (see Table below).

By default,  the  script  files  (*.XML)  for  database  update  are  stored  in  the  program directory  of
the Administrator software in "Database Administration\resource\".

Database type Icon and label Update script

CM Database cm_online update_cm_online.xml

Bearing database cm_bearings update_cm_bearings.xml

If you have selected an update script, the program automatically checks whether it can be used with the database. If this
check is successful, you can update the database.

Click on Execute.

The program updates the database.
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5.1.3.7 Delete database

To delete a database:

Select the database server and the database (see “Select CM database on server" ).

Click Actions > Delete database.

Make sure that you have selected the correct database to delete.

Click Execute and confirm the warning about deleting the database.

CAUTION If  you  delete  the  selected  database,  the  database  and  the  data  it  contains  are  deleted
irretrievably!
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5.1.3.8 Refresh view

If you have made changes to the databases you will need to refresh the database view.

Click File > Refresh tree.

Or:

Press F5.

The list of "Available databases" is reloaded.

5.1.3.9 Log files

The Administrator software logs information about system messages, database actions and import/export processes in
separate log files.

For  support  purposes  you  can  automatically  assort  these  log  files  in  Configuration  Manager  and  send  them  to  our
Support .

Assort log files

Click Assort log files in the Extras menu.

Select the data to save for support purposes.

If you select "data files", the file size may be too big to e-mail the log files.

Define the start date from which to assort the files and

select a directory to save to.

Click OK.

Depending  on  the  version  of  Windows  installed  on  your  system,  the  log  directory  is  at  the
following default location:

Windows  7,  Windows  8:  In  the  "Common  Application  Data”  directory,  e.g.  c:\Program  Data
\Condition Monitoring\Administrator\logs.

Open log folder

Click Open log folder in the Extras menu.

The log directory is displayed in Windows Explorer. You can open log files in a text editor.

5.1.3.10 Database properties

Displays properties and other information about the selected database.

Select a database from the Available databases list and

click Extras > Database properties.

The following information about the CM database being used is displayed:

Name of the database server

Name of the database

Used memory

Free memory

The ratio of free to used memory is also presented as a diagram.

The free memory display and the diagram can only return plausible information if the database
and database server are on the same system.

Other database properties are displayed in addition to the database information:

Name of the database

Type and version of the database

Storage location of the database files (MDF and LDF)

250



45

Configuration Manager

5.1.3.11 Settings

You can open the general program settings configuration window via the Tools > Options menu item.

To change the settings the user currently logged in must have the required access rights (see
"User management ").

A tree  view is  displayed  on  the  left-hand  side  of  the  window and  shows  a  range  of  configuration  options  arranged  in
groups. You can expand the view and configuration options by clicking the symbols in front of the groups.

Information on the individual configuration options is provided or input masks are displayed on the right-hand side of the
window.

General

Language

In this dialog you can choose a different language for the user interface. The program must be restarted if the language
setting is changed.

Select the required language.

If you wish to apply the change directly close the window with "OK", or you can make additional settings.

Database

History

If this option is selected a list of all databases opened to date is displayed on the right. The entries in this list are the one
used to open databases from the File > Open database menu. You can also use this option to delete entries in this list
for clarity of overview.

To delete an alarm list entry:

Select one or (by holding the CTRL key down) multiple items from the list and

press the Delete item button to start the deletion operation.

Miscellaneous

The following information about the CM database being used is displayed:

Name of the database server

Name of the database

Used memory

Free memory

The ratio of free to used memory is also presented as a diagram.

The free memory display and the diagram can only return plausible information if the database
and database server are on the same system.

Contact

Our address, telephone and fax number as well as our e-mail and Internet address are provided here.
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5.2 Log in as / switch user

You can Change database  in the login dialog by clicking the button.

The user list always displays the users of the database currently connected.

Log in as user

When you first start the Administrator software, the program prompts you for your user name and password.

Select a user and enter the password. At this stage you can change your password at any time. Click OK  to start  the
program.

In order to use the Administrator software, you must log in as a user. As delivered, there is no
password for the "admin" and "guest" users. To prevent unauthorized access to software and
data you should assign a password for the “admin” without delay (Further information in User
management ).

A  user  must  always  be  logged  in.  If  you  cancel  the  Login  dialog  three  times  in  a  row,  the
software automatically closes.

If you wish to log in automatically with a user name and password, you can configure an “Auto-login"  in the options.

Change user

Click Change user in the Extra menu.

Select a log-in name from the list of users created in the user management , enter the password and click OK.

If  you  change  user  data  via  the  user  management  (create  a  new  user,  for  example)  the
configuration manager must be restarted in order for the updated list of users to be loaded.

5.3 Set up planning level
With  the  aid  of  planning  levels  you  can  combine  devices  and  their  configurations  in  a  branch.  For  example,  you  can
assign devices in different buildings to a single planning level  with  the name of  the building.  You can create planning
levels at all levels of the tree structure Devices and configurations.

You can build up a hierarchy of up to 5 planning levels. To add a planning level, right-click to call up the context menu in
the tree structure:

Select Add item for a planning level of the top hierarchy.

Select Add sub-item to create a subordinate planning level.

Please refer to the following sections for details about working with planning levels.

General

This tab displays all devices, along with their name and type, that are combined in the planning level.
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Image

You can store a suitable image for the planning level (for example) here. You can use either JPEG or BMP files. Images
with a file size exceeding 500 kB are automatically scaled down and compressed.

To do this click on  and select the file that contains the preferred image using the selection dialog box.

Follow the same procedure as above if you wish to change the image.

Click on  to delete the image and click on  to print it.

Additional information

This tab is used to enter any text, e.g. to add further information about the planning level.

Advanced settings

You can configure additional settings for e-mailing export data (E-service) on this tab. For more information, refer to the
chapter "Export and send data" .

Edit name of entry in planning level

Double-click the name.

Enter the name in the input box and click  on the toolbar.

The edited name is displayed in this overview and in the tree view Devices and configurations.

Edit additional entry information name in planning level

Double-click the additional information.

Enter the text in the input box and click  on the toolbar.

Reset alarm(s)

You can reset the alarm status for an entry (cf. "Reset alarm status" ):

Select a device configuration.

Right-click the selection and select Device > Reset alarm(s) or

click on .

Update alarm state

You can update the alarm state for one or all tree items. 

Select a device and

click Update alarm state of selected nodes in the Edit menu.

Or:

Click Update all alarm states in the Edit menu.

Display device serial number

You can display the serial number of each device in the tree view. If the device is available, it is displayed:

Select the device in the tree view.

Right-click to call up the context menu.

Select Go to device in the context menu.

Or:

Select the device and press CTRL+G.

Refresh tree view

Click on .

Or:

Press CTRL+R or F5.

5.4 Set up device communication
You can connect a device to a PC using the following communication methods:

direct serial connection,

modem or GSM modem connection,
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TCP/IP protocol network connection. The ProCheck device has a network interface and supports the TCP/IP protocol.
In the Dtect X1s device, the integrated “COM server" manages the network connection between the Dtect X1s device
and PC.

The program always connects to a device when you do the following in the Configuration Manager 

create a new device ,

connect  to a selected device.

The connection build-up progress window then appears:

To configure the communication proceed as follows:

Select the tab containing the required connection type.

Configure the appropriate settings as described in "Direct serial connection" , "Modem connection"  and "TCP/
IP connection" .

If the device is password-protected, enter the passwords in the Configuration Manager. Cf. “Passwords" .

Click the OK button to begin establishing the connection.

You connection mode selection is saved along with your settings.

If  you  wish  to  use  the  same  method  to  establish  a  connection  with  the  device  the  next  time
round, click OK to confirm this.

5.4.1 Direct serial connection

This connection type is characterized by the serial transfer of data. Before you configure the connection make sure that

the serial interface is selected on the specific device (see ProCheck and Dtect X1s manual),

the serial interface of the device is connected to the serial interface of the PC with a suitable serial cable,

the configuration manager has detected the connected serial interface and the data transfer rates of both interfaces
are identical.

A  commercially-available  serial  cable  is  supplied  for  connection  of  the  Dtect  X1s  device  to  a
computer. This cable is not suitable for connecting the Dtect X1s device to a modem. Refer to
the Dtect X1s device manual for a wiring layout.

Select the Serial tab.

Select the serial interface to which the data cable for connecting the device is connected.
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Select the speed to be used for communication with the device via the serial connection. The standard baud rate is
9600 baud.

Confirm your selection with OK.

The connection is automatically established.

If the data transfer rates at the computer and device are not the same you will  receive a message that the connection
could not be established. In this instance try to establish the connection using another data transfer rate.

You can edit the transfer rate of the interface of the selected device in the Configuration Manager:

Right-click the device in the Configuration Manager and select Baud rate.

Or:

Click the device in the Configuration Manager and click Baud rate in the Device menu.

Please observe that the baud rate at the device can only be modified if the device is connected
to the control computer via a direct serial connection.

5.4.2 The modem connection

With  this  type  of  connection  data  is  transmitted  via  a  fixed  line  telephone  network  or  a  mobile  network.  Before  you
configure the connection make sure that

a landline modem or GSM modem is connected to the "Config/Com" interface of the Dtect X1s device, 

the control computer also has a modem connection configured for Windows. For more information please refer to the
documentation supplied with your modem and the Windows manual.

This section describes which minimum requirements the modem must meet and also how to set up the control computer
and the ProCheck or Dtect X1s device so they can communicate with one another via the modem.

Please note that you can only connect a landline or GSM modem to the Dtect X1s device using
a null modem cable. Refer to the Dtect X1s device manual for a wiring layout.

The  following  sections  explain  only  how to  establish  the  data  connection  using  commercially-
available modems. Consult the instructions for use supplied with the modems to find out about
their special features, how they operate and how they can be connected to a telephone network
and subsequently configured.

System requirements for the modem

For the modem connection to function correctly it  must be possible to make specific  settings on the Dtect X1s device
side. These are sent to the modem using what are known as AT commands.

The most important configuration options and commands are listed below.

As  the  configuration  options  and  AT  command  set  may  vary  between  modems,  check  and
compare this information with the instructions provided with your modem.

Function AT command Explanation

Echo On
Echo Off

ATE1
ATE0

Echo: All characters received by a modem in command mode are returned to the sender.

Auto-Answer on 
Auto-Answer off

ATS0=1
ATS0=0

Auto-Answer: The modem automatically responds in the event of an incoming call.
This function must be switched on at the modem on the Dtect X1s device.

DTR on
DTR off

AT&D2
AT&D0

Response of modem to a change of voltage at the DTR line: Modem on Dtect X1s device: "DTR
off".
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5.4.2.1 Connection with control computer via fixed network modem

Make sure that:

the modem is connected to the telephone network as described in the relevant manual, is connected to a free serial
interface on your control computer and is configured for Windows, and

the modem is switched on.

Select the Modem tab in the Add communication channel window.

Please enter the phone number of the modem to which the device is connected in the Telephone number box. If the
modem at the control computer is on a branch line of a telephone system you will probably need to insert the digit 0 in
front of the phone number to obtain the network.

Select the modem you wish to use to establish the connection from the Modem list box.

Click OK.

Your  input  is  then  saved  for  the  next  time  you  wish  to  establish  a  connection  and  a  connection  with  the  device  is
established. If you selected the "Request password" option when configuring the device (see "Set up modem at device"

), you will be asked to enter it when the connection is being established.

If your modem is connected on a branch line of the telephone system you will have to make the
corresponding settings when installing the modem driver otherwise your modem will not be able
to establish a connection.

Please  observe  that  you  can  only  establish  the  connection  if  you  have  configured  the
modem which is connected to the device.

5.4.2.2 Connection via GSM modem at control computer

The GSM modem only differs slightly from the fixed network modem when used in conjunction with the control computer.
If a Windows driver was not supplied with the GSM modem, install a standard modem with a data transfer rate of 9600
baud.

Make sure that:

the modem is correctly connected to the control computer,

a SIM card that is enabled for the outgoing communication of data is used, and

the modem is switched on.

Call up an appropriate command in the configuration manager to establish a connection.

Select the "GSM" tab in the "Connect with device" window.
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Configuration Manager

You can select the modem connected to the control computer and enter the phone number in this tab.

Select the modem required or GSM operation from the "TAPI Modem" list box.

Enter the phone number of the modem in the "Telephone number" field by which the device can be contacted.

Close the dialog box by pressing the OK button.

Your input is then saved for the next connection session and a connection with the device is established.

If the GSM modem is not yet registered in the network you will be asked to enter the PIN.

If you selected the "Request password" option when configuring the device (see "Set up modem at device" ), you will
be asked to enter it when the connection is being established.

5.4.2.3 Set up modem at device

ProCheck

To install a modem on the ProCheck, the device must be created in the Configuration Manager and it must be possible
to make a connection via the serial interface or TCP/IP network.

Click the device in the Devices and configurations tree view.

Configure the modem connection in the Communication settings  tab.

Send the configuration to the device (cf. "Send device configuration to device" ).

Dtect X1s

Modem setup is carried out in three steps:

1. The  configuration  required  for  operation  of  the  modem is  first  of  all  stored  in  the  device  with  the  assistance  of  the
configuration manager.

2. The serial interface of the device is then configured.

3. The modem is then connected to the device and restarted in order to transfer the modem configuration from the Dtect
X1s device to the modem.

Start the configuration of the Dtect X1s modem as follows:

establish and activate a direct serial connection between the Dtect X1s device and control computer.

Select  the  connected  device  in  the  Configuration  Manager  then  go  to  the  Device  settings  tab  in  the  properties
display on the right-hand side.

The configuration data for the Dtect X1s modem currently stored in the database are displayed in this tab. If the bottom
section of the tab is coloured red this indicates that the modem configuration saved in the database is not the same as
the modem configuration stored in the Dtect X1s device. The Replace with device values option overwrites the values
stored in the database with those of the Dtect X1s device. Conversely, the Send to device option updates the Dtect X1s
device with the configuration data saved in the database.
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Details of configuration:

Select the modem type to connect to the Dtect X1s device from the “The device communicates via..." list box.

Enter the AT commands you wish to use to initialize the modem in the Initialization field. The DTR Off, Echo Off and
Auto-Answer  On  settings  are  required.  The  initialization  string  with  the  modem  commands  described  in  "Modem
requirements " is ATE0&D0S0=1. This initialization corresponds to the Dtect X1s device default setting.

You  can  execute  several  AT  commands  successively.  Commands  requiring  a  "Carriage  Return"  at  the  end  must  be
completed with the + CR switch. Additional commands may be entered after this.

It is still necessary to enter the phone number of the Remote Server to be used by the Dtect X1s device to send its
data in the Phone number field and

to configure the dial mode with which the Dtect X1s device connects using the selection boxes “Multi-frequency" and
“Pulse dial". Where GSM modems are used please select "Multi-frequency".

Additional information on remote operation is provided in "The Remote Server ".

If a GSM type modem is used:

enter the 4-digit PIN in the PIN field. This is required to verify the access rights during the initialization phase before
dialling in to the mobile network. You will be given this four digit PIN when registering with the network operator.

Please enter the PIN carefully. If the incorrect number is sent three times to the mobile network
modem any further attempts to enter the PIN will initially be blocked.
The PIN input can be enabled again using a suitable program. To do this,  refer to the manual
supplied with the modem.

A time interval for re-initializing communication can be specified in Reinitialization interval. This means (for example)
that if the connection with a GSM modem is interrupted, the modem is re-initialized and logs in to the network once this
time has elapsed. Set the time interval to "0" if you do not wish the modem to be re-initialized automatically. In this case
the Dtect X1s device will only be re-initialized each time it is restarted.

It may also be useful to specify automatic re-initialization where fixed network modems are used. The modem's settings
may  be  lost  if  it  is  switched  off  then  switched  back  on  later,  for  example.  Re-initialization  ensures  that  the  modem
receives the necessary settings again within a defined period and can therefore continue to receive and send data.
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The input in the "Device settings" tab is now complete.

Save the settings and send them to the Dtect X1s device.

The configuration is now sent to the Dtect X1s device and saved there.

Adjust the baud rate to be used by the Dtect X1s device to communicate with the modem via the context menu (also
see "Direct serial connection "). 

In  contrast  to  fixed  network  modems,  the  majority  of  mobile  network  modems  do  not
automatically adopt the data transfer rate of the connected Dtect X1s device. Please therefore
ensure  that  the  Dtect  X1s  device  and  modem  are  using  the  same  data  transfer  rate  on  their
shared data connection. The default data transfer rate for GSM modems is normally 9600 baud,
but in some cases 19200 baud is also used.

Now disconnect the serial connection between the control computer and Dtect X1s device.

The Dtect X1s device restarts.

Connect the Dtect X1s modem

Once you have sent the modem configuration to the Dtect X1s device and made sure that the data transfer rate for the
connection between Dtect X1s device and modem is configured correctly you can connect the modem to the Dtect X1s
device.

First switch off the Dtect X1s device.

Connect the modem to the telephone network and the "Config/Com" serial  interface on the front  panel  of  the Dtect
X1s device as described in the manual supplied with the modem.

Switch the modem on.

Switch the Dtect X1s device on.

The  Dtect  X1s  device  is  then  restarted.  When  the  device  restarts  it  detects  that  a  modem  is  connected  to  the  serial
interface and sends it  the saved modem configuration.  The modem connection has now also been  configured  on  the
Dtect X1s device.

Automatic modem detection

Each  time  it  restarts,  the  Dtect  X1s  device  carries  out  an  automatic  search  for  the  modem.  This  is  indicated  by  the
"Search modem" message on the display. If a modem is not connected to the Dtect X1s device, it automatically enters
direct serial communication mode.

If the Dtect X1s device detects a modem on the serial interface, this is initialized. All strings sent to the modem for the
purposes of  initialization as well  as  the responses by the modem are displayed by the Dtect  X1s  device.  This  makes
troubleshooting  easier  should  problems  arise  in  conjunction  with  the  modem  operation.  The  sequence  is  described
below using a connected GSM modem as an example.

On  the  Dtect  X1s  device,  the  following  messages  are  displayed  in  the  top  two  lines  of  the
display.

48



54

Start of modem detection

Modem detection started, Dtect X1s device waiting for modem to respond.

The connected modem has been detected.

Dtect X1s device has detected modem.

Checks are carried out to determine whether the GSM modem is already registered in the network.

Is modem registered? +CPIN:SIM PIN response means that modem requires a PIN

If not, the modem is registered by sending the PIN.

PIN was sent. Response by modem to confirm acceptance of PIN.

The modem was successfully registered in the network.

Registration of the GSM modem successfully completed.

The modem is initialized, the corresponding AT command is sent

The Dtect X1s device sends initialization string from modem configuration

Modem responds with "OK". Initialization successful

The modem responds with "OK", initialization is complete.

Initialization successfully completed.

The Dtect X1s device changes to monitoring mode.
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The error messages that can occur when the modem is in operation as well  as their possible causes are listed in the
table below which is intended as a troubleshooting aid.

Messages Possible cause

No Answer Modem is not responding. 

Timeout The maximum waiting period in which a response must be received from the modem has been exceeded. The
flow of data has been interrupted.

Wrong Frame The character frame received contains error(s). The responses from the modem do not start and end with
<CR><LF>.

Modem deselected A modem was detected on the Dtect X1s device. However, the initialization failed. The modem operation was
switched off.

Can’t init modem The modem could not be initialised.

Pin rejected! The PIN that was sent was rejected by the network. The GSM modem cannot be registered.

Pin locked Sending of the PIN during automatic modem detection has been locked because the PIN has been rejected twice
as invalid. This function prevents locking of the SIM card due to repeated restarting and sending of the incorrect
PIN. The lock can be removed by sending a new modem configuration to the Dtect X1s device or by resetting the
system.

No simcard A SIM card has not been inserted into the modem.

Send timeout The Dtect X1s device could not send characters for one of the following reasons: a modem is not connected to the
device or the send function for the connected modem has been locked.

5.4.3 TCP/IP connection

ProCheck

Get the network administrator to give you an IP address for the ProCheck device.

Configure the TCP/IP network connection with the assigned IP address on the ProCheck device, as described in the
ProCheck  manual  (chapter  “Operating  instructions   CM  Installer   ProCheck  Configure  device",  section  “IP
settings").

The necessary administrator settings are made in the Add communication channel  window. This  window appears  if
you  wish  to  register  a  new  ProCheck  device  in  the  Configuration  Manager  or  begin  establishing  a  connection  for  a
device already registered in the configuration manager.

Click the TCP/IP tab.

In the IP address box enter the network address (IP address) of the ProCheck device and port number 8000 in the
Port box.

Click OK.

Your input is saved for the next time you wish to establish a connection and a connection with the device is established.

Dtect X1s

The  TCP/IP  connection  is  available  to  you  if  your  computer  is  connected  to  a  computer  network  and  the  Dtect  X1s
device  is  also  connected  to  this  network  via  an  auxiliary  device  known  as  a  “COM server".  The  internal  COM server
ensures compatibility of the Dtect X1s device with the network. Before a TCP/IP connection can be established between
the  control  computer  on  which  the  configuration  manager  is  loaded  and  the  Dtect  X1s  device  the  device  must  be
connected to the computer network. The COM Server serves this purpose. It is a computer network component that can
be connected via a serial interface to devices that do not have a network interface.

For additional information refer to the COM server operating instructions.

With the Dtect X1 device, you must activate the Telnet client in Windows 7 first. This requires
administrator  rights  on  your  system.  Open  “Control  Panel  >  Programs  >  Programs  and
Functions > Turn Windows features on or off”, activate "Telnet Client" and click OK. You can
then establish the connection via the Telnet protocol.

With the Dtect X1s device, please use Net Utility to configure the communication settings.

Proceed as follows to prepare the Dtect X1s device for the TCP/IP connection.

Make sure that the TCP/IP protocol is installed on the control computer. Consult your network administrator for more
information.

Ask your network administrator to provide you with a network address (IP address) for the Dtect X1s device.

Connect the COM server to the network and specify your IP address.
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As is the case with the direct serial connection between the computer and Dtect X1s device, a
standard cable is used to connect the Dtect X1s device to the COM server.
Refer to the COM server manual to find out how to connect it to the network and transfer the IP
address.

Make  sure  that  the  serial  interfaces  on  the  Dtect  X1s  device  and  COM  server  are  operating  with  the  same  data
transfer rate (see "Direct serial connection " or COM server manual)

Connect the Dtect X1s device to the COM server using the data line for serial data transmission provided.

The Dtect X1s device has now been configured for a TCP/IP connection.

TCP/IP connection settings in the configuration manager

The necessary administrator settings are made in the "Establish connection" window. This window appears if you wish
to  register  a  new Dtect  X1s  device  in  the  Configuration  Manager  or  begin  establishing  a  connection  for  a  Dtect  X1s
device already registered in the configuration manager.

Select the "TCP/IP connection" tab here.

The "TCP/IP connection" tab

Enter the network address (IP address) of the COM server in the "IP address" field;

Select the port number of the COM server connected to the Dtect X1s device from the "Port" field;

Close the dialog box by pressing the OK button.

Your input is then saved for the next time you wish to establish a connection and a connection with the Dtect X1s device
is then established.

5.4.4 Password settings

To protect against unauthorised access, you can protect ProCheck and Dtect  X1s with  one password (Dtect  X1s with
3.0/3.2  firmware)  or  two  passwords  (ProCheck  and  Dtect  X1s  as  of  3.4  firmware).  These  are  entered  in  the
Configuration Manager  in device settings.

ProCheck
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Configuration Manager

Dtect X1s

BOTH  passwords  must  be  entered  if  password  protection  is  required.  Once  the  passwords  have  been  sent,  three
security levels exist and are set when the connection is being established:

No password

(Dtect X1 / Dtect X1s only)

If no password is input when the connection is made, you can only read data from the device. It is not
possible to edit device settings or configurations.

User password If the user password has been entered correctly when the connection is being established the user may
also reset the device alarm status and restart the device.

Power user password If the power user password is entered correctly when the connection is being established the user can then
change all device settings. In this case it does not matter whether the first password (user password) has
been entered correctly or not.

The  device  is  supplied  ex  works  with  password  protection  disabled,  the  passwords  in  the
device settings are empty.

If a password has not been entered in the device settings but has been entered in the device
this  will  be  requested  during  the  connection  build-up  procedure.  If  the  password  entered  is
incorrect a connection will not be established.

5.4.4.1 Connect to password-protected device

Dtect X1 / Dtect X1s (Firmware 3.0/3.2)

The password input in the device settings is sent to the device. If it matches the password in the device, the connection
is established, data can be read and configurations can be written. If password protection is activated but no password
has been entered, you are automatically prompted for a password.

ProCheck and Dtect X1 / Dtect X1s (firmware 3.4 or higher)

The first and second password input in the device settings are sent to the device. If the passwords do not match or if the
password fields are empty, the user can only read data (but cannot configure any settings).
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5.4.4.2 Edit passwords

To  edit  passwords,  first  connect  to  the  device  using  the  old  passwords.  As  soon  as  the  connection  has  been
established, the passwords may be changed. Enter the new password twice. Then click Send to device to change the
passwords.

If the device password protection is deactivated the connection must be established with empty
password fields.

5.4.4.3 Activate password protection

To activate password protection, first connect to the device without entering any passwords. As soon as the connection
has been established, the passwords may be changed. Enter the user and power user password (as of firmware version
3.4) twice. Then click Send to device to activate password protection.

When using devices with firmware version 3.4 or higher, the power user password must always
be  entered  when  activating  password  protection.  If  the  power  user  password  field  is  empty,
password protection is deactivated!

5.4.4.4 Deactivate password protection

To deactivate password protection,  first  connect  to  the device with  the current  passwords.  Once  connected,  clear  the
password fields. Then click Send to device to deactivate password protection.

Password protection is also deactivated in the event of a total system reset.

5.5 Connection to a device
If you wish to:

transfer a new device configuration to a device or

obtain measuring data, alarm statuses and configurations from a device in the configuration manager

you must establish a data connection with the relevant device.

As  of  version  3.8  of  the  Administrator  software,  Dtect  X1s  devices  do  not  send  modem
configurations to the computer.

Establishing a connection

First, open the Establish connection window as follows:

mark the device in the directory of devices and configurations then 

either

open the context menu with the right-hand mouse button

and select the item Device > Connect to selected device 

or

press the  button in the button bar.

Click the OK button in the Establish connection window to begin establishing the connection directly using the same
method and settings previously used.

Otherwise you can change the connection type or settings as described in "Set up communication with device" .

Once the connection has been established, information on the configuration and alarm statuses is transferred. You can
then carry out the desired operations.

End connection

You can end a connection with a device as follows:

by pressing the button  in the button bar.
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Check connection to a device

Devices with an overdue remote call that fail to respond are indicated by a clock icon  in the tree. You can have the
connection to these devices checked automatically.

Click Check connection of not calling devices in the Extras menu.

The  software  attempts  to  connect  to  these  devices  in  order.  If  this  is  not  possible,  you  can  edit  the  device’s
communication  settings  in  the  next  step.  If  the  next  attempt  to  connect  fails  too,  please  check  all  of  the  device’s
connection settings . For further information, refer to the “FAQ"  section.

You  can  also  search  for  overdue  remote  connections  in  the  CM  database.  Click  Check
database  for  overdue  remote  connections  in  the  Extras  menu.  Then  click  Check
connection of not calling devices  in the Extras  menu. The program checks the status of all
devices and modifies them if necessary. 

5.6 Manage devices

Create device

Every device to be controlled must be created first.

Click on  in the toolbar.

Or:

In the Device menu click Create new device .

In Connect with select the device type Dtect X1s or ProCheck.

Enter the type of connection and appropriate parameters in the Establish connection dialog as described in "Setting
up communication with a device" . Click OK.

The Configuration Manager establishes the connection with the selected device and saves the settings for the next time.

Finally, confirm registration of the device with OK.

This  adds  the  device  to  the  list  of  devices  and  configurations.  The  Configuration  Manager  automatically  generates  a
name based on the serial number of the device.

When you create a new device whose settings are identical  to those of an existing device, no
new device is created. Instead the existing one is highlighted in the tree.
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You can enter a name and location to identify the device in the top part of the Configuration Manager window. These
details are only saved in the CM database. In addition, this section also displays the software version,  serial  number,
and times of the last and next scheduled communication (Last call, Next call) with the device.

The tab Additional information is used to enter any text, e.g. to add further information about a device.

Edit name and installation location of a device

Click the device in the Devices and configurations list.

Enter the name and installation location in the appropriate input boxes.

On the toolbar, click on  or Edit > Save.

Delete device

When you delete a device, it is deleted along with all device and monitoring configurations and
the associated data from the CM database. It is not possible to restore a deleted device.

Delete a device as follows:

Right-click the device in the list of Devices and configurations and select Delete or click Delete in the Edit menu.

Click Cancel in the confirmation dialog if you do not want to delete the device or OK to confirm deletion.

If  the  configuration  to  be  deleted  contains  a  large  number  of  records  (several  thousand),  the
deletion  process  may  take  several  minutes.  During  this  process,  you  cannot  use  the
Configuration Manager for any other purpose. If you try to quit  the Configuration Manager, the
title bar of the program window displays "Not responding" status.
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5.6.1 Device properties

This tab displays the hardware properties of the selected device.

You can display the properties of a device in the configuration manager as follows:

Click on the device in the device and configurations list.

Click the Device properties tab.

ProCheck

Module overview

This section displays information on the available input and output channels of the ProCheck device:

Number of available input channels,

Number of available digital outputs,

Number of available additional channels,

Number of available analog outputs,

Number of available virtual channels,

Multiplexer type (MUX type).

Slot overview

This section displays information on the modules used in the ProCheck device:

Number of connector,

Module type (measuring channels, additional channels, digital outputs, etc.)

Module information (e.g. 9233 or 9201)

Channel numbers (e.g. 1-8, 9-16 for two modules with eight channels each)
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Detailed  technical  information  on  the  available  module  types  can  be  found  in  the  ProCheck
manual or in the ProCheck Modbus TCP manual.

Dtect X1s

The device properties are:

number of available sensor inputs,

number of available additional channels,

number of available D/A channels,

maximum number of monitoring configurations,

maximum number of frequency bands for each monitoring configuration,

type of the available filter module,

frequency tracking option;

demodulation generating option,

an overview of available sensors on the respective channels.

Note that the performance features of your Dtect X1 /  Dtect  X1 device depend on the chosen
device specification and may not correspond with the information shown in the illustrations.
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5.6.2 Device settings

ProCheck

Alarm conditions

Alarm occurrences before output: Enter the number of threshold events before an alarm is given.

Reset  main  alarm  manually:  Enable  this  checkbox  to  save  main  alarms  until  they  are  manually  reset  in  the
Configuration Manager.

Reset  pre-alarm  manually:  Enable  this  checkbox  to  save  pre-alarms  until  they  are  manually  reset  in  the
Configuration Manager.

Password settings

Enter the passwords for establishing a connection here (cf. "Passwords " for further details).

Time zone settings

Enter the deviation of local ProCheck device time from UTC co-ordinated world time in minutes.

Data file size settings

You  can  modify  the  data  file  size  on  the  ProCheck  device  here.  If  the  size  of  the  data  exceeds  the  critical  file  size
configured,  you can initiate  a remote call  in  case  of  disk  overflow .  If  the  maximum data  file  size  is  exceeded,  the
oldest measuring data are deleted!
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Dtect X1s

Password settings

Enter the passwords for establishing a connection here (cf. "Passwords " for further details).

Communication settings

Configure the device connection as described in “Setting up device communication" .

5.6.3 Communication settings

This tab is only used for ProCheck devices.

CAUTION Loss of data on the ProCheck device if communication intervals are too long

If you measured data cached on the ProCheck device are not retrieved (by the remote server or
manually), the device deletes the oldest records when certain thresholds are exceeded. If  you
want to manually download data from the ProCheck device during the delete process with the
Configuration  Manager,  they  may  already  have  been  deleted  but  this  may  not  have  been
signalled to the Configuration Manager yet. In this case the Configuration Manager signals that
a requested file was not sent by the ProCheck device. These data are irretrievably lost!

Because  the  volume  of  measured  data  recorded  depends  on  your  system  configuration,  we
recommend using and configuring the remote server accordingly so as to avoid loss of data. If
data are only transferred manually, loss of data cannot be ruled out completely.

You can configure the communication channels available on the ProCheck in this tab.
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Serial interface

modem (via the serial interface)

Network (via the Ethernet interface)

Also, you can specify the communication mode between a ProCheck device and a remote server.

Information about communication settings

The  volume  of  measured  data  recorded  depends  to  a  great  extent  on  your  individual  system  configuration.  Use  the
following  data  volume  calculation  for  a  sample  configuration  to  help  you  choose  the  appropriate  settings.  You  can
determine the appropriate settings for your system with the aid of this information.

Configuration

Number of monitoring configurations 8

Number of time signals per monitoring configuration 2 (raw and demodulation signal)

Number of samples per time signal 8192

Number of FFT per monitoring configuration 2 (for raw and demodulation signal)

Number of lines per FFT 4096

Number of characteristic values in frequency range 2

Number of characteristic values in time range 2

Interval to save time signals to the ProCheck flash disk 6 h

Interval to save characteristic values to the ProCheck flash disk 10 min.

Interval to transfer measured data to the ProCheck queue 4 h

Interval for remote communication (see also "Remote settings"  in this section) 5 h

Data volume

Total data volume per hour approx. 200 kB

Total data volume per day approx. 4.7 MB

Volume per monitoring configuration and day approx. 600 kB

Number of ProCheck queue items per day 85

Total data volume per year 1.7 GB

66



66

Configuration

Note: The data volume caused by alarms cannot be reliably estimated and is therefore not included in this calculation.

Communication devices supported

Select the desired communication devices. Serial connection and modem cannot be selected at the same time as they
use the same interface.

Remote settings

In this tab you can specify how a ProCheck device connects to a remote server.

Preferred communication device: Select the communication device to use for communication. If it is not available,
the device switches to the next available communication device. If you select No remote communication, the device
does not communicate autonomously with the PC or remote server.

Use remote timer expiration / Remote timer expires every: You can activate the remote timer and set a delay for
the ProCheck device to regularly establish the connection. The timer is reset after this time expires. In many cases a
time of 12 hours is sufficient.

Use connection times: Here you can activate a list of times and set a time for the ProCheck device to connect with
the remote server. In addition to the list, the specific time is also displayed relative to co-ordinated world time UTC.

Max. number of  connection attempts n for every remote address:  Restricts  the number of  connection attempts
(minimum 1) per remote address. If a new event occurs in the device, the device attempts to establish a connection
with  the Remote Server  following the expiry of  one  monitoring  cycle.  If  the  connection  is  established,  the  data  and
messages of all events that occurred at the Remote Server to date are transmitted and marked internally in the device
as  "reported".  Events  already  reported  are  not  reported  the  next  time  a  connection  with  the  Remote  Server  is
established. If a connection cannot be established with the remote server (telephone line engaged, for example), the
device attempts  to  establish a connection again once the time set  at  Minimum delays  between connections  has
expired.  This  option  can  also  be  used  to  limit  the  number  of  repeat  connection  attempts  per  remote  address.  If  a
connection cannot be established within this number of attempts a new connection build-up procedure is only started
when a new event occurs.
If  the  List  of  remote  server  addresses  contains  multiple  servers,  the  next  remote  server  address  in  the  list  is
automatically contacted after a failed connection attempt. Every server can be contacted the number of times set in
Maximum number of retries.

Maximum  connections  per  day:  Enter  the  maximum  number  of  times  the  device  may  connect  with  the  Remote
Server on any given day (minimum = 1, deactivation = 0).

Minimum Delay between connections: This is the minimum time the device will  wait before attempting to connect
again once a monitoring cycle has been completed following a failed connection between the device and the Remote
Server. In our experience, you should set a time of not less than 5 minutes.

Serial settings

In this section you can configure the serial interface of the ProCheck device (only displayed if you check Serial).

Baud rate: Interface speed

Serial timeout (sec.): Communication is stopped if no data is transferred within this time.

Packet settings: These settings should only be changed after consulting our support service (cf. "Contact" ).

Modem settings

Modem type: Select Modem for a landline modem or GSM for a GSM modem.

Baud rate: Modem speed

Serial timeout (sec.): Communication is stopped if no data is transferred within this time.

Modem initialization: Enter the AT command sequence for modem initialization here. If  your modem requires non-
standard commands, please refer to you modem manual.

Packet settings: These settings should only be changed after consulting our support service (cf. "Contact" ).

Ethernet settings

Server port: Number of the port on which the remote server receives data from the ProCheck device. Must be set to
8000.

TCP/IP timeout (sec.): Communication is stopped if no data is transferred within this time.

Packet settings: These settings should only be changed after consulting our support service (cf. "Contact" ).

List of remote server addresses

The  ProCheck  device  can  communicate  with  multiple  remote  servers,  which  you  can  specify  here.  If  a  connection
attempt fails,  the next remote server address in the list  is  automatically contacted.  Every server  can be contacted the
number of times set in Maximum number of retries.

250
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For the modem connection, please enter the phone numbers of the remote servers.

For  the  Ethernet  connection,  please  enter  the  IP  address  and  port  number  (pattern:  <n>.<n>.<n>.<n>:<Port>,  e.g.
192.168.0.55:8000).

5.6.4 Advanced settings

You can configure settings for call control and automatic e-mailing of export data and non-response alarms here.

Call control

Define how often a device should call here:

Activate Call control and

define when you expect the next call from the device. The days and hours input here are added to the time of the Last
call. The result is the time when the next call is expected.

If the device has not called by the expected time, a clock icon  is displayed next to it in the tree and a non-response
alarm is triggered. You can have this alarm e-mailed automatically by the Notify Link  software (see "Automatic  e-mail
notification (via Notify Link)" ). 

E-mail settings (for E-service and Notify Link)

You  can  define  the  e-mail  settings  for  sending  export  data  in  this  section.  You  can  compile  and  automatically  send
configurations and measuring data  with  both  the  E-service  function  and  with  the  Notify  Link  software  for  each
device in  the CM database.  By default,  the recipient  of  this  e-mail  is  taken  from the  details  on  this  tab.  If  you  do  not
specify  a  recipient,  the  global  e-mail  recipient  from  the  Configuration  Manager  options  (for  E-service)  or  from  the
Notify Link options  is used.

Proceed as follows to define an alternative e-mail recipient for device export data:

Enter an e-mail address in “To” and 

if necessary, activate the option to send a copy of this e-mail to the global e-mail recipient. It is displayed below the
checkbox for checking.

The contract number and comment can be automatically copied from the program settings.
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Automatic e-mailing (via Notify Link)

These settings are only effective if 

e-mailing is configured in Notify Link and

Notify Link us in run mode.

The Administrator software does not need to be running.

Export and send measurement data

This function is used to automatically export measuring data and configurations from the CM database and e-mail them
via Notify Link.

Enable the function Export and send measurement data.

Specify the time after which to export data.

You can limit  the data sent by e-mail  using the "But  only datasets  from the last  x day(s)"  option.  The "Only not  yet
exported data" option prevents resending data already sent (even if they are within the time range configured).

Send non-response alarms automatically

In  case a device  no  longer  calls  and  there  is  a  non-response  alarm,  you  can  automatically  send  an  e-mail  via  Notify
Link.

Activate Send non-response alarms and

set the number of e-mails to automatically send for one and the same alarm event.

Use “Reset" to reset the number of e-mails already sent to "0".

A non-response alarm can only be output if

a remote timer has been defined and

call control expects a call from a device at least once a day (1=minimum, 0=disable).
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5.6.5 Read out status report

Status report

The log file can be read out from the device via the  Device  >  Device log  menu item, provided a connection with  the
device  exists.  All  important  processes  are  also  recorded  and  can  be  used  as  a  troubleshooting  aid  in  the  event  that
problems with the device occur . The following messages may be output by the Dtect X1s device:

Message Meaning

System started The Dtect X1s device has been switched on or restarted.

Total system reset A total system reset has been triggered.

Error in global config Error in device configuration.

Error in modem config Error in modem configuration.

Loading default configuration Default configuration has been loaded.

Signal error The quality check detected an invalid time signal. The time signal was discarded.

PIN lock counter The content of the PIN lock counter is written into the log file following a restart. If an incorrect PIN is
entered when a GSM modem is used the counter counts down by one. If the PIN is entered incorrectly
twice the counter is set to zero and the Dtect X1s device will not send a PIN to the modem. The user now
has only one more chance to enter the PIN. If this is entered correctly the PIN lock counter is reset,
otherwise the PIN lock must be deleted with a PUK and a new PIN must be entered. For more information
refer to the operating instructions for your modem. If it is necessary to unlock the PIN using PUK, the Dtect
X1s displays an error message and a corresponding entry appears in the status log.

Modem found A modem has been found.

No modem found A modem has not been found.

GSM modem registered The GSM modem has been registered in the network.

GSM modem not registered The GSM modem could not be registered in the network, the reason for this is also provided.

GSM status unknown The Dtect X1s has attempted to verify whether the GSM modem is registered in the network but the
modem has sent an invalid response.

Can't reset GSM modem The Dtect X1s device has attempted to trigger a GSM modem reset but has failed.

Init modem done The modem has been successfully initialized.

Init modem error The modem could not be initialised.

Modem deactivated The modem has been deactivated.

Can't detect modem features The Dtect X1s has attempted to detect the available modem features but the modem has responded
incorrectly or not at all.

Modem reset disabled The modem does not support the reset command which consequently will not be used by the Dtect X1s
device.

Baudrate set to … The baud rate has been changed.

Invalid baudrate, setting default value The stored baud rate is not supported and the default baud rate will therefore be used.

Start communication A connection with the Dtect X1s device has been established.

Reset configurations The load default configuration command has been sent from the configuration manager. Default
configuration is loaded after restart.

Stop communication Communication has ended.

Reboot system The Dtect X1s device is restarted after the connection has been terminated.

Received new modem configuration The Dtect X1s device has received a new modem configuration.

Rejected new modem configuration The modem configuration received by the Dtect X1s device contained errors.

Set device clock The Dtect X1s device system clock was reset.

Set update mode The Dtect X1s device was set to update mode.

Login failed An incorrect password was entered when attempting to log in.

Start remote communication The Dtect X1s device is establishing a connection with the Remote Server.
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Message Meaning

Remote connect error The attempt to establish a connection with the Remote Server has failed. The reason is also provided.

Application connect error A connection with the Remote Server computer/modem has been established but the Remote Server
software is not responding.

Incomplete remote call The connection was interrupted when transferring data to the Remote Server.

GSM Status: Status of GSM modem.

Fast COM-Port found During self test it was discovered that communication with up to 115200 baud (X1S: 230400) is possible.

Standard COM-Port found During self test it was discovered that communication with up to 38400 baud is possible.

96KB Overlay RAM detected The additional overlay memory has been found.

Overlay RAM Test failed The overlay memory is defective.

1MB RAM detected 1MB of memory has been found.

256KB RAM detected 256MB of memory has been found.

5.6.6 Time

Display and synchronize device time

Right-click the device.

Click Device > Device time from the context menu.

Or:

Click Device time in the Device menu.

The program displays the device time and system time of your computer.

You can now synchronize the device time with the system time of your computer.

LOSS OF DATA All data on the device are lost when you synchronize the device time.

Download all data from the device before synchronizing the time.

Click Yes to synchronize the device time.

The device time is synchronized with your computer. The program disconnects and deletes all data on the device. The
device is then restarted.

Or:

Click No to close the window without setting the time.

5.6.7 Firmware version

The firmware version of the selected device can be displayed via the Device > Device version menu.

5.6.8 Restart

This function is only available for ProCheck devices with firmware version 2.0.4 or higher!

You can reboot the device from the menu: Device > Reboot device. Although the default configuration is loaded if the
"Load default configuration after reboot" option is activated, the communication settings remain unchanged. This means
that the modem settings, PIN, telephone number, baud rate, etc. are retained and communication will  still  be possible
following a restart.
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5.7 Configure device for remote server

5.7.1 Communication/connection parameters

All connection types that are available for manual operation are also available for remote operation. First configure the
ProCheck or Dtect X1s device for the preferred connection type as described in "Set up communication with the device

".

In order for a device to be able to connect with the remote server, it requires information on how to contact the remote
server:

Modem connection

With a modem connection, this is the telephone number of the modem connected to the remote server. This number
must be entered in the modem configuration as described in the section "Set up modem at device" .

TCP/IP connection

Dtect X1s:  With  remote operation via  TCP/IP,  the COM Server  carries  out  the task of  assigning an address  to  the
remote server. For this, the COM Server must be configured as a "Socket Client". Further details are provided in the
operating instructions for the COM Server. The necessary parameters for configuring the socket client include the IP
address of the computer running the Remote Server. Then the port number on which the Remote Server accepts the
connection. This port number must also be specified when configuring the remote server. The standard port number
is 9000.

ProCheck:  In  remote  operation  via  TCP/IP,  the  ProCheck  device  communicates  directly  with  one  or  more  remote
servers. Enter the address(es) in the ProCheck device communication settings (cf. "Communication settings ").

With the Dtect X1s device, please use Net Utility to configure the communication settings.

With the Dtect X1 device, you must activate the Telnet client in Windows 7 first. This requires
administrator  rights.  Proceed  as  follows:  Open “Control  Panel  >  Programs  >  Programs  and
Functions > Turn Windows features on or off”, activate "Telnet Client" and click OK. Only then
can  you  establish  the  connection  via  the  Telnet  protocol."Control  Panel  >  Programs  >
Programs and Features > Turn Windows features on or off" > Telnet Client

Continue with the device configuration .

5.7.2 Device configuration

This tab is only displayed in Dtect X1s device configurations.

Remote operation settings in device configuration

Click the General settings tab in the corresponding Dtect X1s device configuration.
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Alarm conditions

Reset  main  alarm  manually:  Enable  this  checkbox  to  save  main  alarms  until  they  are  manually  reset  in  the
Configuration Manager.

Reset  pre-alarm  manually:  Enable  this  checkbox  to  save  pre-alarms  until  they  are  manually  reset  in  the
Configuration Manager.

Do  not  reset  alarm  if  validation  fails:  Tick  this  checkbox  to  save  alarms  until  validation  has  been  performed
successfully.

Remote settings

Remote communication device: Select the preferred connection type.

The settings for the Dtect X1s communication device must correspond to the settings specified
in the "Device settings" tab when configuring the communication.

Remote timer expires every ...  h  ...  min:  Enter  the time that  must  elapse before the timer expired global  event  is
triggered. Possible settings range between 3 minutes and 96 hours. The start  of  this time interval  can either be the
time the Dtect X1s device is switched on or the last "Timer expiry" event.

Send 'Still Alive’ message when the remote timer has elapsed: A "Still alive" message is sent when this option is
activated. This can be used to monitor and therefore ensure problem-free remote operation, also if no data or alarms
are sent. If the "timer expiry" event is not evaluated in any monitoring configuration (i.e. if the “Device calls at elapsed
remote timer" option is deactivated in the monitoring configuration), the Dtect X1s only sends a signal to the Remote
Server if the "Still alive" option has been activated.

Maximum connection attempts: This option limits the number of connection attempts. If a new event occurs in the
Dtect X1s device, the Dtect X1s device attempts to establish a connection with the Remote Server following the expiry
of  one monitoring cycle.  If  the connection is  established,  the data and  messages  of  all  events  that  occurred  at  the
Remote Server to date are transmitted and marked internally in the device as "reported". Events already reported are
not reported the next time a connection with the Remote Server is established. If a connection cannot be established
with the remote server (telephone line engaged, for example), the Dtect X1s device attempts to establish a connection
again once the time set at "Minimum delays between connections" has expired. This option can also be used to limit
the number of repeat connection attempts. If a connection cannot be established within this number of attempts a new
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connection build-up procedure is only started when a new event occurs.

Maximum connections per day:  Enter  the maximum number of  times the Dtect  X1s  device  may connect  with  the
Remote Server on any given day. If you select "0" an infinite number of connections are permitted.

This  option  is  only  available  if  a  firmware  version  3.6.0.  or  later  is  installed  on  the  Dtect  X1s
device.

Minimum Delay between connections: This is the minimum time the Dtect X1s device will wait before attempting to
connect  again  once  a  monitoring  cycle  has  been  completed  following  a  failed  connection  between  the  Dtect  X1s
device and the Remote Server.

Continue with the monitoring configuration .

5.7.3 Monitoring configuration

This tab is only displayed in Dtect X1s monitoring configurations.

In the configuration manager you can specify, separately for each monitoring configuration, the corresponding data and
messages for events to be transferred to the Remote Server in the "Remote" tab in the monitoring configuration.

Click the corresponding monitoring configuration in the Remote tab.

Device calls at

This setting can be used to specify which events trigger a remote connection. Select the options you require.

Main alarm: The monitoring configuration triggers a remote connection if a main alarm occurs.

Pre-alarm: The monitoring configuration triggers a remote connection if a pre-alarm occurs.

Ring buffer overflow: The monitoring configuration triggers a remote connection if the characteristic value memory is
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full.

Remote timer elapsed: This monitoring configuration triggers a remote connection if the remote timer has expired.

The "Remote timer expiry" event applies globally. This means that one timer is managed in the
Dtect  X1s  device.  This  timer  triggers  the  "Remote  timer  expired"  event  once  a  preset  interval
has elapsed. This can then be evaluated by the individual monitoring configurations.

The  alarm  and  characteristic  value  memory  overflow  events  are  known  as  local  events.  The
response  to  these  local  events  may  be  configured  separately  in  the  respective  monitoring
configurations.

The evaluation of events and connection with the Remote Server always takes place at the end of a monitoring cycle to
keep the number of required connections to a minimum. This means that messages for several events can be grouped
together.

Device sends on call:

Here you can define which data is sent to the Remote Server if one of the events described above has occurred.

Once you have made the settings for remote operation at the Dtect X1s device you must send the new configuration to
the Dtect X1s device. The Dtect X1s device restarts once the connection is ended. The remote operation in the Dtect
X1s device is now active.

5.8 Device configuration
The device configuration contains all  shared monitoring configurations and information to be processed by the device.
This information must initially be defined.

Create device configuration

Click the name of the device for which a configuration is to be created in the left-hand window of the Configuration
Manager.

Right-click the name of the device again and select Create new device configuration from the context menu.

The new configuration is inserted under the name of the device.

Click Save in the Edit menu to save the current status.

Or:

Click on  in the toolbar.

As long as a device configuration does not contain a monitoring configuration, it is invalid and
highlighted yellow in the tree view (see Invalid configurations ).

You can  create  a  suitable  device  configuration  for  each  device  that  accommodates  several
monitoring tasks.

Edit name of device configuration

Change the name of the device configuration as follows:

125
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Click the device configuration in the tree view.

Enter the new name in the Name field in the right-hand window.

Click Save in the Edit menu to save the current status.

Or:

Click on  in the toolbar.

Delete device configuration

When  you  delete  a  device  configuration,  it  is  deleted  along  with  all  monitoring  configurations
and  the  associated  data  from the  CM database.  It  is  not  possible  to  restore  a  deleted  device
configuration.

Delete a device configuration as follows:

Right-click the device configuration in the list of Devices and configurations and select Delete or click Delete in the
Edit menu.

Click Cancel in the confirmation dialog if you do not want to delete the device configuration or OK to confirm deletion.

If  the  configuration  to  be  deleted  contains  a  large  number  of  records  (several  thousand),  the
deletion  process  may  take  several  minutes.  During  this  process,  you  cannot  use  the
Configuration Manager for any other purpose. If you try to quit  the Configuration Manager, the
title bar of the program window displays "Not responding" status.

5.8.1 Overview

This tab contains a list of monitoring configurations under the relevant device configuration.

Click the Overview tab in the device configuration.

ProCheck

The overview of monitoring configurations created for the selected ProCheck device displays:

Number: Serial number of the monitoring configuration

Monitoring configuration: Name of monitoring configuration

Active: Green check if the monitoring configuration is active, otherwise empty

If you have assigned bearings to one or more monitoring configurations, they are displayed by monitoring configuration
in the list of bearings.
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The overview lists the following for each monitoring configuration:

Name of monitoring configuration

number of input channel

input type

sensor type used to record the signals, and

type of characteristic value used for the monitoring.

If you have assigned bearings to one or more monitoring configurations, they are displayed by monitoring configuration
in the list of bearings.
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5.8.2 General settings

This tab is only displayed in Dtect X1s device configurations.

This tab can be used to make settings that influence the behaviour of the system in the event of an alarm, to configure
the remote functionality and to define the starting characteristics of the Dtect X1s device.
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Alarm conditions

The alarm delay is defined in the "Alarm conditions" group field by specifying how often a threshold may be exceeded
before the alarm signal is output.

It is also possible here to define how the alarm should be reset: either manually (i.e. using the Configuration Manager
 or buttons on the control panel of the Dtect X1s device) or automatically (if the cause of the alarm signal no longer

exists).

Pre-alarms are reset automatically by default whereas main alarms must be cancelled manually.

You  can  use  the  "Do  not  reset  alarm  if  validation  fails"  checkbox  to  define  how  the  device  should  respond  if  a
validation condition is not met (also refer to "Validation" ).

If the checkbox is activated and a validation cannot be found any alarms that exist are not reset. The previous status
of  alarm  LEDs,  relays  and  power  outputs  before  omission  of  the  validation  also  remains  the  same.  The  previous
status of the alarm delay counter is also retained.

If  the  checkbox  is  deactivated  AND  the  "Delete  main  alarm/pre-alarm  manually"  option  is  also  deactivated  an
existing alarm is reset if the validation is missing. The alarm LEDs go out, the relays revert to the idle state and the
power  outputs  produce  a  quiescent  current  level  of  0  or  4  mA,  depending  on  the  configuration.  The  alarm  delay
counter is reset to zero.

Remote settings

You can activate the remote functionality here which enables an Dtect X1s device to send a signal to the Remote Server
 if certain events occur. Input in this dialog box is only possible if the remote function was activated beforehand. For

more information refer to "The Remote Server ".

Boot delay

You can use this field to specify how much longer the Dtect  X1s device should wait  in  addition to  the normal  starting
time when it is restarted. This means that, where the Dtect X1s device and peripherals are activated centrally, the Dtect
X1s  device  can  be  prevented  from  entering  measuring  mode  before  all  peripherals  (such  as  modem)  are  ready  for
operation.
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5.8.3 D/A channels

This tab is only displayed in Dtect X1s device configurations.

If the Dtect X1s device is equipped with D/A outputs the signals to be applied at the outputs can be specified here.

The following may be output:

a current proportional to the characteristic value of a frequency band for a selected monitoring operation

or

a predefined pre- or main alarm current level in the event of an alarm.

 The standard amperages are within a range of 4-20 mA. Alternatively, you can select the 0-20 mA range.

Current signal proportional to a characteristic value

The analog  signal  is  proportional  to  the  characteristic  value  of  a  monitoring  configuration.  For  the  purposes  of  signal
output the characteristic value is linked to the main alarm threshold or a fixed related value.

You can obtain this signal at the desired channel as follows:

First, select the "Related characteristic value" option in the "Channel" group field.

Enter the number of the monitoring configuration in "Source configuration" and

Select the desired characteristic value at "Characteristic value".

If you do not wish the output current to be dependent on the main alarm threshold activate the "Lock to special value"
option. This may be desirable if the main alarm threshold changes in relation to a reference variable through speed-
dependent alarm limits.

Current signal in the event an alarm is triggered

The signal can be referenced to:

the alarm status of a frequency band for a monitoring configuration

or
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the alarm status of all monitoring configurations

In the alarm-free state a current  of  4mA is  applied at  the output.  In  the event  of  a  pre-  or  main
alarm this value changes to a value specified by the user.  A maximum of  19 mA for  pre-alarms
and 20 mA for main alarms is possible.

Proceed as follows to obtain the analog signal at a D/A channel:

First, select the "Pre-alarm and main alarm limit" option in the "Channel" group field.

Specify the monitoring configuration under "Source configuration" or, if you wish to record all configurations, select the
entry "Connect all configurations".

Finally, select the frequency band.

Invert relay

You can invert  the function of  the switching relay by activating the checkbox at  the bottom of  the tab.  If  this  option is
activated the rest position of the relay is the alarm position. As this corresponds to the status of a deactivated Dtect X1s
device this also allows the operating status of the Dtect X1s device to be monitored. 

5.8.4 Sensors

To configure the properties of the sensors, click the Sensors tab in the device configuration.

If you make any changes to the device configuration that affect the monitoring configuration(s),
a message is displayed. Click "Yes" to edit the configuration. Click "No" to reset the changes to
the device configuration.

ProCheck

The left part of the dialog displays a list of sensors, while the right side displays the properties of the sensor selected in
the list and the sensor function test setting (sensor OK setting) under Sensor details:



81

Configuration Manager

If  the  ProCheck  device  has  a  multiplexer,  you  must  assign  the  existing  ProCheck  signal
channels  to  different  Multiplexer  banks.  Otherwise,  the  ProCheck  device  cannot  perform  the
measurement.

Examples: 

Sensor 1 on channel 1, sensor 6 also on channel 1  Measurement not possible!

Sensor 1 on channel 1, sensor 9 on channel 2  Measurement possible.

Currently, the Configuration Manager cannot prevent a misallocation of channels when using a
multiplexer.

Sensor name: Enter a text.

Channel: Sensor input channel number on the ProCheck device (cf.  Slot overview).

Input type: ICP (integrated circuit piezoelectric) is currently the fixed default.

Sensor type: Select the signal for the sensor to measure here (acceleration, acceleration, speed, pressure, particle,
etc.).

Sensor unit: Automatically selected depending on the type of sensor, e.g. "g" for acceleration sensors. If you select
the sensor type "Engineering Sensor", you can enter a freely definable unit here. In this case the signal must be in the
range +/-10 V.

Sensitivity: Unit is automatically selected depending on the type of sensor, e.g. "g" for acceleration sensors.

Offset: Must be indicated if the sensor delivers a steady component. The unit is automatically selected depending on
the type of sensor.

Min. / Max. bias voltage: The values 5 V / 15 V are pre-defined. 

Only if a multiplexer is installed can you check bias voltage and configure default values.

These settings should only be changed after consulting our support service (cf. "Contact" ).

Min./Max. signal level: If the sensor signal is below the limits specified here (input in %), the sensor is reported as
defective.

Channel and sensor type cannot be changed if the sensor is already being used in a monitoring
configuration.

Adding a sensor

Click on .

Enter the properties of the sensor in Sensor properties and Sensor OK detection.

Click .

Editing a sensor

Select the sensor from the sensor list.

Click .

Enter the properties of the sensor in Sensor properties and Sensor OK detection.

Click .

Deleting a sensor

Select the sensor from the sensor list.

Click on .

Sensor overview

Click  to display a list and detailed information of all sensors. The sensor overview is displayed.

250
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If  the  Dtect  X1s  device  is  equipped  with  selectable  input  types  these  can  be  selected  individually  for  the  various
channels  from  the  list  of  input  types.  The  sensor  type  can  be  selected  from  a  list  for  each  input  channel  and  the
sensitivity of each sensor must be entered.

It is also possible to specify which sensor signal should be assigned to the BNC port of the Dtect X1s device.

If a multiplexer is connected to the Dtect X1s device each input channel has a separate sensor
output  that  can  be  picked  up  via  a  BNC  port  at  the  multiplexer.  In  this  case  no  function  is
assigned to the BNC port of the Dtect X1s device.

5.8.5 Additional channels

The  additional  channels  of  the  device  are  configured  in  this  tab.  These  are  subsequently  available  in  the  validation,
alarm and frequency tracking monitoring configurations.

Click the Additional channels tab in the device configuration.
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If you make any changes to the device configuration that affect the monitoring configuration(s),
a message is displayed. Click “Yes” to edit  the monitoring configuration(s).  Click  "No"  to  reset
the changes to the device configuration.

ProCheck

The  left  part  of  the  dialog  displays  a  list  of  additional  channels,  while  the  right  side  displays  the  properties  of  the
additional channel selected in the list under Additional channel details:

Channel name: Enter a text.

Channel: Displays the number of the additional channel on the ProCheck device (cf. "Device properties"   Slot
overview). Virtual channels are additionally labelled "Virtual Channel".

Input type: DC (direct current) is currently the fixed default.

Sensor type: Select what signal the sensor measures (acceleration, velocity, pressure, etc.).

Sensor unit: Automatically selected depending on the type of sensor, e.g. "g" for acceleration sensors. If you select
the sensor type "Engineering Sensor", you can enter a freely definable unit here. In this case the signal must be in the
range +/-10 V.

Factor:  Enter  the  conversion  factor  between  the  measured  variable  and  sensor  voltage/current.  The  unit  is
automatically selected depending on the type of sensor, e.g. "rpm/V" for rotational speed sensors No unit is displayed
for virtual channels.

Frequency relation: This value is required to configure frequency tracking. The value defines the extent to which the
reference  variable  (in  other  words,  the  signal  measured  at  the  additional  channel)  influences  the  position  of  the
frequency bands in the frequency spectrum. The unit used to express the frequency relation is [Hz] / [unit]. Example: If
you measure the rotational speed [rpm] at the auxiliary channel, the frequency relation is 1 Hz/60 rpm which means
that 1 Hz in the frequency spectrum corresponds to 60 rpm. The unit is automatically selected depending on the type
of sensor. No unit is displayed for virtual channels.

Offset:  Must  be indicated if  the additional  channel  delivers  a  steady component.  The  unit  is  automatically  selected
depending on the type of sensor. No unit is displayed for virtual channels.

Sample calculation for a rotational speed signal (1-1000 rpm) available as an analog signal (4-20 mA or 2-
10 V).
Select rotational sensor as sensor type and enter the factor: 1000 rpm must be divided over a bandwidth of 10 V
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- 2 V = 8 V or 20 mA - 4 mA = 16 mA, therefore: factor = 1000 rpm / 8 V = 125 rpm/V.
Enter the offset dependent on the factor. In this example, the signal is offset by 2 V, i.e. by a rotational speed of 2
V * 125 rpm/V = 250 rpm. Therefore: Offset = -250 rpm.

Digital input: Must be enabled if the additional channel is a digital input. Not available for virtual channels.

You  can  only  enable  this  field  if  a  rotational  speed  sensor  (rpm)  or  a  rotational  frequency
sensor (Hz) was selected.

Observe the information regarding configuring digital  input  signals  in  the ProCheck manual.
Digital  input  signals  are  fed  into  the  ProCheck  device  via  a  voltage  divider  that  limits  input
voltage to max. 6 V.

Trigger on rising edge: Must be enabled if you want the channel to switch to "1" if the signal exceeds the input level
defined in Value. If this checkbox is not checked, the channel switches to "1" if the signal displays a falling edge, i.e. if
it drops below the input level defined in Value.

Level: Input level that, if exceeded (rising edge) or not reached (falling edge), causes the digital input to switch to "1".

Hysteresis:  Range in  which  the  input  level  may drop  below or  exceed  the  level  defined  in  Value  without  the  input
changing state.

Pulse factor: Enter the number if pulses that the sensor delivery per rotation.

Example of trigger on rising edge:
In  the  following  example  these  settings  were  chosen:  Trigger  for  rising  edge  =  enabled,  Value  =  3  V,  and
Hysteresis = 1 V. The auxiliary channel switches to "1" if the input level displays a rising edge and exceeds 3 V.
Only when the input level drops below 2V (Value - Hysteresis) again does the additional channel switch back to
"0".

Example of trigger on falling edge:
In  the  following  example  these  settings  were  chosen:  Trigger  for  rising  edge  =  disabled,  Value  =  3  V,  and
Hysteresis = 1 V. The auxiliary channel switches to "1" if the input level displays a falling edge and drops below
3 V. Only when the input level rises above 4V (Value + Hysteresis) again does the additional channel switch back
to "0".

Add additional channel

Click on .

Enter the properties of the additional channel in Additional channel details.

Click .

Edit additional channel

Select the additional channel from the list of additional channels.

Click .

Enter the properties of the additional channel in Additional channel details.

Click .

Delete additional channel

Select the additional channel from the list of additional channels.

Click on .
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Additional channel overview

Click  to display a list and detailed information of all additional channels. This displays a list of additional channels.

Dtect X1s

Signal type

You can initially select one of several input types from this list box (rotary speed input, rotational frequency input, load
input and free input) depending on the signal  type you wish to use with the additional  channels.  If  the required signal
type is not available you can specify the sensor unit itself at "Free input".

Name

You can assign a name to an additional channel in the Name field. This name is used in the monitoring configurations
for  subsequent  configuration.  If  the name "engine speed"  is  entered here for  example,  you will  be able to  access  the
corresponding additional channel in the monitoring configurations using this name.

Unit

If you selected the "Free input" signal type you can enter a unit here that corresponds to the input signal measured. The
input is limited to a maximum of 6 characters. If you selected a predefined signal type this field is filled out automatically
and cannot be changed.

Sensitivity

You can enter the sensitivity of the sensor used in this field. The sensitivity is expressed as [unit] / [volt].
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Frequency relation

This value is required to configure frequency tracking. This value defines the extent to which the reference variable (in
other words, the signal measured at the additional channel) influences the position of the frequency bands scaled in [Hz]
in the frequency spectrum. The unit used to express the frequency relation is [Hz] / [unit].

Example:  If  you  measure  the  rotational  speed  [rpm]  at  the  additional  channel,  the  frequency  relation  is
1 Hz/60 rpm which means that 1 Hz in the frequency spectrum corresponds to 60 rpm.

If  you  plan  to  carry  out  speed-dependent  tracking  of  frequency  bands  or  alarm  limits  for
monitoring configurations to be defined at a later date, you must specify the additional channel
that is connected to the speed sensor here.

5.8.6 Digital outputs

This tab is only displayed in ProCheck device configurations.

If the selected ProCheck device has digital outputs, you can set their properties in this tab.

The  left  part  of  the  dialog  displays  a  list  of  digital  outputs,  while  the  right  side  displays  the  properties  of  the  output
selected in the list under Digital output details:

Output name: Enter a text.

Channel:  Channel  number  of  the  digital  output  on  the  ProCheck  device  (cf.  "Device  properties"   List  of
connectors).

Inverted: Must be enabled if you want to invert the output signal.

Add digital output

Click on .
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Enter the properties of the output.

Click .

Edit digital output

Select the digital output from the List of digital outputs.

Click .

Enter the properties of the output.

Click .

Delete digital output

Select the digital output from the List of digital outputs.

Click on .

Overview of digital outputs

Click  to display a list and detailed information of all digital outputs. This displays a list of digital outputs.

If you make any changes to the device configuration that affect the monitoring configuration(s),
a message is displayed. Click "Yes" to edit the configuration. Click "No" to reset the changes to
the device configuration.

5.8.7 Analog outputs

This tab is only displayed in ProCheck device configurations.

If the selected ProCheck device has analog outputs, you can set their properties in this tab.
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The  left  part  of  the  dialog  displays  a  list  of  analog  outputs,  while  the  right  side  displays  the  properties  of  the  output
selected in the list under Analog output details:

Output name: Enter a text.

Channel:  Channel  number  of  the  analog  output  on  the  ProCheck  device  (cf.  "Device  properties"   List  of
connectors).

Current range: Select the range in which the current must be here. It is automatically selected if you choose Related
value as the type of analog output.

Type: Select the type of analog output

Alarm output: In the event of a pre-alarm/main alarm, the current defined below is applied to the output.

Related value: The output signal is proportional to the characteristic value of a monitoring configuration. For signal
output,  the  characteristic  value  is  related  to  a  fixed  related  value  (cf.  monitoring  configuration   Characteristic
values ).

Main  alarm  related  value:  The  output  signal  is  proportional  to  the  characteristic  value  of  a  monitoring
configuration. For signal output, the characteristic value is linked to the main alarm threshold.

Pre-alarm current: Enter the value in mA that the ProCheck device applies to the output to signal a pre-alarm. You
can only input a value if you have selected the Alarm output setting in Type.

Main alarm current:  Enter the value in mA that  the ProCheck device applies  to  the output  to  signal  a  main alarm.
You can only input a value if you have selected the Alarm output setting in Type.

Add analog output

Click on .

Enter the properties of the output.

Click .

Edit analog output

Select the analog output from the analog output list.

Click .

Enter the properties of the output.

Click .
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Delete analog output

Select the analog output from the analog output list.

Click on .

Analog output overview

Click  to display a list and detailed information of all analog outputs. This displays the analog output overview.

If you make any changes to the device configuration that affect the monitoring configuration(s),
a message is displayed. Click "Yes" to edit the configuration. Click "No" to reset the changes to
the device configuration.

5.8.8 Image

You can store a suitable image for the configuration (for example) here. You can use either JPEG or BMP files.

To do this click on  and select the file that contains the preferred image using the selection dialog box.

Follow the same procedure as above if you wish to change the image.

Click on  to delete the image and click on  to print it.

5.8.9 Additional information

Additional information can be entered in this field as required.

The data  entered  here  is  stored  in  the  CM database  currently  being  used,  and  not  in  the
device.  If  a  configuration  is  read  out  from  a  different  database,  the  above  information  will  no
longer be available.

5.8.10 Import device configuration from device

You can read out a device configuration e.g. in order to

add a new device to the CM database with the existing configuration or

update the configuration in the Configuration Manager after changing the device configuration.

New registration of a device configuration in the configuration manager

Proceed as follows if you wish to register a new device configuration for a device in the configuration manager:

First, establish a data connection  between the configuration manager and device.

Open the context menu under the name of the device in the configuration manager then go to the corresponding sub-
menu under the device menu item.

Select Read device configuration and create from this sub-menu.

The configuration is then read out from the device and entered as a device configuration in the configuration manager.

To resume measuring mode you should now end the data connection.

Update configuration of a device in the configuration manager

It is important to carry this out if you have made changes to a device configuration at the device itself and wish to adapt
this configuration in the configuration manager.
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First, establish a data connection  between the configuration manager and the Dtect X1s device.

Open the context menu on the name of  the device configuration you wish to  update,  click  Device,  then click  Send
device configuration to device.

The configuration is now updated.

To resume measuring mode you should now end the data connection.

5.8.11 Send device configuration to device

If  you wish to  reconfigure a device,  a  new device  configuration  must  initially  be  created  in  the  configuration  manager
(see "Create device configuration " and "Create monitoring configuration ") and sent to the device.

First, establish a data connection between the configuration manager and device (see "Connection with a device" ).

Then  open  the  context  menu  by  right-clicking  the  mouse  on  the  device  configuration  that  you  wish  to  send  in  the
configuration manager and click Device.

Select the Send device configuration to device menu item and wait until the transfer is complete.

End the connection if you do not wish to carry out any further operations.

From  here,  first-time  users  can  change  to  "Reset  and  update  alarm  status ",  where  an
explanation is provided on how the configuration manager can be used to reset an alarm.

5.8.12 Search for device configuration

Once the configuration manager has established a connection with a device you can search for a device configuration in
the database that matches the connected device.

To do this, right-click the device and select Device > Search for current device configuration in database from the
context menu.

5.9 Monitoring configuration
Depending on the features of the ProCheck or Dtect X1s device in use, every device configuration can process different
monitoring modes for different input signals or types of characteristic values. The information required for this, such as
the maximum frequency of the low-pass filter, characteristic value type, location and width of frequency bands and alarm
limits comprises the monitoring configuration. These are carried out one after the other in monitoring mode.

In order to be executed, a monitoring configuration must be activated.

Set monitoring configuration

In the tree view, click the device configuration for which a new monitoring configuration should be defined.

Right-click again on the device configuration and select Add sub-item from the context menu.

The new configuration is inserted under the name of the device configuration.

Click Save in the Edit menu to save the current status.

Or:

Click on  in the toolbar.
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Activate monitoring configuration

Check the Active configuration checkbox..

Edit name of monitoring configuration

Change the name of the monitoring configuration as follows:

Click the monitoring configuration in the tree view.

Enter the new name in the Name field in the right-hand window.

Please  note  that  the  characters  <,  >,  &,  '  and  "  cannot  be  used  in  monitoring  configuration
names.

Click Save in the Edit menu to save the current status.

Or:

Click on  in the toolbar.

Delete monitoring configuration

If  you  delete  a  monitoring  configuration  that  contains  no  measuring  data,  this  monitoring
configuration is deleted from the CM database and cannot be restored.

If  you delete a monitoring configuration that  contains  measuring data,  a  copy of  the higher-
level device configuration is created first.  The monitoring configuration to be deleted is then
deleted  from this  copy  and  then  the  device  configuration  is  activated.  This  modified  device
configuration should be sent to the device (cf. "Send device configuration to device" ). The
original  device configuration,  including the deleted monitoring  configuration,  is  disabled  and
hidden. You can display the "old" data at any time (cf. "Outdated configurations" ).

Right-click the monitoring configuration in the list of Devices and configurations and select Delete or click Delete in
the Edit menu.

Click  Cancel  in  the  confirmation  dialog  if  you  do  not  want  to  delete  the  monitoring  configuration,  or  OK  to  confirm
deletion.

If  the  configuration  to  be  deleted  contains  a  large  number  of  records  (several  thousand),  the
deletion  process  may  take  several  minutes.  During  this  process,  you  cannot  use  the
Configuration Manager for any other purpose. If you try to quit  the Configuration Manager, the
title bar of the program window displays "Not responding" status.

5.9.1 Data

This tab displays an overview of the measuring data available for the monitoring configuration.

Select the measuring data as follows:

Expand the relevant device in the tree view until you reach the measuring data level.

Click the monitoring configuration and then on the Data tab to display all measurements.

Or:

Click the appropriate measuring data in the tree view (FFTs, time signal, characteristic values) and then on the Data
tab to display the measured data of the selected type.
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The following information is displayed:

Measuring time

Alarm status:

o  - Green if there is no alarm in the monitoring configuration.

o  - Yellow if there is a pre-alarm in the monitoring configuration.

o  - Red if there is a main alarm in the monitoring configuration.

The alarm was acknowledged: If you manually reset an alarm (cf. Reset alarm status ), the measuring data entry is
marked with a check.

Low level (ProCheck only): The level of the measured and filtered signal is too low and therefore so is the signal-to-
noise ratio. The cause may be, for example, a defective sensor or faulty filter configuration. The display refers to the
signal level at the time of measuring. The current signal level may thus deviate.

Channel:: Sensor channel used for measurement.

Signal type (ProCheck only): Indicates whether the raw signal or the demodulation signal is measured on the sensor
channel.

FFT, time signal, characteristic values: A check indicates the data contained in the measuring data entry.

Attribute: Textbox in which you can enter up to 100 characters.

Comment: Textbox in which you can enter any text.

Rotational speed: Double-click on a rotational speed to edit it.

Additional channels: One column containing the associated measured value is displayed for each additional channel
defined in the monitoring configuration.

Limit records displayed

With the aid of the "Dataset load limit"  you can limit  the number of datasets displayed. The limit  begins with the most
recent dataset.

Configure how many datasets to display and

click on .

If you set the dataset load limit to "0", all datasets in the database are displayed.
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Sort columns in ascending/descending order

You can sort a column in ascending order (A-Z, 0-9, pre-alarm-alarm, etc.) or in descending order (Z-A, 9-0, alarm-pre-
alarm,  etc.)  by  double-clicking  on  the  column  header.  You  can  reset  this  setting  by  selecting  "Default  sorting"  in  the
context menu.

5.9.1.1 Working with measured data

Filter measuring data

You can filter the entries displayed in the measuring data view according to the following criteria:

alarm status,

time range,

measured values of additional channels.

Define filter settings

Click the black arrow in the filter settings section.

Configure filter settings and

click on .

Click on the black arrow again to minimise the filter pane.

If  you change the filter  settings you will  need to  refresh the view.  Click   on the toolbar  or
press CTRL+R.

When the filter  settings are enabled,  the table  of  measuring data is  displayed with  a  yellow
background.  In  addition,  "Filtered  view  -  Refer  to  filter  settings"  is  displayed  in  the  table
header  to  show  that  you  may  not  be  seeing  all  measuring  data,  depending  on  the  filter
settings.
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Select alarm status

Select the No alarm, Pre-alarm and Main alarm statuses to display corresponding entries.

Select time range

Select this option to view data from a specific period only. Enter the start and end time.

Filter by comments and attributes

Select this option to view data with certain comments and attributes only. You can refine the search results by selecting
“equals", "starts with" or "includes".

Select signal level state

You can show or hide below-threshold signals and signals with sufficient level here.

Select sensor channel

Select the sensors whose measured data you wish to display.

Select signal type

You can show or hide raw signal/demodulation measured data here.

Limit additional channel value range

Select this option to filter the displayed measurements depending on the values of the additional channels.

ProCheck:  You  can  select  an  independent  upper  and  lower  limit  for  each  of  the  additional  channels  defined  in  the
monitoring configuration.

Dtect X1s: You can select an independent upper and lower limit for the two available additional channels.

Reset filter settings

Right-click the selection and select Reset filter settings.

This resets filter settings and refreshes the measuring data view.
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Edit rotational speed

You can edit the rotational speed value of one or more datasets in measuring data view.

Double-click on a rotational speed field and enter a rotational speed.

Click on Save.

Or:

Select one or more datasets and

right-click on a rotational speed field and select Edit rotational speed.

Configure the rotational speed settings and click OK.

In Copy value from you can

· enter a constant rotational speed value.

· use the value of a validator or additional channel for the rotational speed.

· add a certain fixed value (offset) to the current rotational speed value.

· multiply the current rotational speed value by a certain factor.

Calculate FFTs from time signals

If there are measuring data with time signals but without FFTs, you can calculate FFTs at a later time.

Select several datasets and

right-click on the highlighted area.

Select Calculate FFTs from time signals from the context menu.

Measuring data preview

A preview is displayed at the bottom of the measuring data view. You can display the time signal, FFT and/or trend as a
preview for the selected dataset.

Select a dataset and

click the black arrow in the preview bar.

Use the “Up"  and “Down"  arrows on your computer keyboard to navigate quickly through
the items.

Click on the black arrow again to minimise the preview pane.
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The following information and functions are available here:

Time signal The following information is displayed next to the graphic:

Lower / upper value (Y-axis)

Signal length (bottom right)

FFT The following information is displayed next to the graphic:

Lower/upper value (Y-axis)

Low-pass (bottom right): A value of 1000 Hz, for example, indicates usable values up to 1000 Hz.

Trend The trend display provides a first indication of whether there is a trend at all. The following information
is displayed next to the graphic:

Lower/upper value (Y-axis)

Number of days until the current date (bottom right): The trend displayed is limited to this period. You
can  display  the  complete  trend  in  FAG  Viewer,  where  you  can  also  configure  how  many  days  to
display. This setting is found in Extras > Options > Trend diagram.

Trend context
menu

Right-click  on the trend  preview to  call  up  the  context  menu.  This  context  menu is  only  available  for
tracked rotational speed values, but not for fixed windows. The following display options are available
here:

Trend: The entire range is displayed with all rotational speeds.

Filtered trend:  The  area  displayed  is  limited  according  to  the  selected  dataset  and  depending  on
the rotational speed.

Trend  and  filtered  trend:  These  two  display  options  are  highlighted  in  colour.  You  can  then
compare the trend values at different rotational speeds.

Speed filter range: This option opens a window in which you can set the rotational speed range in
%.

View measuring data in Viewer

You can view one data set in the FAG Viewer as follows:

Double-click the entry in the measuring data view.

Or:

In the View menu, click Show data in Viewer  > Show data in Viewer.

Or:

Right-click the entry in the measuring data view. Select Show data in Viewer  from the context menu.

You can view several data sets in the FAG Viewer as follows:

Select the required measuring data. Use the Shift or CTRL key to select several datasets.

In the View menu, click Show data in Viewer.

Click Every signal in separate diagram to open each dataset in a separate window.
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Or:

Click Signals of same type in one diagram to display the selected records in a diagram with their own axes.

Or:

Right-click  the  entry  in  the  measuring  data  view.  Select  Show  data  in  Viewer  from  the  context  menu  with  the
appropriate display option.

Or:

Click on .

5.9.2 General details

This tab is only displayed in Dtect X1s monitoring configurations.

You can specify the following settings in this tab:

the variable type being monitored for the input channel to be used,

characteristic value type, as described in the section "Monitoring types in frequency range";

low-pass filter cutoff frequency,

amplification;

overload detection,

window evaluation of time signal for FFT calculation;
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DC component suppression and

maximum frequency of high pass filter where an demodulation signal is to be generated

Input channel

Select the channel containing the signals to be processed from the list box of the same name. The entries contain the
number of the channel and the sensor type.

Set particle counter

Click Set particle counter to automatically configure all default settings for the “Particle counter (Fe/nFe)" sensor type
(see "Set pre-defined characteristic values" ).

Characteristic value mode

You can enter one of the characteristic value types presented in the "Monitoring types in frequency range" section here.
All characteristic values with the exception of time range monitoring are calculated from the frequency spectrum of the
recorded time signal. With time range monitoring, characteristic values are monitored directly from the time range and
the frequency spectrum calculation is omitted.

Characteristic value type Meaning

ISO 10816 RMS of velocity between 10 Hz and 1 kHz

LDZ High-bandwidth LDZN value between 0 Hz and low pass cutoff frequency

RMS High-bandwidth RMS value between 0 Hz and low pass cutoff frequency

Selective LDZ LDZN value in fixed frequency bands

Selective RMS RMS in fixed frequency bands

Selective LDZ tracked LDZN value in frequency bands subject to speed-dependent tracking.

For this, an additional channel with speed signal must be defined (see "General settings ").

Selective RMS tracked RMS value in frequency bands subject to speed-dependent tracking.
For this, an additional channel with speed signal must be defined (see "General settings ").

Time domain monitoring Monitoring of the time signal using the characteristic values specified.
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LDZ value in g

If one of the LDZ characteristic values is selected it is possible to choose between the units g and dB. For g the "LDZ
values in [g]" option must be selected.

Observe  that  this  unit  will  also  be  used  for  the  tracking  of  alarm  thresholds.  If  a  value  in  dB
appears here, the value calculated from the supporting points  is  added to  the alarm limits  (as
this is a logarithmic value). In the case of g values these are multiplied by the alarm limits.

Monitored parameter

If the characteristic value selected is an RMS value and an acceleration sensor is selected, you can select in the group
field whether you wish to convert the acceleration signal by integrating it into a speed signal or a distance signal. You
can make your selection in the group field. This option is only available for RMS values calculated from the frequency
spectrum and not for the characteristic values of time domain monitoring.

LDZN values can only be monitored using an acceleration signal and monitoring in accordance with ISO 10816 is only

possible using a speed signal. The standard unit for LDZ characteristic values is dB. However, if you wish to display LDZ
values  with  the  unit  g  select  the  "LDZ  values  in  [g]"  option.  Observe  that  this  unit  will  also  be  used  for  the  speed-
dependent alarm limits. If a value in dB appears here, the value calculated from the supporting points is added to the
alarm thresholds (as this is a logarithmic value). In the case of g values these are multiplied by the alarm limits.

Low-pass

The low-pass filters  out  the useful  frequency range from the  time signal  which  is  either  a  raw signal  or  demodulation
signal. The cutoff frequency must therefore be adapted to the frequency ranges which are to be monitored.

You can make this adjustment in the "LP cutoff frequency" list box. The available values depend on the low-pass module
you have selected for your Dtect X1s device.

Click on  to display more detailed information on the selected cutoff frequency:

With the ISO 10816 characteristic value type, the low pass cutoff frequency is automatically set to 1000 Hz. In the case
of "tracked" characteristic values, the system automatically sets the low pass cutoff frequency to the optimum frequency
range obtained from the configuration of the monitored frequency bands.

Sample rate and number of measured values

The sample rate is always set at three times the cutoff frequency of the low pass. 4096 measured values are recorded
during each measurement. The duration of a measurement can be obtained by dividing the number of measured values
by the sample rate.

Please observe that the low pass cutoff frequency and the sample rate are set automatically for
tracking of RMS or LDZ values.

Amplifier setting

The input signal is amplified in an initial stage directly behind the input. A second amplifier stage is located behind the
low pass.

The amplification is set automatically if the entry "Automatic" is selected in the "Stage 1" list box. Suitable amplification
factors are determined via a preliminary measurement and subsequently used for the actual measurement.

The amplification factors at both stages can also be manually applied. The following options are available:
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Amplifier stage Amplification factor

1. Level 1, 2, 4, 8, 32, 64, 128

2. Level 1, 2, 4, 8

If  the  amplifier  is  adjusted  manually  the  amplitudes  of  the  input  signal  should  be  precisely
known to prevent overloading.

Overload detection

This checkbox can be used to switch the automatic overload detection on or off. If the input signal contains individual a
high amplitude pulses the signal chain may become overloaded. The Dtect X1s device interrupts the measurement of
the monitoring configuration and begins the next one. If a configuration is always to be measured the overload detection
can be deactivated.

Windowing of time signal

Here you can specify whether  or  not  you  wish  the  time signal  for  monitoring  operations  in  the  frequency range  to  be
evaluated using a Hanning windowing operation.

High-pass cutoff frequency

If a LDZ value is selected for monitoring purposes, the demodulation signal  is  formed from a raw signal using a high-
pass (amongst others). The maximum frequency of the high-pass can be specified in the "High-pass cutoff frequency"
group field. The possible values are 2 kHz and 750 Hz.

DC component suppression

Mark this item if you wish to suppress the DC component of the recorded time signal. This occurs automatically when
generating an demodulation.

Signal configuration

Where a LDZN value is used for monitoring, the "demodulation signal" or otherwise "Raw signal" option is checked here.

5.9.3 Main channels

This tab is only displayed in ProCheck monitoring configurations.
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General settings

Window selection: Select whether to monitor with fixed or speed-tracked frequency bands or whether to perform an
order analysis .  If  you want to track frequency bands, you must measure the speed on an additional  channel.  In
this case, select the additional channel with the speed signal in Additional channel for window selection.

You can only select the order analysis if

the ProCheck device is running with a firmware version 2.0.0.0 or newer,

no more than one sensor/filter combination is defined (raw signal or demodulation),

no characteristic values of the "time range" type exist and

the rotational speed to measure is in the range from 0.6 Hz to 4500 Hz.

If  you  select  order  analysis  although  more  than  one  sensor/filter  combination  is  defined,  a
warning is displayed and the previous window selection setting is restored.

If any "time range" characteristic values are defined in the monitoring configuration, a warning is
displayed  and  the  Configuration  Manager  asks  you  whether  to  delete  these  characteristic
values.  Click  OK  to  delete  the  "time  range"  characteristic  values  and  activate  order  analysis.
Click Cancel to keep the "time range" characteristic values and not activate order analysis.

Additional  channel  for  window  selection:  From  the  Additional  channels  defined  in  the  device  configuration,
select the channel which sends the speed signal for the speed-dependant tracking. Not available for order analysis.

Rotational speed channel for order analysis: From the Additional channels  defined in the device configuration,
select  the channel  which supplies  the speed signal  for  order  analysis.  Only  available  for  order  analysis.  Measuring
inaccuracies may result with analog or virtual additional channels.

Additional  channel  for  alarm calculation:  If  you  want  to  monitor  with  speed-tracked  alarm  thresholds,  select  the
channel to track the alarm threshold speed from the Additional channels , defined in the device configuration. Only
then can you enable the Tracked alarms option in the Characteristic values  tab.

Sensor and filter settings

In  this  section  you  can  assign  filter  settings  to  the  sensors  defined  in  the  device  configuration  (cf.  "Sensors ").
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Observe the following restrictions:

You can filter up to  four  signals  at  the same time.  That  means a maximum of  four  sensor/filter  combinations if  you
filter  the  raw  or  demodulation  signal  in  every  combination.  If  you  filter  the  raw  and  demodulation  signals  in  a
combination,  the  available  filter  capacity  is  reduced  to  two  signals,  which  you  can,  in  turn,  split  up  into  one  or  two
combinations.

You can only add sensors of the same type (acceleration, velocity, path, etc.) to the list of sensor/filter combinations.
For example, if you have defined six acceleration sensors and two velocity sensors in the device configuration, you
can select four of the six acceleration sensors or the two velocity sensors here.

You need at least one characteristic value for each sensor/filter setting. If you have not created a characteristic value,
the program automatically creates one.

The  left  section  displays  the  list  of  sensor/filter  combinations,  while  the  right  section  displays  the  settings  of  the
combinations selected in the list:

Selected sensor: Sensor for which filter settings are defined. If you create new settings, you can only select sensors
here for which no settings exist yet!

Raw  signal:  Enable  the  checkbox  Filter  raw  signal  to  define  the  filter  for  the  raw  signal.  Select  High  pass
frequency  and  Low  pass  frequency  and  the  number  of  measured  values.  If  you  selected  order  analysis  in
window  selection,  the  frequencies  are  automatically  selected.  Also,  the  number  of  measured  values  is  limited  to
16384.

Demodulation  signal:  Enable  the  checkbox  Filter  demodulation  signal  to  define  the  filter  for  the  demodulation
signal.  Select  High  pass  frequency  and  Low  pass  frequency  and  the  number  of  measured  values.  If  you
selected  order  analysis  in  window  selection,  the  frequencies  are  automatically  selected.  Also,  the  number  of
measured values is limited to 16384.

If you have created more than two sensor/filter combinations and selected lowpass frequencies,
the sensor channels are not distinguished on the ProCheck device. Instead, a uniform lowpass
frequency  is  calculated  from  the  highest  band  frequency  of  all  characteristic  values  of  the
monitoring configuration,  that  is  used for  all  sensor  channels.  If  the sensor  channel  frequency
bands  differ  significantly  from each  other,  this  may  result  in  an  unfavourable  resolution  in  the
FFT of one or more sensor channels.

Add sensor/filter combination

Click on .

Adjust the settings.

Click .

Edit sensor / filter combination

Select the sensor / filter combination.

Click .

Adjust the settings.

Click .

Delete sensor / filter combination

Select the sensor/filter combination.

Click on .

Overview of sensor/filter combination

Click  to display a list and detailed information of all sensor/filter combinations.
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FFT settings

Specify the settings for calculating the FFT from the time signal in this section.

Windowing type: You can evaluate the time signal with Hanning, Hamming or Flat Top windowing.

Characteristic value calculation

Specify the settings for calculating the characteristic values from the time signal in this section.

Characteristic value unit: Depends on the type of sensor.

Number of integrations: Select how often to integrate the time signal (max. 2 times). This setting is not available for
the order analysis.

Remove DC level: Enable this checkbox to suppress any steady component in the measured value when calculating
the characteristic value.

You can also automatically apply pre-defined characteristic values (see “Predefined characteristic values " ):

ISO 10816 settings: Click the button to create a characteristic value to ISO 10816.

Set  particle  counter:  Click  this  button  to  automatically  configure  all  default  settings  for  the  sensor  type  “Particle
counter Fe/nFe".

You can only edit these settings if you have finished editing the sensor/filter combinations!

5.9.4 Additional channels

This tab is only displayed in ProCheck monitoring configurations.
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Additional channel options

Settings in this section globally affect all  additional  channels in a monitoring configuration with the exception of virtual
channels. The additional channel options do not affect virtual channels.

Sample  rate  of  the  analog  additional  channel:  Select  the  sample  rate  (max.  10000).  This  applies  to  all  additional
channels  defined in the device configuration.

Selected trigger channel: You can select a digital channel from the additional channels to trigger measurement here.
The other additional channels can be used as validators.

Rotational speed settings

If you are not using frequency tracking but rather "Fixed windows", you need the rotational speed information for the FFT
display in FAG Viewer. 

Specify whether to enter frequencies in Hz or rpm.

Enter the number of revolutions.

Validation settings

In  this  section  you  can  select  and  configure  validators  for  the  selected  monitoring  configuration.  Validators  are  those
additional channels  (defined in the device configuration) used to validate measurements. You can use validation to
ensure that only measurements obtained under predefined operating conditions are recognized and that alarm signals
are only output under these conditions.

The left section displays the list of validators, while the right section displays the settings of the validator selected in the
list:

Validation name: Name of the validator.

Selected  channel:  Additional  channel  to  be  used  as  a  validator.  You  can  select  from  the  additional  channels
defined in the device configuration.

Validation type: How should the validator work?

o Deactivated: No validation.

o Minimum / Maximum: Measurement only if the validator signal is within defined thresholds.

o Signal change: The validator signal may only change by the defined maximum value during measurement.
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o Min./Max. + signal change: Combination of Minimum/Maximum and Signal change.

Conversion factor: The conversion factor is used where rescaling of the reference variable is required. To achieve
this,  the  reference  variable  is  multiplied  by  the  conversion  factor  prior  to  evaluation  by  the  ProCheck  device.  This
conversion factor is required for gearboxes (for example) where the measured rotational  speed does not match the
speed of the component being monitored due to a gear ratio.

Maximum signal change: Input for Signal change or Min./Max. + signal change as Validation type.

o Relative signal change (%): If this option is enabled, signal change is calculated by adding the percentage to or
subtracting it from mean rotational speed. This function is only available as of ProCheck firmware version > 2.2.4.

Upper limit: Maximum if Minimum / Maximum is selected as the Validation type.

Lower limit: Minimum if Minimum / Maximum is selected as the Validation type.

o Mirror  limits:  This  option  is  only  available  if  Minimum/Maximum  is  selected  as  Validation  type.  Activate  this
option  to  mirror  the  upper  and  lower  limit,  i.e.  for  rotational  speeds  in  reverse  operation.  This  function  is  only
available as of ProCheck firmware version > 2.2.4.

Use as speed source: If activated, a validator can be used as a speed source.

If  you  make  any  changes  that  affect  supporting  points,  you  can  have  them  automatically
modified.  The  program  adjusts  the  reference  variables  and  deletes  values  outside  the  new
reference variables. This may reduce the number of supporting points.

Add validator

Click on .

Adjust the settings.

Click .

Edit validator

Select the validator.

Click .

Adjust the settings.

Click .

Delete validator

Select the validator.

Click on .

Overview of validators

Click to display a list and detailed information of all validators.
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5.9.5 Bearings

On  this  tab  you  can  assign  bearings  from  the  bearing  database  to  the  monitoring  configuration.  The  associated
kinematic  frequencies  can  be  displayed  in  the  evaluation  diagram  in  the  FAG  Viewer.  If  you  add  a  bearing  to  a
monitoring  configuration,  the  associated  kinematic  frequencies  are  copied  from  the  bearing  database  to  the
Configuration Manager. Changes made to the kinematic frequencies in the Configuration Manager are not saved back to
the bearing database!

Add bearing

You can assign a maximum of 40 bearings to a monitoring configuration!

Click on .

Select the bearing from the database as described in "Search for bearings" .

The bearing is added to the monitoring configuration.

The  fundamental  train  frequency  is  relative  to  the  respective  fixed  race,  that  you  can  toggle
between Fixed outer race and Fixed inner race using the Fixed race option.

Edit bearing data

Changes  to  bearings  in  the  monitoring  configuration  do  not  affect  the  bearing  database.  If  you  edit  a  bearing  or
subsequently add the original bearing from the bearing database, the latter is appended to the list  of  bearings without
overwriting  the  modified  bearing.  Therefore,  it  makes  sense  to  indicate  any changes  to  the  characteristic  values  of  a
bearing in the identifier so as to make it easier to distinguish the modified bearing from the original bearing.
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You can enter a maximum of 60 characters in the input boxes Bearing name and Description.

Click on .

Make the appropriate changes and 

click again on  to save the changes.

Create bearing-related characteristic values

You can automatically create bearing-specific characteristic values for each bearing.

On  the  Dtect  X1s  device  you  can  only  create  characteristic  values  if  you  are  using  the
characteristic  value  mode  “selective  RMS  /  LDZ"  or  "selective  RMS  /  LDZ  tracked"  (see
"Characteristic value mode" ). Otherwise the button is disabled.

Click on Create characteristic values.

Enter a characteristic value name.

Select the sensor and the signal type for which to create the characteristic value (ProCheck only).

In the next step, select which kinematic frequency to monitor:

Tick the Frequency checkbox and

configure how many harmonics to include in the monitoring.

Alternatively,  you  can  click  Default  setting  to  use  the  “Bearing-related  characteristic  values”  predefined  in  the
program settings .

If you have selected "Fixed windows" or “Selective RMS / LDZ",

configure the rotational speed settings.

Click OK.

The characteristic bearing values are generated automatically. 

If  you  exceed  the  maximum  permissible  number  of  characteristic  values,  the  software
displays a warning. You can then modify the number of characteristic values.

On the Dtect X1s device, you can create a maximum of 12 windows. If there are already any
windows  in  the  window  options,  you  can  overwrite  the  old  windows  or  append  the  new
windows. The maximum number of 12 windows must not be exceeded. 

Deleting a bearing from the monitoring configuration

Deleting a bearing from the monitoring configuration removes all bearing data.

Click on .

Displaying a list of bearings

Click on  to display a list of allocated bearings with the associated bearing data.

Replacing a bearing

If you replace a bearing on a monitored machine, the bearing data may also change. 

Click on .
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Select  Revision  only  if  you  are  replacing  the  existing  bearing  with  a  bearing  of  the  same  type  with  identical
characteristic values. A comment in the trend indicates the time of replacing the bearing.

Select Replace bearing with bearing of different type to use a different type of bearing. You must then select the
new bearing from the bearing database. The new bearing replaces the one replaced in the list of bearings. The new
characteristic bearing values are used immediately.

Save the monitoring configuration to activate the new bearing data.

5.9.6 Components

On this tab you can additional components to the monitoring configuration that do not belong to the bearings and that
are manifested in the vibration measurement with periodic signals. These may include tooth engagement frequencies,
mains hum or interference from other machines. These components have no effect on monitoring, they merely provide
additional information for analysis. 

Add component

You can assign a maximum of forty components to a monitoring configuration.

You can enter a maximum of 20 characters in the Component identifier input box. You can
enter a maximum of 60 characters in the Description input box.
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Click on . The new component is displayed in the component list on the left.

Enter the appropriate details in Component details:

o Component identifier: Name of the component

o Description: Additional information about the component

o Frequency: Frequency of the periodic signal characterising the component. The characteristic value is generated
from this frequency.

o Speed  correction  factor:  Factor  by  which  the  measured  rotational  speed  must  be  multiplied  to  obtain  the
rotational speed of the component.

o is fixed: This frequency is independent of rotational speed, e.g. a mains hum of 50 Hz.

o has harmonic: The component creates vibrations at the specified frequency and multiples thereof.

o has sidebands: The component creates a vibration with sidebands.

The component is added to the monitoring configuration.

Edit components

Proceed as follows to edit a component:

Click on .

Make the appropriate changes.

If you switch to another section, you are prompted to save the changes.

Create component-related characteristic values

You can automatically create specific characteristic values for each component.

On  the  Dtect  X1s  device  you  can  only  create  characteristic  values  if  you  are  using  the
characteristic  value  mode  “selective  RMS  /  LDZ"  or  "selective  RMS  /  LDZ  tracked"  (see
"Characteristic value mode" ). Otherwise the button is disabled.

Click on Create characteristic values.

Enter a characteristic value name.

Select the sensor and the signal type for which to create the characteristic value (ProCheck only).

In the next step, please select what to monitor:

Tick the Base frequency checkbox and

configure how many harmonics to include in the monitoring.

Alternatively, you can click Default setting. This activates the base frequency and configures 5 harmonics.

Click OK to create the component characteristic values automatically. 

If  you  exceed  the  maximum  permissible  number  of  characteristic  values,  the  software
displays a warning. You can then modify the number of characteristic values.

On the Dtect X1s device, you can create a maximum of 12 windows. If there are already any
windows  in  the  window  options,  you  can  overwrite  the  old  windows  or  append  the  new
windows. The maximum number of 12 windows must not be exceeded. 

Delete component from monitoring configuration

Deleting a component from the monitoring configuration removes all component data.

Click on .

Display component overview

Click  to display an overview of the assigned components and the related data.
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5.9.7 Characteristic values

This tab is only displayed in ProCheck monitoring configurations.

In this tab you can define the characteristic values to be calculated by ProCheck.

Set predefined characteristic values

You can automatically apply predefined characteristic values here (see “Predefined characteristic values " ):

ISO 10816 settings: Click this button to create a characteristic value to ISO 10816.

Set  particle  counter:  Click  this  button  to  automatically  configure  all  default  settings  for  the  sensor  type  “Particle
counter Fe/nFe".

The  left  part  of  the  tab  displays  the  list  of  characteristic  values  already  defined,  while  the  right  section  displays  the
settings of the characteristic value selected in the list.
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Add characteristic value

Click on .

Adjust the settings.

Click .

Edit characteristic value

Select the characteristic value.

Click .

Adjust the settings.

Click .

Delete characteristic value

Select the characteristic value.

Click on .

Maximum possible rotational speed (for order analysis only)

If  you  have  selected  order  analysis  on  the  Main  channels  tab,  the  maximum  measurable  rotational  speed  is
calculated  from  the  selected  settings  and  the  ProCheck  maximums  for  lowpass  frequency  and  order.  Click  Max.
possible rotational speed to display the maximum measurable rotational speed.

General settings

Name: Enter a text.

Sensor: Sensor channel whose measured values are used to calculate the characteristic value. You can only select
sensor channels that you have created in the Main channels tab (cf. "Main channels" ).

Signal type: ProCheck can record either the raw signal or the demodulation signal on a sensor channel.

Characteristic value type: Select whether the characteristic value refers to monitoring in a time or frequency range.
The other characteristic value settings depend on this selection.

Characteristic value settings

If you selected Monitoring in time range in Characteristic value type, you can configure RMS, DC level, peak, peak-
peak  and  crest  factor  alarm  thresholds  and  alarm  outputs  for  the  available  characteristic  values.  You  can  specify
additional window settings for monitoring in a frequency range.

Alarm thresholds: Enter the threshold for triggering a main alarm in g. Enter the pre-alarm threshold as a percentage
relative to the main alarm threshold.

Digital output: If you have configured digital outputs (cf. "Digital outputs" ), you can select which of these outputs
to activate in the event of a pre- or main alarm.

Analog  output:  If  you  have  configured  analog  outputs  (cf.  "Analog  outputs" ),  you  can  select  which  of  these
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outputs  to  activate  in  the  event  of  a  pre-  or  main  alarm.  Also,  you  can  enter  the  reference  value  to  relate  the
characteristic value to if the type of analog output was set to Relate value (cf. Device configuration  Analog outputs

).

Use for the preview: Activate this option to display the selected characteristic value as a trend in the trend preview.

Click  to display a list of characteristic value settings for the time range.

Speed dependent alarms

All valid alarm thresholds can be tracked as a reference variable on an additional channel if this additional channel was
activated  as  a  velocity  channel  in  the  Main  channels  tab.  If  alarm  threshold  tracking  is  selected,  the  fixed  alarm
threshold  settings  are  retained  in  the  Characteristic  value  settings  tab.  The  tracking  involves  multiplying  the  fixed
alarm thresholds by a factor which is dependent on speed.

To calculate this scaling factor the value pairs for the rotational speed range being monitored, comprising the rotational
speed  and  corresponding  factor,  are  stored.  A  minimum  requirement  here  is  that  both  value  pairs  for  the  rotational
speed range limits are specified. The scaling factor for all other rotational speeds in the rotational speed interval is then
calculated by means of linear interpolation. These value pairs,  referred to in this context  as  supporting points,  can be
entered in  the Tracking of  alarm thresholds tab.  In  this  case  the  reference  variable  of  both  outer  supporting  points  is
specified in the validation settings.

If  you  make  any  changes  that  affect  supporting  points,  you  can  have  them  automatically
modified.  The  program  adjusts  the  reference  variables  and  deletes  values  outside  the  new
reference variables. This may reduce the number of supporting points.

Check the Enable checkbox. A table showing two supporting points for both limits of the reference variable range is
displayed in this tab. The X values are the reference variables and the Y values are the scaling factors.

First, select the preferred number of supporting points.

Enter the data for the supporting points, i.e. reference variables under "X" and scaling factors under "Y".

If you right-click the table you can copy the values entered here to the clipboard and vice versa.
This method can be used to copy values from one configuration to another. It is also possible to
paste these values into a spreadsheet program or copy them from there and insert them into the
table of supporting points.

Windows

You can specify the frequency bands for monitoring in the frequency range in this tab.
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Use peak mode: If you enable this checkbox, when the characteristic value is calculated, rather than calculating the
root mean square across all frequency lines in a window the software searches for the highest peak in each window.
Therefore for calculation of  the characteristic  value only one value from each window is  used (the highest  peak)  to
calculate  the  root  mean square  (RMS value).  If  a  significant  amount  of  noise  or  smaller  signals  are  present  in  the
window next to the peak then the impact of a significant change of the normal characteristic value peak is less severe
because the characteristic value obtained from the RMS calculation is only an average value for the window. In peak
mode a change in the peak would cause the characteristic value in this window to change to exactly the same extent.

Number of windows used for characteristic value calculation: You can select a maximum of 12 windows.

Window settings:

o Fixed windows:

Enter the upper and lower threshold frequency for the first window and then define the harmonic frequencies
(see Defining harmonic frequencies ).

o Tracked windows / order analysis:

Normalized average frequency / Hz: For the first window, enter the frequency relative to rotational speed where
you want the middle of the window to be.

Normalized bandwidth / Hz: Enter the bandwidth of the first and last window in Hz then define the harmonic
frequencies (see Defining harmonic frequencies ).

Example:
With a normalized average frequency of  4  and a normalized bandwidth of  0.5  you  will  have  a  window ranging
from 3.75  times  (4  -  half  bandwidth)  to  4.25  times  (4  +  half  bandwidth)  the  rotational  speed.  With  a  rotational
speed of 1200 min-1 = 20 Hz, the window would be between 75 and 85 Hz.

The sum of normalized average frequency and half the normalized bandwidth must not exceed
239.95 Hz.

o Window name: Enter the desired window name. By default, the Configuration Manager names the windows "window
<n>".

Define harmonic frequencies: Defines the harmonics based on the first window.

o For fixed windows: The frequencies for windows 2 to n are calculated based on the values of the first  window by
multiplying them by 2 to n. The windows are named according to this pattern: "n*<name of first window>".

o Tracked windows / order analysis: The normalized average frequencies for windows 2 to n are calculated based on
the values of the first  window by multiplying them by 2 to n. The normalized bandwidths of windows 2 to  n-1 are
calculated by interpolating from the normalized bandwidths of  the first  and last  window. The windows are named
according to this pattern: "n*<name of first window>".

Example:
Window 1: normalized average frequency = 1.1, normalized bandwidth = 1.0; window 3: normalized bandwidth =
0.5
The  following  values  are  calculated:  window  2:  normalized  average  frequency  =  2.2,  normalized  bandwidth  =
0.75; window 3: normalized average frequency = 3.3.
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If an input value is outside the measurable range, the result may be that measuring data are
invalid  or  a  measurement  cannot  even  be  performed.  A  warning  draws  attention  to  this
situation, and the invalid value is highlighted yellow until a valid value is input.

If you save the configuration with the invalid values, the appropriate monitoring configuration is
highlighted yellow up to device level (see Invalid configurations ).

5.9.8 Validation

This tab is only displayed in Dtect X1s monitoring configurations.

If additional channels for the tracking of frequencies, speed-dependent alarm limits and for validation are installed in the
Dtect X1s device, these are defined in the "Validation" tab.

Where  frequencies  are  tracked  the  additional  channel  to  which  a  speed  sensor  is  connected
must be specified in the General settings  tab of the device configuration.

Rotational speed settings

If you are not using frequency tracking you need the rotational speed information for the FFT display in FAG Viewer. 

Specify whether to enter frequencies in Hz or rpm.

Enter the number of revolutions.

Additional channel for the tracking of frequencies

If you select the "tracked" characteristic values in the General data  tab or wish to use speed-dependent alarm limits
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, you must first specify the additional channel to be used as the reference variable.

Enter a label for the validator in “Validation 1".

Select whether to use the validator for tracked windows and/or tracked alarm limits.

Select the additional  channel with the reference value in the “Linked additional  channel”  list  box.  The names of  the
additional channels in this case correspond to the names you assigned in the device configuration .

Enter  a  conversion  factor  if  you  want.  The  conversion  factor  is  used  where  rescaling  of  the  reference  variable  is
required. To achieve this, the reference variable is multiplied by the conversion factor prior to evaluation by the Dtect
X1s device. This conversion factor is required for gearboxes (for example) where the measured rotational speed does
not match the speed of the component being monitored due to a gear ratio.

Validation via an additional channel

You  can  use  validation  to  ensure  that  only  measurements  obtained  under  predefined  operating  conditions  are
recognized and that alarm signals are only output under these conditions.

Two threshold ranges per validation channel are available. This means that the user can classify the signals  for  each
validation channel  (high speed or  load and low speed and load).  You can also use the "Mirror  limits"  option  to  mirror
upper and lower limits, e.g. for rotational speeds in reverse. If you activate "Mirror limits", the second validation section
is no longer available.

You can use positive and negative values for  validation.  This  allows  you  to  selectively  exclude  a  system's  resonance
ranges that could otherwise distort measurements and thus result in false alarms.

If the validation condition becomes invalid existing alarms are reset, providing the "Manual reset" option (see "General
settings " tab in the device configuration) is not activated. In this case you must define a condition for the auxiliary
signal by activating the individual checkboxes and entering the assigned maximum values. If  this condition is satisfied
for the duration of the measurement, the result is accepted.

A  maximum  of  one  validator  per  additional  channel  is  possible.  The  validators  are  defined  under  the  headings
"Validation 1" or "Validation 2" and are logically ANDed.

Create a validation

Enter a label for the validation.

Select which additional channel to use in the "Linked additional  channel” listbox. The names of the channels in this
case correspond to the names you assigned in the device configuration.

Enter a conversion factor (see above) as required.

Compile a validation condition.

The  three  individual  conditions  and  corresponding  limit  values  produce  a  validation  condition.  The  conditions  are
logically ANDed but are only taken into account if the checkbox is activated. 

Individual condition Meaning

Maximum signal change Maximum permitted change of additional signal during a measurement.

Relative signal change (%) If this option is enabled, signal change is calculated by adding the percentage to or subtracting it
from mean rotational speed.

Upper limit Highest value permitted for auxiliary signal.

Lower limit Lowest value permitted for auxiliary signal.

Combination of validations

If two validations are defined these are logically ANDed as standard.

Validation with high sample rates

The  A/D  converter  in  the  Dtect  X1s  device  has  a  overall  sampling  rate  of  roughly  80kHz.  It  is  therefore  no  longer
possible to measure both validators and the measurement signal at the same time at sample rates greater than 15 kHz,
i.e.  at  a  low pass  frequency of  5  kHz.  However,  with  high  sample  rates  it  may be  assumed that  the  rotational  speed
changes  only  slightly  for  the  duration  of  the  measuring  time  because  the  measurement  is  completed  in  a  very  short
space of time (only 137ms with 30kHz sample rate, for example).  It  is  therefore sufficient in  this  case to  measure the
input signal of the validator before and after the actual measurement in order to monitor the validation window.

If  you  make  any  changes  to  the  validation  that  affect  the  characteristic  values  frequency
window,  a  message  is  displayed  indicating  which  characteristic  values  and  frequency
windows need to be modified. Click “Yes” to change the validations (the characteristic values
and frequency windows that need to be changed are highlighted yellow). Click "No" to reset
the changes to the validation.

If you save the configuration with the invalid values, the appropriate monitoring configuration
is highlighted yellow up to the device (see Invalid configurations ).
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5.9.9 Window options

This tab is only displayed in Dtect X1s monitoring configurations.

This  tab  only  appears  if  you  selected  a  characteristic  value  for  monitoring  in  the  frequency  range  in  the  General
information  tab.  The frequency bands (for  selective characteristic  values)  and  alarm limits  are  defined  here.  Each
option is explained below.

Alarm limits for high-bandwidth "ISO 10816", "RMS" and "LDZ" characteristic value types

The  ISO 10816,  RMS and  LDZ  characteristic  value  types  are  high-bandwidth  types  (refer  to  section  "Monitoring  with
high-bandwidth characteristic values") which means that only the pre- and main alarm thresholds must be defined here.

Enter...

the value of the main alarm threshold in the same units as the characteristic value in the field with the main alarm
designation and 

specify  the  pre-alarm  threshold  as  a  percentage  of  the  main  alarm  threshold  in  the  field  with  the  pre-alarm
designation.
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Note that the LDZ values are standardized and subsequently output as dB values. The main
alarm threshold must therefore also be defined in dB.
The  pre-alarm  threshold  values  on  the  other  hand  are  based  on  the  LDZ  value  prior  to
standardization.  If  the  main  alarm  threshold  is  10dB  for  example,  a  pre-alarm  threshold  of
50%  will  cause  the  pre-alarm  to  be  triggered  from  an  LDZ  value  of  7dB.  The  pre-alarm  is
calculated according to the following formula:
pre-alarm threshold = main alarm threshold-10 * log (percentage value).

The main alarm limit in dB can be set in a range from -699 to 800 dB.

Frequency bands and alarm limits for "selective LDZ" and "selective RMS" characteristic value types

If you selected the "selective LDZ" and "selective RMS" characteristic value types in the "General data" tab, you can do
the following here:

define the frequency bands to be taken into consideration,

specify whether a characteristic value should be calculated separately for each frequency band or whether a common
characteristic value should be calculated for all bands,

assign a name to the individual frequency bands, and

specify the corresponding alarm limits.

Proceed as follows:

First, enter the number of frequency bands that are to be taken into account under "number of windows" at the top of
the tab.

Specify  a  common  characteristic  value  or  separate  characteristic  values  for  each  frequency  band  in  the
"Characteristic value calculation" group field.

Assign names to the frequency bands if required.

If a common characteristic value is to be calculated, 

define both alarm limits on the right-hand side of the tab and the upper and lower limit of the frequency bands at the
foot of the table.

If individual characteristic values are to be calculated, 

enter the lower and upper limit of the frequency bands and corresponding alarm limits at the foot of the table.

Frequency bands and alarm limits for the "selective LDZ speed-dependent" and "selective RMS speed-
dependent" characteristic values.

If you selected the "selective LDZ speed-dependent" and "selective RMS speed-dependent" characteristic value types in
the "General information" tab, you can do the following here:

define the frequency bands to be taken into account based on the rotational frequency,

specify whether a characteristic value should be calculated separately for each frequency band or whether a common
characteristic value should be calculated for all bands,

specify names for the frequency bands, and

specify the corresponding alarm limits.

Now proceed as follows:

First, define the number of frequency bands that are to be taken into account under "number of windows" at the top of
the tab.

Specify  a  common  characteristic  value  or  separate  characteristic  values  for  each  frequency  band  in  the
"Characteristic value calculation" group field.

If a common characteristic value is to be calculated, 

enter both alarm limits on the right-hand side of the tab and enter the average frequency and width of the frequency
bands based on the rotational speed at the foot of the table.

If individual characteristic values are to be calculated, 

enter  the  average  frequency  and  width  of  the  frequency  bands  based  on  the  rotational  speed  and  corresponding
alarm thresholds at the foot of the table.

You  can  determine  the  average  frequencies  and  widths  to  be  entered  in  the  table  as  follows:  Assuming  that,  for  a
machine component turning at a frequency of fD, you anticipate an unusual signal to occur between the fS- f/2 and fS +

f/2 frequencies, fS is the average frequency and f is the width of the frequency interval. With tracked frequency bands
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you must enter the following values in the table: fS/fD for the average frequency and f/fD for the width of the frequency

band.

Peak mode

It  is  possible  to  activate  the  "Use  max peak"  option  in  the  monitoring  configuration  window options.  This  means  that,
when the characteristic value is calculated, rather than calculating the root mean square across all frequency lines in a
window the software searches for the highest peak in each window. Therefore for calculation of the characteristic value
only one value from each window is used (the highest peak) to calculate the root mean square (RMS value).

If  a  significant  amount  of  noise  or  smaller  signals  are  present  in  the  window  next  to  the  peak  then  the  impact  of  a
significant change of the normal characteristic value peak is less severe because the characteristic value obtained from
the RMS calculation is only an average value for the window. In max peak mode a change in the peak would cause the
characteristic value in this window to change to exactly the same extent.

If you right-click the table you can copy the values entered here to the clipboard and vice versa.
This method can be used to copy values from one configuration to another. It is also possible to
paste these values into Excel from the table in the window or vice versa.

Configure particle counter window

Click  Configure particle  counter window  to  automatically configure all  default  settings  for  the  “Particle  counter  (Fe/
nFe)" sensor type (see "Set pre-defined characteristic values" ).

Review window settings

If an input value is outside the measurable range, the result may be that measuring data are
invalid  or  a  measurement  cannot  even  be  performed.  A  message  draws  attention  to  this
situation, and the invalid value is highlighted yellow until a valid value is input.

If you save the configuration with the invalid values, the appropriate monitoring configuration is
highlighted yellow up to device level (see Invalid configurations ).

5.9.10 Alarm thresholds

This tab is only displayed in Dtect X1s monitoring configurations.

This tab is only displayed if you have selected time domain monitoring, i.e. the “Time domain” characteristic value mode,
on the General data  tab.
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Mark the characteristic values to be used to monitor the time signal (all characteristic values are always calculated but
only the marked values will be taken into account for alarm messages).

Enter  the  main  alarm  threshold  value  and  pre-alarm  threshold  value  for  the  characteristic  values  selected  as  a
percentage of the main alarm threshold.

5.9.11 Speed-dependent alarm thresholds

This tab is only displayed in Dtect X1s monitoring configurations.

All valid alarm limits can be tracked as a reference variable via an additional channel providing this has been activated
in  the  Validation  tab  as  the  additional  channel  for  the  tracking  of  frequencies,  i.e.  as  the  1st  validator  of  the
monitoring configuration.
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If  tracking  of  alarm  limits  is  selected,  the  fixed  alarm  limit  settings  are  retained  in  the  Window  options  tab.  The
tracking involves multiplying the fixed alarm limits by a factor which is dependent on speed.

To calculate this scaling factor the value pairs for the rotational speed range being monitored, comprising the rotational
speed  and  corresponding  factor,  are  stored.  A  minimum  requirement  here  is  that  both  value  pairs  for  the  rotational
speed range limits are specified. The scaling factor for all other rotational speeds in the rotational speed interval is then
calculated by means of linear interpolation.

If  the  monitored  characteristic  value  is  an  LDZN  value  measured  in  dB,  the  change  to  the

characteristic value is saved in  dB and used for  interpolation.  In  the case of  the LDZ value,  it
should be noted that the multiplication changes to addition as a result of the dB standardization
and scaling.

These value pairs, referred to in this context as supporting points, can be entered in the Speed-dependent alarm limits
tab. In this case the reference variable of both outer supporting points is specified in the validation settings. A maximum
of eight additional supporting points can be defined between these points.

Open the Validation  tab, activate the "lower" or "upper threshold" checkbox under the "Validation 1" heading and
enter the lower and upper limit for the reference variable to be monitored.

Switch to the Speed-dependent alarm limits tab and select the Activate option.

A  table  showing  two  supporting  points  for  both  limits  of  the  reference  variable  range  is  displayed  in  this  tab.  The  X
values are the reference variables and the Y values are the scaling factors.

First, select the preferred number of supporting points.

Enter the data for the supporting points, i.e. reference variables under "X" and scaling factors under "Y".

As the program checks each entry to determine whether the X values of the supporting points
increase  as  the  supporting  point  number  increases,  values  should  be  entered  in  ascending
order, i.e. starting with the highest supporting point number.
Note that with LDZN values changes to alarm thresholds must be specified in dB.
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If you right-click the table you can copy the values entered here to the clipboard and vice versa.
This method can be used to copy values from one configuration to another. It is also possible to
paste these values into a spreadsheet program or copy them from there and insert them into the
table of supporting points.

5.9.12 Memory options

You  can  configure  how the  device  saves  characteristic  values  on  the  Saving  options  tab.  Characteristic  values  are
always saved if you have triggered an alarm, regardless of the settings. This forced storage ensures that no important
characteristic values are lost.

ProCheck

Characteristic value save options

Save always:  The characteristic  values of  a  monitoring configuration are saved with  every measurement.  The time
interval between two successive characteristic values corresponds to the duration of a complete monitoring cycle.

Save every <n> measurements: The characteristic values of a monitoring configuration are saved after a specified
number of measurements. The time interval between two successive characteristic values corresponds to the N-fold
duration of a complete monitoring cycle.

Save every <n> h/m/s: You can use this setting to specify the time interval during which two successive characteristic
values are saved. The time interval set must be regarded as the minimum interval between two characteristic values.
This minimum time interval can be extended by the duration of one monitoring cycle at the most.



122

Please observe that the time interval set is a minimum time which can be extended in each case
by the duration of  a  monitoring cycle.  The use of  time intervals  smaller  than the duration of  a
monitoring cycle is not expedient as the characteristic values of the monitoring configuration are
consequently always saved.

Saving  on  changes  of  more  than  +/-  %:  Characteristic  values  are  only  saved  if  they  deviate  from  the  previous
measurement by a specified percentage.

Time signal and FFT save options

Save signals every <n> h/min: Enter an interval at which to save time signals and FFTs and select the data to save.

Save on main alarm: Select the data to save in the event of a main alarm.

Save on pre-alarm: Select the data to save in the event of a pre-alarm.

You can only save raw and demodulation signals if they are enabled for the respective sensor
on the Main channels tab (see "Main channels" ).

FFTs  can  only  be  saved  if  you  have  created  at  least  one  characteristic  value  of  the
frequency  range  monitoring  type  for  the  respective  signal  type  on  the  Characteristic
values tab (see "Characteristic values" ). If you have only defined characteristic values of
the time range monitoring type there, you cannot save any FFTs. 

Data storage settings

Save data every <n> h/min: Enter an interval after which the characteristic values must be transferred and stored.

Remote call

In this section you can specify whether the ProCheck device should automatically report and send data via the selected
communication channel if certain events occur.

Device calls at:

o Main alarm: Device reports if a main alarm has occurred in this monitoring configuration.

o Pre-alarm: Device reports if a pre-alarm has occurred in this monitoring configuration.

o Disk  overflow/Low memory:  The  critical  data  file  size  in  the  data  storage  of  the  ProCheck  device  has  been
reached. Read out the data as soon as possible to free up memory.

o Elapsed remote time: One of the conditions defined for remote communication (see "Communication settings"
  Remote communication) is fulfilled.

Note that these settings affect the monitoring configuration! Therefore,  the device only  reports
when the selected events occur if they occur during the monitoring configuration.

Dtect X1s

The storage options are defined in the upper section of the tab and the validators saved with the characteristic values
are displayed in the lower section of the tab. The following storage options exist:
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Always save characteristic values

The characteristic values of a monitoring configuration are saved with  every measurement.  The time interval  between
two successive characteristic values corresponds to the duration of a complete monitoring cycle.

Save characteristic values after n measurement(s)

The characteristic values of a monitoring configuration are saved after a specified number of measurements. The time
interval between two successive characteristic values corresponds to the N-fold duration of a complete monitoring cycle.

To configure this option proceed as follows:

Activate the checkbox next to the "Save characteristic value every N measurements" option.

Now  enter  the  number  of  measurements  that  must  be  made  before  the  respective  characteristic  values  for  this
monitoring configuration are saved in the activated field.

Save characteristic values if time exceeds

You can use this setting to specify the time interval  during which two successive characteristic values are saved. The
time  interval  set  must  be  regarded  as  the  minimum  interval  between  two  characteristic  values.  This  minimum  time
interval can be extended by the duration of one monitoring cycle at the most.

To configure this option proceed as follows:

Activate the checkbox next to the "Save characteristic value after..." option.

Enter the preferred minimum time interval that should exist between two characteristic values in the activated hours,
minutes and seconds fields. The maximum time interval is 49 hours, 59 minutes and 59 seconds.

Please observe that the time interval set is a minimum time which can be extended in each case
by the duration of  a  monitoring cycle.  The use of  time intervals  smaller  than the duration of  a
monitoring cycle is not expedient as the characteristic values of the monitoring configuration are
consequently always saved.
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Save characteristic values where change is greater than +/- <n> % (for characteristic values from the frequency
spectrum)

With  this  setting  the  characteristic  values  are  only  saved  if  they  differ  from  the  previous  characteristic  value  by  a
minimum  percentage  "X".  Where  this  parameter  is  set  correctly  this  results  in  a  greater  density  of  data  in  the
characteristic value ring and also results in changing trends being presented more clearly. The option "absolute" can be
used  to  specify  that  changes  of  X  percent  in  a  positive  as  well  as  negative  direction  are  saved.  If  this  option  is  not
selected the symbol in front of the specified percentage determines whether  the characteristic  value is  saved,  i.e.  if  it
increases by X percent (positive symbol) or decreases by X percent (negative symbol). If several characteristic values in
a  monitoring  configuration  are  calculated,  all  characteristic  values  are  subsequently  saved  providing  the  storage
condition for at least one characteristic value is met.

To configure this option proceed as follows:

Activate the checkbox next to the "Save characteristic if changed..." option.

If positive and negative changes to characteristic values are to be saved activate the "absolute" checkbox.

Now  enter  the  preferred  percentage  in  the  field  in  front  of  the  percentage  symbol.  If  the  "absolute"  option  is  not
activated, check that the symbol entered in front of the value is the correct one.

Save characteristic values where change is greater than +/- <n> % (for characteristic values from the time
domain)

If you opted to calculate characteristic values from the time range in your monitoring configuration, the appearance of
the  input  screen  will  be  slightly  different  than  the  screen  used  to  determine  characteristic  values  from  the  frequency
spectrum (see above).  The functional  method is essentially  the same.  However,  in  this  characteristic  value mode you
can also define a separate change threshold for each characteristic value.

The "absolute"  option in  this  case relates to  all  change thresholds.  Here  too  the  following  also  applies:  if  the  storage
condition for at least one characteristic value is met, all characteristic values of the monitoring configuration are saved. If
change  thresholds  are  not  to  be  taken  into  consideration  for  individual  characteristic  values,  the  relevant  change
threshold settings must be sufficiently high.

To carry out the configuration please follow a similar procedure to the one described above under "Storage option for
characteristic values from the frequency range".

Please observe that, owing to the percentage, the change threshold depends on the size of the
characteristic  value  which  means  that  characteristic  values  are  saved  even  if  relatively  small
changes are made to small characteristic values in terms of amount.

Save timestamp of characteristic dataset

You can switch the option for storing the system time together with the characteristic values on or off here. If this option
is activated the time the measurement was taken is stored alongside each characteristic value.

This  option  therefore  influences  the  display  of  characteristic  values  stored  in  the  trend  memory.  If  the  time  stamp
storage option is active this results in a linear presentation of trend data for the time period. It follows therefore that the
intervals  between the  characteristic  values  represent  the  actual  time  intervals  of  the  measurement.  If  the  time  stamp
storage option is not activated the distances between all characteristic values displayed will be the same irrespective of
how much time has passed between two measurements.

Below, you can configure the number of validation channels to save with the characteristic values.

To obtain valid trends, the characteristic values must always be saved with a timestamp.

The condition for cumulating characteristic values is that characteristic values be saved with a
timestamp (see "Saving options" ).

5.9.13 Remote

This tab is only displayed in Dtect X1s monitoring configurations.

For details about this tab please refer to the section "Configure device for remote server ".
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5.9.14 Image

You can store a suitable image for the configuration (for example) here. You can use either JPEG or BMP files.

To do this click on  and select the file that contains the preferred image using the selection dialog box.

Follow the same procedure as above if you wish to change the image.

Click on  to delete the image and click on  to print it.

5.9.15 Additional information

This  tab  is  used  to  enter  any  text,  e.g.  to  add  further  information  about  a  device.  You  can  also  enter  a  link  as
information. Double-click it to open it in your default browser.

5.10 Copy configuration(s)
You  can  copy  a  device  configuration  or  monitoring  configuration  as  a  template  for  new  configurations.  Device
configurations are copied together with their monitoring configurations. Data or alarm settings of the original monitoring
configuration are not copied.

If you copy a configuration between two different devices:

the device type and device properties of both devices must be identical

the firmware version of  both devices must  be identical  or  the firmware version  of  the  target
device must be newer.

Copy device configuration

Highlight the device configuration you wish to copy.

Select Copy from the context menu or press CTRL+ALT+C.

Highlight the device to add the copy of the device configuration to.

Select Paste from the context menu or press CTRL+ALT+V.

The copy of the device configuration is inserted at the last position of the device level, with “Copy of” added. You can
edit the device configuration as usual (see sections Device configuration  and Monitoring configuration ).

Click on  on the toolbar or press F5 to refresh the display.

Copy monitoring configuration

Highlight the monitoring configuration you wish to copy.

Select Copy from the context menu or press CTRL+ALT+C.

Highlight the device configuration under which you wish to add a copy of the monitoring configuration.

Select Paste from the context menu or press CTRL+ALT+V.

The monitoring configuration is inserted at the last position of the device level, with “Copy of” added. You can edit the
monitoring configuration as usual (see section Monitoring configuration ).

Click on  on the toolbar or press F5 to refresh the display.

5.11 Invalid configurations
If you have created an invalid configuration in the FAG Administrator software, it is highlighted yellow in the tree view.
The highlight extends from the relevant monitoring configuration to the device level.

A device or monitoring configuration is invalid if a value is outside a valid range. The result may be that measuring data
are invalid or a measurement cannot even be performed. In the event of an invalid configuration, we recommend that
you always check the settings.
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As long as a device configuration does not contain a Monitoring configuration, it is also invalid
and is highlighted yellow in the tree view.

5.12 Outdated configurations
If you change the device or monitoring configuration of a device, the corresponding data stored in the CM database is
no  longer  comparable.  Therefore,  the  configurations  are  marked  as  outdated,  i.e.  the  data  is  removed  from  the  tree
view Devices and configurations but not deleted from the database. You can continue to analyse the stored data.

Show outdated configurations

Click a device or device configuration.

Right-click the device configuration and select Show outdated configurations.

The outdated configurations are displayed in italics under the active configuration.

You  can  have  outdated  configurations  shown  automatically.  To  do  so,  activate  the  Always
show outdated configurations option in Extras > Options > General > Miscellaneous.

Press F7 to deactivate this setting.

Hide outdated configurations

Right-click an element in the tree view.

Select Refresh tree / selected item.

Or:

Press CTRL+ALT+R.

What to observe when deleting outdated configurations

If  you  want  to  delete  an  invalid  device  configuration,  for  which  there  are  both  active  and  outdated  device
configurations, you can select whether to delete only the active or the active and outdated device configurations.

If  you  delete  a  monitoring  configuration,  the  device  configuration  to  which  the  monitoring  configuration  belongs  is
flagged as outdated. If you do not want this, first delete all  measuring data in the monitoring configuration and then
the monitoring configuration itself. 

5.13 Predefined characteristic values
You can configure various predefined characteristic values in the Administrator software depending on your settings.

ISO 10816

The following defaults are configured for monitoring to the ISO 10816 standard:

Monitored parameter: "Velocity"; low-pass frequency "1 kHz"; integrations: "1" (with acceleration sensors).

Particle counter settings

The following defaults are configured for the sensor type “Particle counter (Fe/nFe)":

ProCheck:  Window  selection  "Fixed  windows";  signal  type  “Raw  signal";  low-pass  frequency  "1  kHz";  number  of
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measuring  values  "4096";  windows  for  characteristic  value  calculation  "11";  characteristic  value  type  "Frequency
domain monitoring"; number of windows "1".

Dtect X1s: Characteristic value mode "selective RMS"; low-pass frequency "1 kHz"; windows for characteristic value
calculation "11"; one characteristic value per frequency band.

Particle class frequencies are at 54; 81; 135; 189; 297; 351; 459; 513; 621; 783 and 837 Hz.

Bearing-related  characteristic  values  can  only  be  created  on  the  "Bearings"  tab  (see  “Create
bearing-related characteristic values" ).  

5.14 Automatic alarm level adjustment
The  user  can  use  this  function  to  generate  alarm  thresholds  for  the  characteristic  values  defined  in  the  system.  An
algorithm developed by FAG Industrial  Services GmbH is  used in  this  case.  Specific  information which is  required for
calculation of the alarm limits must be provided by the user. The user can adapt the alarm thresholds again at any time
or change the limits manually at a later date.

Before this function in the system can be used it is necessary for the data to have been recorded by the system over a
longer period of time. The more comprehensive the base data, the more precise the results determined by the system
for the various characteristic values will be.

This function is not available for the tracking of alarm thresholds .

Automatic alarm limit adjustment ignores faulty peaks with values greater than 10^100.

You can define minimum and maximum values for all characteristic values available in the system in the options dialog
 for Dtect X1s and ProCheck devices.

If the values specified when adjusting the alarm threshold fall below the lowest or exceed the highest peaks defined for
the  relevant  characteristic  value  (see  "Program  settings" )  the  corresponding  maximum  values  from  the  options
dialog  are  set  as  the  alarm  limits.  This  data  can  be  adapted  by  users  to  the  specific  vibrational  properties  of  the
mechanical assemblies being monitored based on their own experience. 

Further,  in  order  to  exclude  specific  conditions  of  a  system  when  calculating  the  alarm  limits,  it  is  also  possible  for
characteristic values that are above or below specific limits not to be taken into account during modification. These can
also be optimized by users according to their experience and entered in the Program settings .

Use of the alarm threshold adjustment wizard does not relieve the user of the responsibility  of
critically  analysing  the  maximum  values  set.  This  is  only  intended  as  an  aid  and  not  as  a
replacement for the experience accumulated by the operator with the system concerned.

You can modify the alarm limits as follows:

Highlight a device in the tree and

click Automatic alarm limit adjustment in the Edit menu.

Or:

Click Automatic alarm limit adjustment for all devices in the Edit menu and

select the devices whose alarm limits you want to edit: 
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All devices in the database are displayed. Click on the checkbox before a device to select it.  If  you only want devices
with a certain name, you can filter the list. To do so, enter a name (e.g. ProCheck) and tick the checkbox next to “Filter
device names". The list displays only devices with this name.

Select the devices,

activate Adjust alarm limits automatically and 

click OK.

The alarm limit adjustment wizard is displayed:

Select an adjustment mode (low, medium, high) and click Next.

Specify the extent to which the alarm thresholds should be increased in percent or dB.
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In order to also adapt the pre-alarm values to the new alarm limits, select the Set pre-alarm limit to option and enter
the required % or dB values.

Click Continue.

If you wish to limit the adjustment of alarm thresholds to a specific period of data measurement, select Time period.

You  can  define  a  date  and  time  for  the  time  range  in  Start  date  and  End  date.  If  you  wish  to  adapt  the  alarm
thresholds from a specific period up to the end date you can enter the number of days in the corresponding input field.
The start date is then adjusted automatically.

Click Continue.

Check your settings and click Calculate to adjust the alarm thresholds or click Back to edit the settings.

An overview of all modified values is displayed. You can copy them to the clipboard from the context menu.

5.15 Alarm list management
The alarm list administration feature provides you with a chronological overview of various events that have occurred as
well as changes made to the system. This is identical to the data administration feature in that you have access to the
data as soon as it has been read out from the device and saved.

The following events are logged in the alarm list administration:

Changes to a device configuration

Triggering of a pre-alarm

Triggering of a main alarm

Resetting of an alarm

Launch the alarm list administration as follows:

Click on Show alarm list in the View menu.
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The alarm list itself is located below a menu bar and a panel containing various command buttons. This contains data,
more information on which is provided below:

Nomenclature of alarm list data fields:

Field name Meaning

Symbol The symbol in front of each data set allows you to identify the associated event more easily. The
meanings of the individual symbols are:

 blue i:
 yellow square:
 red square:
 red/green square:

General information
A pre-alarm was triggered.
A main alarm was triggered.
The alarm was reset.

Date The Date field contains information on the day and time a new entry was entered in the alarm list.

Action The Operation field contains a brief description for each entry of the event that led to the entry.

Serial number This field contains the serial number of the device that the entry refers to.

Name Name given to the device during configuration.

Device configuration This field contains the name of the device configuration.

Monitoring configuration This field contains the name of the monitoring configuration.

Frequency band Displays the name of the relevant frequency band.

User name Name of the person who configured the device and the monitoring parameters.

Comment This is the comment that was entered when specifying the settings of the monitoring configuration.

A context menu can be opened and the data administration functions called up by right-clicking any field containing a
data set.

Functions for the alarm list administration

The  most  important  functions  of  the  alarm  list  administration  can  be  called  up  via  the  context  menu,  which  can  be
accessed from any marked data set. Several of these functions can also be called up via the button bar or menu bar.

Context menu in alarm administration

The context menu can be used to navigate through the data sets. You can also specify a filter or edit the comment for a
data set.
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Menu items Function

Use current data set to filter list You can use this option to filter the list using the selected data set as the basis.

Reset filter settings Resets the filter in order to display all data sets in the alarm list.

Edit comment Opens a dialog box in which the comment can be edited.

First Moves to the first data set in the alarm list.

Next Positions the cursor at the next data set.

Previous Positions the cursor at the previous data set.

Last Jumps to the last entry in the alarm list.

The button bar

You can quickly access frequently used functions via the button bar elements. A data set must be marked before the
data set functions can be called up.

Button Meaning

Exit the alarm list administration

Jumps to the first data set in the alarm list.

Positions the cursor at the previous data set.

Positions the cursor at the next data set.

Jumps to the last entry in the alarm list.

Deletes the selected entry in the alarm list.

Opens a dialog box in which the comment can be edited.

You can use this option to filter the list according to the selected dataset.

Resets the filter in order to display all data sets in the alarm list.

Opens the print preview for the report.

The menu bar

Several commands from the context menu can also be called up via the menu bar.

Menu Menu items and function

File Export data
You can use this button to save the data in the alarm list in a CSV file.
Close 
Exit the alarm list administration

Alarm list Use current data set to filter list
You can use this option to filter the list according to the selected dataset.
Reset filter settings
Resets the filter in order to display all data sets in the alarm list.
Edit comment
Opens a dialog box in which the comment can be edited.
First
Moves to the first data set in the alarm list.
Next
Positions the cursor at the next data set.
Previous
Positions the cursor at the previous data set.
Last
Jumps to the last entry in the alarm list.

Filter settings

You can  use  the  filter  settings  to  define  precisely  which  data  should  be  displayed.  You  can  display  the  filter  settings
options via the "Filter settings" button. The various options are explained below:

Option Function

Period of time You can display alarms from a specific period by activating this option.

Filter Serial number
If you enter a serial number here alarms from the device with this serial number will be
displayed.
Device config. name
If you enter the name of a device configuration here only data originating from this device
configuration will be displayed.
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Option Function

User name
When this filter setting is applied, only configurations defined by this user and corresponding
data sets will be displayed.
Name
This provides the user with the option of displaying only the data of a specific device.
Monitoring config. name
Here you can enter the name of a monitoring configuration, which is then used as filter criterion.

The print preview

The print preview window opens when the button in the alarm list administration toolbar is pressed.

You can navigate through the individual pages of the report and change the size of the view with the help of the button

bar in the print preview. Once you are satisfied with the report you can press the  button to print it out.

Exit the alarm list administration

You can end the alarm list administration using one of the following commands:

either

from the menu File > Close 

or

by clicking  on the menu bar.

5.16 Alarm status

Update alarm state

You can update the alarm state for one or all tree items.

Select a device and

click Update alarm state of selected nodes in the Edit menu.

Or:

Click Update all alarm states in the Edit menu.

Reset alarm status

If  the  Reset  pre/main  alarm  manually  option  is  selected  (ProCheck  see  section  “Manage  devices"   "General
settings" ,  Dtect  X1s  see  section  "Device  configuration"   "General  settings" ),  the  triggering  monitoring
configuration  is  removed  from  monitoring  mode  in  the  event  of  a  main  alarm.  This  is  only  taken  into  account  again
during measuring mode once the alarm has been reset.

You can reset the alarm status as follows:

Make sure that a connection to the device has been established.

Select a device or one or several configurations.

Right-click the selected entries and select Reset alarms... from the context menu.

Or:

Click on  in the toolbar.

All  alarms  for  the  element  selected,  including  all  sub-elements,  are  reset.  The  relevant  elements  in  the  tree  view are
highlighted in green once again.

The original alarm status remains displayed in the measuring data view !

5.17 Data export/import
The configuration manager provides the following options:

Store (i.e. export) device information, configurations and measuring data in an external file and also

import  such files.

This means that data and configurations can easily be exchanged between different installations. To migrate databases
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created  and  edited  with  Configuration  Manager  (as  of  version  4.0),  you  can  import  them  completely  into  the  current
Configuration Manager.

Export format

The Configuration Manager exports data in "4.x Export-Format (*.x5)" format.

Import formats

The Configuration Manager can import the following formats:

Files in "4.x Export Format (*.x5)"

Files or databases in "4.0 Export Format (*.zip)"

Configuration Manager version 3.x: V3 files (*.x11) or databases (from a directory)

5.17.1 Export data

In the FAG Administrator software you can export device information, configurations and measuring data with the aid of
the Export Wizard. 

To do so, select a device, configuration or the complete system in the tree view and

click Export selection in the File menu.

Or:

Select one or more datasets in the data view of a monitoring configuration and

select "Export selected rows” from the context menu.

The wizard helps you put together the export data:

Enter the path and file name for the export file.

Click Continue.

The following options are available:

- Configurations to export only the configuration of the devices (no export data exported).

- Configurations with data to export the configuration of the devices and the measuring data.

- Configurations with data in date/time range to export the configurations with data from a specific time period.
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Press Next to confirm your selection.

If you only export the configurations, you will arrive directly at an overview of the settings you made. Click on Finish to
export the data.

If you have already exported data from the database and only want to export new datasets, perform the following steps:

Select Only not yet exported data. The advantage of this is that a much smaller file will be generated. However, the
recipient of the data must already have access to an exported database.

Press Next to confirm your selection.

If you have selected "Configurations with data in date/time range", you can define the time range of the data to export.
You can define a date and time for the time range in Start date and End date. If you wish to export the data from a
specific period up to the end date you can enter the number of days in the corresponding input field. The start date is
then adjusted automatically:

Press Next to confirm your selection.

Click Finish to export the data.

The export file is saved to the selected directory.

5.17.2 Export and send data (E-service)

You can compile and automatically send configurations and measuring data with the E-service function. By default, the
recipient  of  this  e-mail  is  taken  from the  details  on  the  “Advanced  settings”  tab.  If  you  do  not  specify  a  recipient,  the
global e-mail recipient from the options is automatically used.

Configure the E-service function as follows:

First configure the e-mail settings in the Configuration Manager options .

If you would like to have different e-mail recipients for each system or device, you can specify them on the “Advanced
settings” tab:

Select a system or device in the Configuration Manager tree view and

enter an e-mail recipient on the “Advanced settings”  tab.
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Export data with the E-service function as follows:

Select a device or the entire system in the tree view and

Click E-service in the Service menu.

Use the Export Wizard  to compile the export data. The data are then automatically sent by e-mail.

You can end the Wizard at any time by clicking on the "Cancel" button.

5.17.3 Export and send data automatically

You can automatically export configurations and measuring data from any device in the CM database and send them by
e-mail using the Notify Link software. By default, the recipient of this e-mail is taken from the details on the “Advanced
settings” tab. If you do not specify a recipient, the global e-mail recipient from the Notify Link options is used.

You can configure the automatic data export as follows:

First configure the e-mail settings in the options  of the Notify Link and

enter a "global" e-mail recipient.

If you would like to have a different e-mail recipient for each device,

select a device in the Configuration Manager tree view,

call up the "Advanced settings"  tab, and

enter an e-mail recipient in E-mail settings.

Tick the checkbox next to Export and send measurement data in the "Automatic e-mails (via Notify Link)” section.

Specify the number of days and hours to export after.

You can restrict the data transferred to data from a specific number of days using the "But only datasets from the last
X day(s)" option. If the "Only not yet exported data" option is selected, data already sent at an earlier date/time will not
be transferred again.

If the Notify Link is in run mode, it checks the CM database in the configured time range and sends e-mails as soon as
there are any export data. The Administrator software does not need to be running.

5.17.4 Import data

Depending on the volume of data to be imported, this process may take some time. Do not
interrupt the import process in order to avoid inconsistencies in the database.

If  you  import  configurations  that  already  exist  in  the  database,  the  imported  configurations
overwrite the existing configurations , which are then flagged as changed.

You can import data in V5 format (Dtect X1s and ProCheck) as follows:

1. Click Import in the File menu, then Import file to call up the file selection window.

2. Specify the file (*.x5) you wish to import here.

3. Click Open.

The content of the file is integrated into the device and configuration structure.

You can import data in V4 format (Dtect X1) as follows:

How to import V4 files:

Import  the export  file  in  V4 format  (*.zip):  The content  of  the export  file  is  imported into  the current  database.  After
import,  the  Configuration  Manager  displays  an  import  report  indicating  the  number  of  imported  (first-time  imported)
and changed (already existing and overwritten) devices and configurations.

Import database: Reads the database and imports all data into the current CM database.

To import V4 data:

Click Import in the File menu.

To select an export file:

Click Import 4.0 file.

Select the file you want to import, then click Open.
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Or:

Click on Import 4.0 database.

Select the database as described in "Select database" .

You can import data in V3 format (Dtect X1) as follows:

If you wish to import data in Administrator software version 3.6 or 3.8 format you can import the individual files in *.x11
format, import a complete V3 database or import the V3 user administration data.

Click Import in the File menu.

Then select Import 3.x file or Import 3.x database and select the file, folder or database to import.

Click Open.

Import V3 user management data as follows:

Click Import users from version 3.x in the Extra menu.

Select Import users from version 3.x and select the file 'user_dat'. 

Click Import users.

Data from Administrator versions lower than version 3.6 cannot be imported.

You  can  only  import  Dtect  X1/Dtect  X1s  data  if  the  characteristic  values  were  saved  with
timestamps  (see  "Saving  options" ).  If  not,  you  can  activate  this  option  later:  load  the
configuration of the Dtect X1/Dtect X1s device, activate the save option "Save timestamp of
characteristic dataset" and send the modified configuration back to the device. You can then
import the data as usual.

Log file for data import

The Administrator software logs information about import processes in separate log files.

Click Show import logs in the File menu.

Provides an overview of all import processes. 

Using  the  import  filter  you  can  filter  processes  by  “All  logs",  "Successful  imports"  and  "Not  successful  imports".  The
following information is displayed:

Field name Meaning

Read Import message already read can be ticked. Press the "Mark all as read" button to select all messages. You
can automatically delete these messages when you close the import log.

Status The import status is displayed with the following icons:

 Import was successful, all data were imported.

34

121



137

Configuration Manager

Field name Meaning

 Import was successful, but not all data were imported or the timestamp of the data was changed.

 Import failed, no data were imported.

Version The Version field contains information about the Administrator software version of the imported data.

Start date The Start date field contains information about the day and time the import was started.

Details Click this icon to display further details about the import process.

Message The Message field contains information about the day and time and how long the import took.

Devices
(imported, ignored)

This field contains the number, name and serial number of the device data to import. It also displays the
number of devices imported and ignored.

Measuring data
(imported, ignored)

This field contains the number of measuring data to import. It also displays the number of measuring data
imported and ignored.

File Click this icon to display the import log file in a text editor.

5.18 ASCII export

The ASCII export only works with Dtect X1 data.

During  the  ASCII  export,  a  separate  file  is  generated  consisting  of  a  header  segment  and  a  data  segment  for  each
existing  data  type.  The  header  segment  contains  the  Administrator  version  number  and  measurement  configuration
data. The information is saved in the Windows INI file format. The measuring data is contained in the data segment. The
file  names  are  made  up  of  the  name  of  the  measuring  data  and  the  file  extension.  The  file  extensions  are  assigned
automatically according to data types. The file extensions and assignment to the corresponding data type are shown in
the table below.

File extension Data type

.X1AscActTime Time signal

.X1AscActFFT FFT

.X1AscAlarmFFT Alarm FFT

.X1AscCharacteristics Characteristic value data

.X1AscAlarms Alarm data

Manual export

Using manual export, only the monitoring configuration which is currently selected will be exported.

Select a monitoring configuration in the tree view.

Select the dataset to export in the “Data" window.

Click ASCII export in the Service menu.

Or:

Click on  in the toolbar.

Select the path to be used for the export of data sets in the "Select export directory" dialog box which subsequently
opens.

Click OK to close the dialog box.

The selected data sets are now exported using the path you selected.

5.19 Create reports
You can output detailed reports for monitoring configurations or alarm reports for devices in Configuration Manager. You
can configure additional settings for both types of report, e.g. graphics or the folder, in the Extras menu, Report .

Depending on the selection, the detail report for monitoring configurations contains information about device properties
and device settings, device and monitoring configurations, and measuring data.

The  alarm  report  for  devices  contains  information  about  the  status  of  the  components  monitored  by  a  device,  e.g.
vibration changes that have occurred since the last report, the status of the monitored components, and warnings about
sensor or transfer errors.
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Create detail report for a monitoring configuration

Proceed as follows to create a detail report:

Select the appropriate monitoring configuration.

Select the appropriate data on the Data tab.

Click Reports... > Detail report in the Service menu.

Or:

Click  on the toolbar and select Detail report.

Or:

Click on the measuring data pane on the right and select “Detail report” from the context menu.

ProCheck

Dtect X1s

Select the content of the report and click OK.

You can view the report on-screen or print  it  out in the Report  window. You can use the toolbar to control  the screen
display:

The  display  size  can  be  defined  in View.  Select  Percent  adjustable  to  enter  a  zoom  factor  expressed  as  a
percentage in the Percent input field.

You can navigate forwards or backwards through the report and also jump to the start or end of the report using the
arrow buttons.
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Click on  to print out the report.

Create alarm report for one or all devices

Before  you  can  create  an  alarm  report,  you  must  define  a  folder  in  the  Extras  >  Options  >
Report  menu.

How to create an alarm report:

Create alarm report for one device

Click the device in the device and configurations list.

Click Reports... > Alarm report in the Service menu.

Or:

Click  on the toolbar and select Alarm report.

Or:

Click on the measuring data pane on the right and select “Alarm report” from the context menu.

The alarm report is stored in the specified directory.

Create alarm report for all devices

Click on a device in the device and configurations list.

Click Reports... > Alarm report for all devices in the Service menu.

Or:

Click  on the toolbar and select Alarm report for all devices.

Or:

Click on the measuring data pane on the right and select “Alarm report for all devices” from the context menu.

All devices in the database are displayed. Click on the checkbox next to a device to select it for the alarm report. If you
only  want  devices  with  a  certain  name,  you  can  filter  the  list.  To  do  so,  enter  a  name  (e.g.  ProCheck)  and  tick  the
checkbox next to “Filter device names".

Select the devices and click OK.

The alarm report is stored in the specified directory.

To  create  an  alarm report  for  all  devices  of  a  planning  level,  highlight  the  planning  level  and
select Service > Reports... > Alarm report.

Open alarm report

The alarm reports are stored in HTML format in the selected folder. Each report  is  stored in a separate directory. The
directory name consists of the timestamp of report creation (e.g. "2010-02-10-16-42-25-387").

To open an alarm report,
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switch to the appropriate directory and

open the file "index.html".

The alarm report is displayed in your default browser.

If  no  browser  is  installed  on  your  system,  you  can  open  the  report  in  an  HTML-enabled  text
editor.

Edit alarm report

You can add information to an alarm report. To do so, open the alarm report in an HTML-enabled text editor and edit the
report accordingly.

5.20 Mail server messages
All information about e-mail sending is logged in Konfigurations-Manager, in Data Link and in Notify Link.

Click Show mail server results in the Service menu.

You can filter the messages by "All results", "Only sent results" and “Unsent results". If an e-mail was sent successfully,

a latter icon  is displayed; an exclamation mark  indicates an unsent e-mail. The send date, recipient and subject of
the e-mail are also displayed. In the event of an error, a detailed error message is displayed.

If  there  are  any e-mails  in  “Unsent  results”  that  could  not  be  sent,  for  example  because  the  e-mail  settings  were  not
correct, you can automatically correct and resend them.

Click Mail server maintenance> Send not sent e-mails again in the Service menu.

5.21 User management

About user management

You can use the Configuration Manager to create users and assign individual rights of use. The standard definition for a
user  is  "admin"  without  password  which  provides  the  user  with  unrestricted  access  and  use  of  all  functions  of  the
Administrator software. The "guest" (guest) user has only restricted permissions, but does not have a password either.
You can use the user management to set up as many users as you require and assign individual access rights to these
users which means that they will only be able to access functions that are relevant to them.

In  the  device  factory  settings  no  password  is  assigned  to  the  "admin"  user.  To  prevent
unauthorized access to software and data you should assign a password for  this  user  without
delay. For further information about switching users, see here .

You can start the user management as follows:

Click on User management in the Tools menu.
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The user management window is split into two sections.

The administration of users is carried out in the upper section where you can select, create, modify and delete users
and assign passwords, providing the user in question has been assigned the corresponding rights.

The rights of the user selected can be restricted or activated in the bottom section of the window, as required.

The following three buttons are positioned next to the user selection box:

Button Meaning

Opens a dialog box where you can enter a new user name.

Allows you to change the user name.

Deletes the user and corresponding rights.

5.21.1 Create/modify user

Make sure that  at  least  one user  has administrator  rights  as otherwise you run the risk  of  not
being  able  to  access  the  user  management!  If  this  does  happen,  please  get  in  touch  with
Support (see "contact ").

Create a user

Click on .

Enter the user name in the dialog box that appears and confirm this with "OK".

Assign a password for this user in "Password".

Confirm the password in Repeat password.

Continue with assign rights .

Rename user

Select a user from the list.
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Click on .

Edit the user name in the dialog box that appears and click "OK“ to confirm.

Delete user

Select a user from the list.

Click on .

Click OK to confirm.

5.21.2 Assign rights

The  rights  for  each  user  can  be  assigned  simply  by  marking  the  corresponding  form  fields.  The  following  overview
provides you with information on the available rights and their corresponding meanings:

Editing/change rights

Name Meaning

Configurations Enables a user to change existing configurations.

Alarms Enables the user to reset alarms.

User rights Enables a user to change the user rights.

Measuring data comments The user can edit comments for the measuring data.

Database connections Enables the user to edit existing databases.

Delete rights

Name Meaning

Configurations If this right is activated a user can delete existing configurations.

Alarm data Enables the user to delete alarm data from the alarm list via the options menu.

Users Enables a user to delete users.

Measuring data Enables the user to delete measuring data.

Rights to start services

Name Meaning

Manual service If this option is activated the user can connect to the Dtect X1s device on his own and download
data, for example.

Remote service Enables the user to start and stop the Remote Server.

Database administration

Create rights

Name Meaning

Configurations If this right is activated a user can create new configurations.

Users Enables a user to create and change users.

Import/export rights

Name Meaning

Export If this right is activated the user can export data from databases.

Import Enables a user to import data into an existing database.

E-service Enables the user to send data by e-mail.

5.22 Bearing database
The bearing database provides you with data on the most widely used bearings for use in your individual configuration.

You can also add your own bearings  to the existing bearing data. Furthermore, the bearing database also includes
a  group  administration  feature  which  you  can  use,  for  example,  to  group  bearings  of  different  makes  that  have
similar characteristics.

Click Tools > Bearing database to open the bearing database.

Select  the  database  as  described  in  "Select  database" .  The  name  of  the  included  bearing  database  is
"cm_bearings".  If  you  installed  it  during  software  installation,  it  is  automatically  opened  when  you  call  the  bearing
database function for the first time. The program uses the default user name and the default password.

Opens the bearing database.
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5.22.1 Search bearing

To find a bearing click on Search bearing in the bearing database.

Click on  to display all bearings.

To restrict the search you can specify the manufacturer and/or group.

You  can  also  further  restrict  the  search  to  specific  bearing  designations  in  Search  criterion  using  the  standard
wildcards "?" and "*", e.g.:

o "*1200*" to find all bearing names containing 1200 or

o "?200*" to find all bearings whose name includes the text "200" at position 2-4.

The list of hits is displayed in Search result.

5.22.2 Add bearing

To add a bearing to the bearing database click on Add bearing.

Select a manufacturer from the list.

Enter a name for the bearing in the Label field.

Detailed comments may be entered in the Comment field (optional).

Geometry data or kinematic frequencies

Use the Geometry and Frequencies options to switch between the input fields in the right-hand area of the window in
order to enter corresponding data. When inputting the contact angle select either degrees or radians for units. When
specifying the frequencies enter whether these should be in Hz or rpm.
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The bearing database indicates whether any information still needs to be input in the bottom right-
hand  area  of  the  window.  The  bearing  can  be  added  to  the  database  only  if  all  inputs  are
completed.

Click on Continue to store the bearing in the bearing database.

5.22.3 Edit / delete bearings

Editing bearings

Click on Edit bearing and start by searching for the corresponding bearing as described at Search bearing .143
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The list of bearings found is displayed in the Search results as well as the number of hits.

Select the bearing to be modified and click on Continue.

Enter the data for the required bearing as described under Add bearing .

Click Continue.

Click  on  to  open  the  Manufacturer  details  window.  You  can  find  the  contact  details  for  the
manufacturer here.

Deleting a bearing

Perform your search as described above . Then select the desired bearing for deletion from the Search results.

Click on Delete  bearing to remove the bearing from the database.

You  can  only  delete  bearings  that  you  have  entered  yourself!  Once  all  the  bearings  for  a
particular manufacturer have been deleted you can also delete the manufacturer .

5.22.4 Export bearings/import bearings

Exporting bearings

Click on Export bearing and search for the bearing you would like to edit as described in Edit/delete bearings .

You  can  use  the  Export  self-created  bearings  only  option  to  restrict  the  export  to  bearings  you  yourself  have
entered.

Click   and  select  the  path  and  file  name.  By  default,  the  program  uses  a  file  name  with  the  following  pattern:
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FAGBearingDB_export_<year>_<month>_<day>.zip. Alternatively, you can use your own file name.

Importing bearings

Click on Import bearings, then on .

Select the import file.

Select whether to import with confirmation for a bearings and/or manufacturers.

Click Next to start the import.

5.22.5 Manage groups

You can use the manage group feature to classify bearings with similar characteristics, regardless of their manufacturer.

Click on Manage groups to call up the bearing database group administration feature.

Create a new group

To create a new group click on .
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Enter a name for the new group and click OK.

Assign bearings to a group

To assign one or more bearings to a group proceed as follows:

Select the desired group from the Group list.

Search  for  one  or  several  bearings  as  described  in  "Search  bearing" .  The  bearings  found  are  displayed  in  the
Unassigned  bearings list.

To assign a bearing to the group click on it then click on . The bearing should now be displayed in the Assigned
bearings list.

To  assign  all  bearings  found  to  the  group,  click  on  .  All  bearings  should  now  be  displayed  in  the  Assigned
bearings list.

To delete a bearing from the group click on the bearing in the Assigned bearings list then click on .

To delete all bearings from the group, click on .

Click on Save assign the bearings to the group in the bearing database.

Rename a group

To rename a group, select it from the Group list and click on .

Enter a new name for the group and click on OK.

Delete a group

To delete a group, select it from the Group list and click on .

Warning! the group is deleted immediately -  you will  not  be prompted to  confirm this!  You should
therefore only use these functions if you are sure that you want to delete a group.

5.22.6 Add manufacturer

Click on Add manufacturer to create a new manufacturer.

Enter the manufacturer's data in the appropriate input fields and click on Next.

Check your input in the next window that appears. If  the input is correct,  click Add  to  save the manufacturer  in  the
bearing database or click Back to modify your input.

5.22.7 Edit / delete manufacturers

Edit manufacturer

Click on Edit manufacturer to modify the data for a manufacturer.

Modify the manufacturer data and click on Next.

In the next window the Trendline shows your changes and the original  data for an easy compare. Click on Save  to
store your changes in the bearing database or click on Back to change your data.

Delete manufacturer

If you have deleted all bearings from a manufacturer from the bearing database (see "Edit/delete bearings" ), you can
also remove the manufacturer.

Click Delete manufacturer.

Then select the manufacture from the Manufacturer list and click Continue.

The manufacturer is then deleted from the bearing database.

You can only delete manufacturers which have been added  by yourself!
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5.22.8 Select different bearing database

Click on Change database.

Select  the  database  as  described  in  "Select  database" .  The  name  of  the  included  bearing  database  is
"cm_bearings".

Opens the bearing database.

5.22.9 Close

To close the bearing database, click Close.

5.23 Program settings

You can open the general program settings configuration window via the Tools > Options menu item.

To change the settings the user currently logged in must have the required access rights (see
"User management ").

A tree  view is  displayed  on  the  left-hand  side  of  the  window and  shows  a  range  of  configuration  options  arranged  in
groups. You can expand the view and configuration options by clicking the symbols in front of the groups.

Information on the individual configuration options is provided or input masks are displayed on the right-hand side of the
window.

Contact

Our address, telephone and fax number as well as our e-mail and Internet address are provided here.

5.23.1 General

Click OK to complete program settings and apply the changes.

Language

The Administrator  software can be displayed in  German,  English and Chinese.  If  you  select  a  different  language,  the
software restarts automatically. 

34
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You may  only  use  ANSI  characters  of  the  Latin-1  codepage  for  entries  that  are  stored  in  the
database.  This  includes,  for  example,  device  and  configuration  names,  characteristic  value
names, channels and the like.

Miscellaneous

Tree settings

Show tree item count

Activate this counter to display the number of subentries in brackets after each level in the tree. This allows
you to see how many active configurations are below a particular device, for example.

Always show outdated configurations

If you change the device or monitoring configuration of a device, the corresponding data stored in the CM
database is no longer comparable. Therefore, the configurations are marked as outdated, i.e. the data is
removed from the tree view Devices and configurations but not deleted from the database.
Activate the option Always show outdated configurations to always see these configurations in the tree
view. Note that this also increases program loading time.

Show maximum alarm status of the data in the tree

By default, the maximum alarm state is always displayed in the tree view. The alarm must always be reset

manually, i.e. by clicking the  button. However, if you do not (cannot) perform an evaluation of your local
database, for example, this may cause all configurations to display a main alarm.
You can deactivate the option Show maximum alarm state in the tree. Then the tree view always shows
the current alarm state.

The tree view context  menu contains  the option Show outdated configurations.  This  also
allows you to display outdated configurations again.

If you have changed settings in the tree view, they are not automatically visible. Refresh the
tree to see the changes.

Preview settings

Configure the rotational speed range in % for the trend preview here.

Activate automatic user login

Whenever you start the software, the program prompts you for your user name and password. You can skip this step by
configuring an auto-login for automatic user login. 

Select a user to log in automatically and enter the password. 

Click on the check mark  to check the user data.

Next time you launch the software, you will be automatically logged in with the configured user data.
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5.23.2 Database

You can configure the database history and display information about the selected database here. You can also delete
entries from the alarm list.

History

If this option is selected a list of all databases opened to date is displayed on the right. The entries in this list are the one
used to open databases from the File > Open database menu. You can also use this option to delete entries in this list
for clarity of overview.

To delete an alarm list entry:

Select one or (by holding the CTRL key down) multiple items from the list and

press the Delete item button to start the deletion operation.

Miscellaneous

Database information

The following information about the CM database being used is displayed:

Name of the database server

Name of the database

Used memory

Free memory

The ratio of free to used memory is also presented as a diagram.

The free memory display and the diagram can only return plausible information if the database
and database server are on the same system.

Miscellaneous settings

Number of connection attempts:

Number of attempts by the program to connect to the database after start-up.
Notify timer (min):

Interval at which Notify Link checks whether it needs to send data. It is in standby mode between intervals. This
reduces the database load.

Call control verification interval (min):

Interval at which call control checks whether data have arrived. It is in standby mode between intervals. This reduces
the database load.

Dataset load limit:

Maximum number of datasets loaded in the data grid. The limit reduces the database load.
Delete entries from alarm list

Using this function you can delete entries from the alarm list in order to make this alarm list more concise.

Warning! If you delete entries from the alarm list they are removed permanently and can not be
restored!

Proceed as follows to delete items from the alarm list:
o Click Select date / time range and select the period in the new window. 

o Click OK to confirm deletion.
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5.23.3 Report

You can configure basic settings for detailed reports and alarm reports here.

Report images (detail report and alarm report)

You can configure the following here:

a company logo for the header (width-to-height ratio 4:1)

an image for the cover page (max. 460 x 490 pixels) 

Alarm report settings

You can configure the following here:

Report folder: Defines the folder for storing alarm reports.

Information for the report header: You can enter additional information to display in the report header here.

HTML preview: Click here to display a preview of the alarm report with your settings in the browser.

Edit report settings

To define or edit a graphic or the folder for reports, 

click  and select the directory.

To delete settings, 

click on .

5.23.4 Send e-mail

The automatic export of data via e-mail is configured and activated in this window. 

Configure e-mailing

You can configure the dispatch of e-mails as follows:

Click Options in the Extras menu.

Select Send e-mail.

Click Configure.

The “Configure” button opens the “E-mail options settings” dialog box where you can select and configure the method
used to send e-mails.

Please enter a valid e-mail address in the input box labelled “From” as the mail account to use for sending.

The e-mail address of the recipient is entered in the "To" input field.



152

Please enter the number of your service contract at "Contract number", if applicable.

You can also enter a custom text "Comment" input box to append to the e-mails created.

Click Configure to set the protocol for the program to send e-mails.

Configure e-mailing

The program supports sending e-mails via Microsoft  Outlook,  MAPI  or  SMTP.  To obtain  the correct  settings consult
your network administrator.

Select the transfer method.

If you are using the SMTP protocol, you must enter either the name or IP address of the e-mail server in “host”.
Optionally  you  can  enter  a  user  name  and  password  for  SMTP  authentication.  If  you  are  using  the  TLS
encryption protocol (SMTP via SSL), you must also configure the TLS port. In "Timeout" you can define a time
range after which to automatically stop trying to make a connection.

To test the connection to the mail server, click Test connection.

Click OK to save the settings.

The Administrator software uses the separate E-MailRelay tool  for SSL encryption. You can
find this tool on the program CD.

If you want to use SSL encryption, you must enter the host of the E-MailRelay tool in SMTP. For
details refer to the section Configure e-mailing in the Administrator software .

5.23.5 Configure alarm limits

Enter the default values for the automatic adjustment of alarm limits  here.

Enter minimum/maximum values

Click the relevant tab to enter the minimum and maximum values for the available characteristic values.

Enter the desired values.
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Enter exclusion values

The maximum limits can be specified in the Exclude alarm values window. Characteristic values above or below these
limits will subsequently not be taken into account.
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Click Exclude alarm values.

Enter the desired values in percent or in dB.

5.23.6 Bearing related characteristic values

In this dialog you can configure the defaults for bearing-related characteristic values. If you edit or create a bearing, you
can automatically apply the defaults configured here (see “Generate bearing-related characteristic values" ).

Click on the Dtect X1s tab or ProCheck to select the device.

Activate the kinematic frequencies you wish to monitor.

Configure how many harmonics to include in the monitoring.

The following kinematic frequencies are available:

· Inner race ball pass frequency (BPFI)

· Outer race ball pass frequency (BPFO)

· Roller rotation frequency (BSF)

· 2 x Roller rotation frequency (BSF)

· Fundamental train rotation frequency (FTF)

5.24 Exit

Click File > Exit to close the program.

107
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6 The FAG Viewer

6.1 About this software
The FAG Viewer software displays the signals and characteristic values provided by the FAG hardware. 

Time signals

Fast Fourier Transformations (FFTs)
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Trend data

With the aid of the various navigation and cursor tools of the Viewer software you can change the display of the data
and perform an error analysis . The aim of the analysis is to identify possible damage as exactly as possible so as to
be able to perform repairs in good time and thus avoid downtimes.

The  following  chapter  explains  the  work  interface .  It  goes  on  to  provide  more  information  about  working  with  the
Viewer software .

6.2 The work interface

6.2.1 Work interface areas

The toolbar  contains various tools which can be used to arrange the diagrams and display/remove the tool area
and  diagram  information  bar  as  well  as  other  tools  which  can  be  used  to  export  measurement  data,  display  the
corresponding configuration for the data set selected and create a measurement report.

You will find a range of navigation tools in the tools  working area which can be used to modify the way in which
the diagrams are presented and also find a number of different cursor tools for carrying out fault analyses. The choice
of tools which can be used varies according to the type of diagrams displayed (FFTs, time signals or trend data).

The main area of the work interface contains the diagram  and the cursor and measuring information area, in
which the corresponding values for the selected cursor are displayed. 

You  will  find  additional  information  in  the  diagram  information  bar  area  (on  measurement  data  for  example)
depending on the diagram type displayed. You can use the tools in this working area to do the following:

o enter comments into the diagram

o select frequency bands with FFTs in order to determine characteristic values for the fault analysis

o determine the maximum, harmonic or sideband values from the diagram depending on the cursor type

The diagram information bar area for each diagram can be displayed or hidden as required and can be used to zoom in
on the diagram area.

198
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Areas of the Viewer software

6.2.2 Toolbar

You can use the Tile windows horizontally button to arrange open windows vertically above one another in the working area of the Viewer
software.

You can use the Cascade windows button to arrange open windows so they overlap in the working area of the Viewer software. 

You can use the Full screen display of current diagram button to fill the entire screen of the Viewer working area with the current diagram
selected. 

You can use the Arrange minimized windows button to arrange minimized windows horizontally from left to right in the working area of the
Viewer software. 

If the Arrange diagrams automatically button is activated the size of the diagram always adjusts automatically to fit the available working
area (when the tool area is displayed or removed, for example). 

You can view a list of the windows that are currently open and make your selection using the Show list of all diagrams button. The selected
diagrams are arranged horizontally and the rest of the diagrams are minimized. 

You can use the Show toolbar button to display/hide the tool bar in the working interface of the Viewer software. 

You can display/remove the information bars of all open diagrams using the Show diagrams information bars. 

You can open a list of the windows that are currently open using the Paste selected diagrams to clipboard button. From this list you can also
select whether the accompanying information text should be copied together with the diagram and define the size of the diagram. The
diagrams selected are copied together to the clipboard as one graphic object. 

You can use the Show time signals button to only show the time signal windows. All other windows will be minimized.

You can use the Show FFTs to only show the FFT windows. All other windows will be minimized.

You can use the Show alarm FFTs to only show the FFT alarm windows. All other windows will be minimized.
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You can click the Show trend data button to limit the diagram view to the trend data window. All other windows will be minimized.

The Show load diagrams button opens the complete view of the distribution diagram. All other windows will be minimized.

You can click the Show collective data button to limit the diagram view to the collective data.

The Show all diagrams button maximizes all diagram windows.

Press the Search harmonics/sidebands button to find harmonic frequencies and sidebands.

Press the Add bearing to add a bearing from the bearing database to the current spectrum.

The ASCII export button starts the ASCII export of the selected data.

The Report button generates a report for the selected data.

6.2.3 Tools

The tools area contains a range of adjustments which you can use to set the display area for the diagrams. A range of
different individually tailored tools is available depending on the type of data set displayed (time signals, FFT or trend
data). These tools can be used for example to do the following:

display/remove signals within a series of signals when working with trend data,

modify the scale of measuring ranges,

integrate the velocity and displacement from the acceleration,

modify the display of the measuring range to suit your individual requirements and

navigate through a diagram easily using the navigation overview.

List of the tools available in conjunction with the corresponding diagram type

Tool Time signal FFT Trend data

Automatic scale

Manual scaling

Logarithmic display of axes

Integration of y-axis

Free zoom

Horizontal zoom

Vertical zoom

Keyboard zoom

Displaying the median

Calculate Cepstrum

Base cursor

Measure cursor

Difference cursor

RMS/AMV cursor

Harmonics cursor

Sideband cursor

HS cursor

Revolutions cursor

Positioning of base cursor

Modify cursor properties

Copy to clipboard

Modifying coordinates of axes
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Tool Time signal FFT Trend data

Signal distribution

Trend filtering

Zoom tools

In order to optimize the display you can enlarge any part of the diagram using the various zoom tools. You can use one
of the predefined zoom tools for this or define the zoom area numerically via a dialogue window.

Zoom tools

Tool & symbol Description

Free zoom You can use the Free zoom tool to enlarge any given rectangular area on the x- and y-axis within a diagram.

Horizontal zoom You can enlarge any part of a diagram in a horizontal direction using the Horizontal zoom tool. The range of
values and scaling of the y-axis remain unchanged.

Vertical zoom You can enlarge an area inside a diagram in a vertical direction using the Vertical zoom tool. The range of
values and scaling of the x-axis remain unchanged.

Keyboard zoom You can use the Keyboard zoom feature to enlarge an area of the diagram using the keyboard instead of the
mouse.

Specifying zoom selection in dialogue window

In addition to using the various zoom tools you can also specify the zoom selection via a dialogue window. To open the
dialogue window which is currently active click on the zoom tool symbol. 

Cursor tools

You can specify the values from a diagram to be used for an analysis with the cursor tools. Depending on the type of
diagram which  has  been  opened appropriate  cursor  tools  are  made  available  which  can  be  used  to  obtain  individual
measuring and characteristic values directly from the diagram.
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Information on the current cursor is displayed above the diagram. You can show/hide these value fields and the cursor
by clicking on the cursor tool symbol that is currently active.

Tool & symbol Description

Base cursor

(FFT, time signals, Trend data)  
You can use the base cursor to determine the measuring values on the x- and y-axis of a measuring point. 

Measure cursor

(Time signals)

The Measure cursor is used to calculate the differences, the effective value (root mean square) and the
arithmetic mean value of two measuring values and the minimum/maximum value.

Difference cursor

(FFT, time signals, Trend data)  
You can use the difference cursor to calculate the difference between two measuring values. 

RMS/AMV cursor

(FFT, time signals)  
You can calculate the effective value (root mean square) and the arithmetic mean between two measuring
points using the RMS/AMV cursor.

Harmonics cursor

(FFT)  
You can use the harmonics cursor to determine measuring values at points in the diagram where
harmonics (multiples of the basic frequency) are likely to occur.

Sideband cursor

(FFT)  
You can use the sideband cursor to determine additional measuring values in definable sidebands starting
from the base cursor.

HS cursor

(FFT)  
The HS cursor (Harmonic with Sidebands) combines both cursor types described above which means that
both the harmonics and their sidebands will be displayed.

Revolutions cursor

(FFT, time signals)  
The revolutions cursor marks the frequency that is assigned to a specific speed with a line. 

A cursor  can only  be placed at  a  measuring point  that  exists.  If  you  click  on  a  position  in  the
diagram where no measuring value exists the cursor automatically jumps to the nearest existing
measuring point.

Additional tools

In addition to the zoom and cursor tools you can use a range of further tools to change the manner in which signals or
cursors are displayed and transfer data to other programs via the clipboard.

Tool & symbol Description

Positioning of 
base cursor

Places the base cursor at a point in the diagram specified via numeric input. The base cursor jumps to
the measuring point nearest to the value entered.

Cursor properties Opens the cursor properties dialogue window where you can change the properties of the cursor
currently used.

Clipboard Copies an image of the current diagram view into the clipboard (additional information ).

Change diagram boundaries Changes the display of minimum/maximum values for the x- and y-axis (additional information ). 

179
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Tool & symbol Description

Edit rotational speed Changes the rotational speed information in an FFT or time signal (Further information ). 

Display signal distribution Displays the distribution of one or multiple signals in relation to another signal (further information ).

Trend filtering Displays the trend progression of one or multiple signals depending on the filter criteria of one or both
validators (further information ). 

6.2.4 Diagram display

The diagram area shows the FFT, time signals and trend data diagrams. You can specify the desired zoom area inside
the diagrams and adjust the position of the cursor using the mouse or keyboard.

6.2.5 Cursor and measuring information

The cursor information for the Viewer software shows important values and measurement data that vary depending on
the cursor tool used. Each item of cursor information contains either the value pairs for a measured value or calculated
characteristic values that are obtained by combining different cursors within the diagram such as the difference cursor or
RMS/AMV cursor. The cursor information can be displayed or removed for each diagram with Ctrl+U.

The  measuring  information  of  the  Viewer  software  displays  important  measurement  data  about  the  active  signal,
dependent on the specific diagram type (e.g. measuring time, channel number, signal type and additional channels; in
addition, for FFTs and time signal, the current rotational speed and rotational frequency). The measuring information is
visible in the diagram and can be displayed or hidden with CTRL+U.

The table below shows the corresponding values displayed in the cursor information for the currently active cursor type:

Cursor type Displayed cursor information

Base 
cursor

Measure 
cursor

Difference 
cursor

RMS/AMV 
cursor

Harmonic 
cursor

Sideband 
cursor

HS cursor

Revolutions 
cursor

6.2.6 The diagram information bar

You can find the diagram information bar in the right-hand column of the working area. This column contains additional
information on the diagram currently selected and can be displayed or hidden as required.

The  table  below provides  an  overview of  the  corresponding  information  displayed  with  the  active  cursor  type  for  FFT
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diagrams in the diagram information bar:

Information displayed in the
diagram information bar

Base cursor
Difference

cursor
RMS/AMV cursor

Harmonics
cursor

Diagram information

Comments

Frequency bands

Highest peaks

Harmonics

Sidebands    

Kinematic frequencies

Information displayed in the
diagram information bar

Sideband cursor HS cursor
Revolutions

cursor

Diagram information

Comments

Frequency bands

Highest peaks

Harmonics

Sidebands

Kinematic frequencies

The measure cursor displays the same information as the difference and RMS/AMV cursor plus Min/Max.

Diagram information and comments  for  time signals  and trend diagrams are displayed in  the diagram information bar
irrespective  of  the  cursor  type  selected.  Further  information  on  the  alarm  values  of  the  data  set  currently  open  is
displayed in the trend diagrams. 

Diagram information

This field contains general information about the measurement data including 

Information on the measuring procedure such as the lowpass or sampling frequency settings

Further information included in the data sets.

6.3 Working with the FAG Viewer software

6.3.1 Displaying several diagrams simultaneously

You  can  open  several  diagrams  in  the  FAG  Viewer  software  simultaneously  and  arrange  these  in  the  working  area
according to your needs. 

Select  one  of  the  following  options  from  the  Diagrams  menu:  Tile  horizontally,  Cascade,  Full  screen,  Arrange
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minimized windows or List….

The windows are rearranged accordingly.

6.3.2 Modifying the appearance of a diagram

Displaying and removing signals

When  a  new  data  set  is  opened  the  Viewer  software  simultaneously  displays  all  signals  contained  in  the  data.  The
series  of  measurements  included  in  the  current  dataset  are  listed  in  the  Signal  selection  field.  For  each  signal  the
program displays a checkbox, the colour of the measuring points and the name of the signal. For a more detailed view,
you can click  to  select  or  deselect  checkboxes to  enable or  disable individual  signals  in  the detailed list.  Note that  at
least one signal must always be activated. The field marked by the yellow triangle is the active cursor signal, on which
the current cursor is set.

Signal display elements

A trend diagram loaded in the Viewer software can contain multiple signals (characteristic values and validators). For a
clearer display of the diagram you can enable and disable individual signals in the list. 

Time  signals  always  contain  a  single  signal  that  you  cannot  hide.  You  can  display  more  than  one  signal  in  the  FFT
diagram. The options "Show alarms" and "Averaging", however, are only available in Trend.

1. Click on the checkbox in front of the signal.

This signal will be displayed or removed.
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Axis settings

Automatic scale

The Automatic scale option sets the scaling of the diagram axes to the next 1000 scale (10³). Based on the base unit of
the  diagram  for  measuring  values  < 1  this  automatically  selects  the  next  smaller  unit  (e.g.  g ¦ mg  or  m ¦ mm)  and,
inversely, for values > 1000 the next greater unit (e.g. ms ¦ s or Hz ¦ kHz).

1. Click the "Auto" checkbox to activate it.

The scaling of the diagram will be adjusted automatically.

Manual scaling of axes

If  you  disable  the  Automatic  scale  option,  you  can  select  one  of  the  preset,  equivalent  units  for  axis  scaling.  The
available scaling units depend on the type of diagram (e.g. Hz or kHz with FFTs for frequencies, g, mg, m/s² or mm/s²
for acceleration values, "orders" for order spectrums, rotations for angular signals, s or ms for time signals, etc.).  The
scaling for the axes can be set independently of one another, i.e. you can specify any desired unit for the x- and y-axes
individually.

1. Click the "Auto" checkbox to deactivate it.

2. Select one of the units provided in the X unit field.

3. Select one of the units provided in the Y unit field.

The axes are scaled independently of one another and can be modified according to the settings that are selected.

Logarithmic scaling of the y-axis

It  may  be  possible  under  certain  conditions  to  present  signals  more  clearly  using  a  logarithmic  scale  if  they  do  not
contain zero values or negative values. You can therefore switch over to logarithmic scaling in the diagram.

1. Click on the Log checkbox to activate the logarithmic scaling of the y-axis.

The scaling of the diagram will be modified according to the settings selected.

This  option  is  deactivated  if  the  measuring  data  cannot  be  presented  logarithmically  (if  it
contains values smaller than or equal to zero, for example).

Displaying y-axis integrations

You have a number of display options for the integration of signals in FFT diagrams that contain an acceleration signal,
for example: 

No integration: Acceleration

Velocity

Displacement

1. In the Integration field, select the Acceleration option to not integrate the signal.

2. In the Integration field, select the Velocity option to display the first integration of the signal.

3. In the Integration field, select the Path option to display the second integration of the signal.

The scaling and display of the diagram will be modified based on the selected settings.

Once you have selected the integration option for the y-axis you can also modify the scaling
of  the  axes  here  (automatic,  manual  or  logarithmic)  and  display  any  desired  part  of  the
diagram using the zoom tools.

No integration is possible in order spectrums.

Displaying the median

You can display the median in FFT diagrams. Click Median in the Edit menu. The median is displayed as a yellow line:
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6.3.3 Using the mouse to control the cursor or zoom function

General

You can position the various cursors by left-clicking the mouse.

You can adjust the zoom selection setting by right-clicking the mouse.

You can use the mouse wheel to zoom and scroll in a diagram.

Mouse control

Zooming with the mouse wheel

If  you  have  a  computer  mouse  with  a  mouse  wheel,  you  can  use  it  to  zoom in  and  out  of  diagrams.  The  zoom  area
changes in steps of 10%.

Click on the diagram whose zoom area you wish to change.

Scroll the mouse wheel away from you to zoom in on the diagram.

Or:

Scroll the mouse wheel towards you to zoom out of the diagram.

Scrolling the zoom area with the mouse wheel

Click the mouse wheel in a zoomed area and hold it down

while moving the mouse left or right.

Using the mouse to highlight a zoom area

Select one of the zoom tools  from the selection list.

Mark a zoom area in the diagram using the right-hand mouse button.

Your selection is displayed in the diagram.

166
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Resetting the zoom

Right-click on the diagram if you wish to return to the previous zoom selection.

Or:

If you wish to return to the full view of the diagram hold the Shift button down and right-click on the diagram

Copying a zoom area to other diagrams (synchronous zooming)

You can automatically copy the zoom area of one diagram to all diagrams of the same type and base unit. Proceed as
follows:

If you have multiple records open in the Viewer software,

select the Zoom tool  and

click on the diagram type whose zoom area you wish to change.

Press the Alt key and use the right mouse button to drag out the area.

The zoom area of all other diagrams of the same type and base unit are modified.

Resetting synchronous zooming

Hold down the Alt key and then right-click on the diagram to return to the previous zoom area.

Or:

To reset all diagrams modified with synchronous zooming, press CTRL+Alt+Space.

6.3.4 Zoom tools

1. Select one of the zoom tools from the selection list.

2. Mark a zoom area in the diagram using the right-hand mouse button.

Your selection is displayed in the diagram.

3. Right-click on the diagram if you wish to return to the previous zoom selection.

4. If you wish to return to the full view of the diagram hold the Shift button down and right-click on the diagram.

Free zoom

You can use the Free zoom tool to enlarge any chosen rectangular area within a diagram:

1. Select the Free zoom tool from the zoom tool selection list using the mouse or press the F9 button.

2. While  holding  down  the  right-hand  mouse  button,  drag  the  mouse  across  the  section  of  the  diagram  you  wish  to
enlarge.

The zoom selection is now marked dark blue in the diagram.

3. Release the right-hand mouse button.

Your highlighted zoom selection is displayed in the diagram.

4. Right-click once again on the diagram if you wish to return to the previous zoom selection.

or 

5. To return to the full view of the diagram hold the Shift button down and right-click on the diagram.
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Horizontal zoom

You can enlarge any part of a diagram in a horizontal direction using the Horizontal zoom tool. The range of values and
scaling of the y-axis remain unchanged:

1. Select the Horizontal zoom tool from the zoom tool selection list using the mouse or press the F10 button.

2. Keeping the right-hand mouse button pressed down, drag the mouse across the horizontal section of the diagram you
wish to enlarge.

The zoom selection is now marked dark blue in the diagram.

3. Release the right-hand mouse button.

Your highlighted zoom selection is displayed in the diagram.

4. Right-click once again on the diagram if you wish to return to the previous zoom selection.

or 

5. To return to the full view of the diagram hold the Shift button down and right-click on the diagram.

Vertical zoom

You can enlarge an area inside a diagram in a vertical direction using the Vertical zoom tool. The range of values and
scaling of the x-axis remain unchanged:

1. Select the Vertical zoom tool from the zoom tool selection list using the mouse or press the F11 button.

2. Keeping the right-hand mouse button pressed down, drag the mouse across the vertical section of the diagram you
wish to enlarge.

The zoom selection is now marked dark blue in the diagram.

3. Release the right-hand mouse button.

Your highlighted zoom selection is displayed in the diagram.

4. Right-click once again on the diagram if you wish to return to the previous zoom selection.
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or 

5. To return to the full view of the diagram hold the Shift button down and right-click on the diagram.

Keyboard zoom

You can use the keyboard zoom feature to enlarge an area of the diagram using the keyboard instead of the mouse.

1. Select the Keyboard zoom tool from the zoom tool selection list using the mouse or press the F12 button.

2. Use the Ctrl+Q and Ctrl+W buttons to shift the start of the zoom selection.

3. Use the Ctrl+A and Ctrl+S buttons to shift the end of the zoom selection.

4. Use the Ctrl+Y and Ctrl+X buttons to shift the highlighted zoom selection to the right or the left.

5. You can enlarge a section of the diagram by pressing Ctrl+Enter (zoom in).

6. You can reduce a section of the diagram by pressing Ctrl+Backspace (zoom out).

7. You can return to the full view of the diagram by pressing Ctrl+space bar.

Defining the zoom selection by inputting values

1. Click the left-hand mouse button on the current zoom tool.

The zoom selection dialogue window opens and shows the current settings for the boundary values.

2. Enter a minimum and maximum for the X axis in the appropriate field.

3. Then enter a minimum and maximum for the Y axis in the appropriate field.

4. Click OK.

The diagram displays your defined zoom selection.

Click on Reset if you want to reset your settings.

6.3.5 Cursor tools

A  cursor  can  be  positioned  in  the  diagram  by  clicking  near  a  measuring  value  or  moved  by
dragging  the  dotted  vertical  line  along  the  diagram  axis  keeping  the  mouse  button  pressed
down. 
Sliding  cursors  are  always  represented  by  a  dotted  vertical  line  whereas  fixed  cursors  or
automatically calculated data displays are represented by a continuous vertical line.

Base cursor

You can use the base cursor to determine the measuring values on the x- and y-axis of a measuring point. 

To do this, place a base cursor at any desired measuring point in the diagram. The corresponding measuring
values are displayed in the cursor information.
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1. Select the base cursor option from the cursor selection list or press the F2 button.

2. Position the base cursor by left-clicking the mouse near a measuring point in the diagram. 

The  base  cursor  jumps  to  the  nearest  measuring  point  in  the  diagram.  The  current  position  in  the  diagram  is
represented  by  a  vertical  dotted  line.  The  measuring  values  for  this  measuring  point  are  displayed  in  the  cursor
information above the diagram.

Measure cursor

The Measure cursor is used to calculate the difference, the effective value (root mean square) and the
arithmetic mean value (AMV) of two measuring values in the time signal digram. Min/Max display the
minimum and maximum measuring values within the selected range.

To do this, place the base cursor and an additional measure cursor at the desired measuring point in the
diagram. The distance between the cursors is indicated by a coloured bar directly above the X-axis. The two
cursor measuring values and the resulting differences, min/max and RMS/AMV values are displayed in the
cursor information.

1. Select the Measure cursor option from the cursor selection list or press the F3 button.

The base cursor and the measure cursor are displayed in the diagram; these are connected by a coloured bar that
runs along and slightly above the X-axis.

2. You can place the base cursor at any desired measuring point in the diagram by left-clicking.

3. You  can  position  the  measure  cursor  at  any desired  measuring  point  in  the  diagram  by  left-clicking  while  holding
down the shift key.

The  measuring  values  of  the  base  cursor,  the  measure  cursor  and  the  difference  delta  with  frequency,  minimum/
maximum  values  and  the  arithmetic  and  RMS  mean  value  for  the  specified  range  are  displayed  in  the  cursor
information above the diagram
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Calculate spectrum

If you select the measure cursor in the time signal, another preview is displayed on the toolbar. The spectrum from the
time signal is shown and refreshed in real time in “FFT preview”. You can create a spectrum based on the time signal or
a spectrum based on defined values of the time signal.

Spectrum from time signal

1. Select the measuring range as described above.

2. Double-click on the FFT preview.

The spectrogram is displayed in the “Calculated FFT" diagram. 

Spectrum based on time signal values

1. In the Edit menu, click on Create spectrogram from time signal.

2. Enter  the  Number  of  values  used  to  calculate  the  spectrum.  The  default  "Number  of  values"  corresponds  to  the
maximum possible number.

The  number  of  values  specified  is  automatically  increased  to  the  next  power  of  two  for  the
calculation.

Example: To create a spectrum of 1000 measuring values, the value is automatically changed
to 1024 values for the calculation. The calculated FFT then contains 512 measuring values.

3. Enter the % overlap.

4. Click OK.

The spectrogram is displayed in the “Calculated FFT" diagram. 

You can configure the display in the FFT settings tool section with Display mode (see Waterfall charts ).

Difference cursor

You can use the difference cursor to calculate the difference between two measuring values.

To do this, place the base cursor and an additional difference cursor at any measuring point in the diagram.
The distance between the cursors is indicated by a coloured bar directly above the X-axis. Both measuring
values obtained with the cursors and the resulting differential values are displayed in the cursor information.
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4. Select the difference cursor option from the cursor selection list or press the F3 button.

The base cursor and the difference cursor are displayed in the diagram, these are connected by a coloured bar that
runs along and slightly above the X-axis.

5. You can place the base cursor at any desired measuring point in the diagram by left-clicking.

6. You can position the difference cursor at any measuring point in the diagram by left-clicking while holding down the
shift key.

The cursor information above the diagram displays the measuring values for the base cursor and difference cursor as
well as the delta value.

RMS/AMV cursor

You can calculate the effective value (root mean square) and the arithmetic mean between two measuring
points using the RMS/AMV cursor.

To do this, place the base cursor and an additional mean value cursor at any measuring point in the diagram.
The distance between the cursors is indicated by a coloured bar directly above the X-axis. Both measuring
values obtained with the cursors and the resulting mean values are displayed in the cursor information.

1. Select the RMS/AMV cursor option from the cursor selection list or press the F4 button.

The base cursor and the averaging cursor are displayed in the diagram, these are connected by a coloured bar that
runs along the X-axis and slightly above it.

2. You can place the base cursor at any measuring point in the diagram by left-clicking.

3. You can position the RMS/AMV cursor at any measuring point in the diagram by left-clicking while holding down the
shift key.

The measuring values of the base cursor, the averaging cursor as well as the arithmetic and RMS value for the area
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specified are displayed in the cursor information above the diagram

Harmonics cursor

 
You can use the harmonics cursor to determine whether harmonics are present in the diagram (integer
multiple of a vibration).

To do this, place the base cursor at any measuring point in the diagram. The harmonics are displayed in each
case as drawn-through vertical lines. The corresponding measuring values are displayed at the upper end of
the vertical lines, and the measuring values for the base cursor are displayed in the cursor information.

1. Select the harmonics cursor option from the cursor selection list or press the F5 button.

The base cursor and vertical lines are displayed at the harmonic of the basic frequency.

2. You can shift the base cursor to any desired measuring point in the diagram using the left mouse button.

When the position of the harmonics cursor is changed the harmonics are automatically shifted. The cursor information
above  the  diagram  displays  the  measuring  values  for  the  base  cursor  and  the  micro  steps  that  were  set.  The
measuring values of the harmonics are each displayed as vertical text next to the corresponding vertical line.

Sideband cursor

 
You can use the sideband cursor to determine additional measuring values in definable sidebands starting
from the base cursor.

To do this, first place the base cursor at any measuring point in the diagram. You can then shift the nearest
sideband to another measuring point in the diagram. All other sidebands that are displayed are
simultaneously adjusted.



173

The FAG Viewer

1. Select the sideband cursor option from the cursor selection list or press the F6 button.

The base cursor and vertical lines are displayed at the sidebands of the frequency.

2. You can use the left mouse button to shift the base cursor to any measuring point in the diagram and also modify the
position of the sidebands.

The cursor information above the diagram displays the measuring values for the base cursor as well as the differential
delta of the sideband frequencies. The measuring values of the sidebands are each displayed vertically as text next to
the corresponding vertical line.

HS cursor

 
The HS cursor (Harmonic with Sidebands) combines both cursor types described above. This means that the
measuring values of the harmonics and their sidebands will be displayed.

1. Select the HS cursor option from the cursor selection list or press the F7 button.

The  base  cursor  and  vertical  lines  are  displayed  at  each  harmonic  of  the  base  cursor  frequency  as  well  as  its
sidebands.

2. You can use the left mouse button to shift the base cursor to any measuring point in the diagram and also modify the
position of the sidebands.

The cursor information above the diagram displays the measuring values for the base cursor as well as the differential
delta of the sideband frequencies. The measuring values of the harmonics are each displayed as vertical text next to
the corresponding vertical line.

Revolutions cursor

 
The revolutions cursor marks the frequency that is assigned to a specific speed with a line. The revolutions
value is calculated as follows:

1. Select the revolutions cursor option from the cursor selection list or press the F8 button.

The "revolutions cursor" dialogue opens.

2. Activate or deactivate the options for the cursor settings in the "revolutions cursor" dialogue.

3. Enter any desired speed in the rpm field and click OK. The revolutions cursor is displayed differently, depending on
the type of diagram (FFT or time signal):

In  an  FFT  diagram,  a  single  revolutions  cursor  is  displayed  at  the  point  previously  specified  for  the  speed  in  the
dialogue. The cursor information above the diagram shows the base cursor value as well as the speed setting. 
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For  a  time  signal  a  speed  field  with  a  series  of  revolutions  cursors  is  displayed.  In  this  case  the  individual  lines
correspond to  an additional  revolution before or  after  the current  position of  the base cursor.  If  you move the base
cursor or position it at another measuring point, the speed field moves automatically with it.

6.3.6 Positioning of base cursor

 
You can position the base cursor at a point in the diagram defined via numeric input in the base cursor
positioning dialogue box. The base cursor jumps to the measuring point nearest to this position.

1. Click on  in the toolbar.

The "Base cursor position" dialogue is displayed.

2. Select the Move cursor to the nearest sample at option and enter any desired value inside the diagram area in the
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input field.

or

3. Select  the  Move  base  cursor  to  measure  point  index  option  and  enter  an  index  value  for  the  corresponding
measuring value in the input field.

4. Click OK.

The base cursor is now positioned at the position you entered numerically.

6.3.7 Modify cursor properties

Using the cursor properties dialogue, you can change the properties of the cursor currently selected.

1. Click on  in the toolbar.

A dialogue showing the currently selected properties of the cursor tool will open.

2. Activate or deactivate the relevant fields in the dialogue window and pick one of the values in the selection boxes or
enter the respective value in the input fields provided.

3. Click OK.

The cursor properties are applied and saved.

General cursor properties

You can modify the general cursor options described below. These properties apply to all available cursor types. To do
this, activate or deactivate the corresponding checkboxes in the dialogue window.

Drag cursors to
nearest peak

Switched on: the cursor jumps to the maximum value which is nearest the mouse pointer.  If
no  maximum  value  can  be  found  immediately  near  the  mouse,  the  cursor  remains  in  its
previous position.

Switched  off:  the  cursor  jumps  precisely  to  the  measuring  point  in  the  diagram  which  is
nearest the mouse pointer. 

Show peaks Switched  on:  In  addition  to  the  vertical  lines  current  symbols  are  used  to  label  measuring
values at the characteristic points of the various cursors in the diagram.

Switched off: the symbols that identify measuring values at characteristic points are removed.
The vertical lines will still be displayed.

Displaying units in 
information boxes

This option is only relevant for the cursor information display which must also be switched on.

Switched  on:  Numerical  values  and  units  for  the  current  cursor  are  displayed  in  the
information boxes at cursor information.

Switched off: Only the numerical values for the current cursor are displayed in the information
boxes at cursor information.

Modifying the properties of the base cursor

When using the base cursor  you can only modify the general  cursor  options described above.  To do this,  activate  or
deactivate the corresponding checkboxes in the dialogue window.

Editing the measure cursor properties

When using the base cursor  you can only modify the general  cursor  options described above.  To do this,  activate  or
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deactivate the corresponding checkboxes in the dialogue window.

Modifying the properties of the difference cursor

When using the difference cursor you can only modify the general cursor options described in Modify cursor properties.
To do this, activate or deactivate the corresponding checkboxes in the dialogue window.

Modifying the properties of the RMS/AMV cursor

Similarly,  when  using  the  RMS/AMV  cursor  you  can  only  modify  the  general  cursor  options  described  in  Modify  the
cursor properties. To do this, activate or deactivate the corresponding checkboxes in the dialogue window.

Editing the properties of the harmonics cursor

In  addition to  the general  cursor  options described in  Modify the cursor  properties  you can  also  modify  the  additional
options  for  the  harmonics  cursor  (described  below).  To  do  this,  activate  or  deactivate  the  appropriate  fields  in  the
dialogue window or select the respective value from the selection boxes.

Standard 
cursor type

The  harmonics  are  precisely  calculated  for  the  current  cursor.  The  indicators  for  the
harmonics  are  set  so  they  locate  the  nearest  measuring  value  for  the  harmonics
calculated.

Micro steps

Micro steps are necessary to allow the basic frequency to be more precisely defined. In
this selection box you can enter the increment between two measured points that will be
used to specify the basic frequency and also calculate the harmonic.

Cursor type:
automatic peak
determination

The  harmonics  are  precisely  calculated  for  the  current  cursor.  The  indicators  for  the
harmonics  are  set  so  they  locate  the  nearest  maximum  value  for  the  harmonics
calculated.

Nearest points

The Viewer software calculates the precise mathematical values of the harmonics. The
intelligent cursor analyses the number of nearest points specified in this field (measuring
points in the diagram in both directions) for maximum values and positions the indicator
for the harmonic at the nearest maximum value.
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Harmonics to calculate In  this  field  you  can  enter  the  number  of  harmonics  that  must  be  calculated  in  each
case.

Sub-harmonics to calculate In this field you can enter the number of sub-harmonics that must be calculated in each
case.

Show coordinates Switched  on:  The  coordinates  (value  pairs)  of  the  harmonics  are  displayed  in  the
diagram.

Switched  off:  The  coordinates  (value  pairs)  of  the  harmonics  are  removed  from  the
diagram.

Show 
vertical lines

Switched on: The harmonics are identified in the diagram using the cursor symbol and
a vertical line.

Switched off: The harmonics are identified using only the corresponding cursor symbol.

Modifying the properties of the sideband cursor

In  addition  to  the  general  cursor  options  described  in  "Modify  the  cursor  properties"  you  can  also  modify  additional
options of the sideband cursor (described below). To do this, activate or deactivate the appropriate fields in the dialogue
window or select the respective value from the selection boxes.

Number of sidebands In  this  field  you  can  enter  the  number  of  sidebands  that  must  be  calculated  for  the  current
cursor in each case.

Nearest points The Viewer software calculates the precise mathematic values of the sidebands. The number
of  nearest  points  specified  in  this  field  (existing  measuring  points  in  the  diagram)  are  then
analysed for maximum values and the sideband marker is positioned at the nearest maximum
value.

Show coordinates Switched  on:  The  measuring  values  of  the  respective  sidebands  on  the  x-  and  y-axes  are
displayed at the vertical lines.

Switched off: The measuring values of the sidebands are removed from the display.

Show vertical lines Switched  on:  The  harmonics  are  identified  in  the  diagram  using  the  cursor  symbol  and  a
vertical line.

Switched off: The harmonics are identified using only the corresponding cursor symbol.

Editing the HS cursor properties

In addition to the general cursor options described in "Modify the cursor properties" you can also modify the options for
the  HS  cursor  (described  below).  To  do  this,  activate  or  deactivate  the  appropriate  fields  in  the  dialogue  window  or
select the respective value from the selection boxes.
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Calculated harmonic In this field you can enter the number of harmonics that must be calculated in each case.

Nearest points Each  harmonic  is  determined  precisely  using  a  mathematical  formula.  You  can  enter  the
number  of  nearest  points  to  the  left  and  right  of  the  harmonic  identified  to  be  analysed  for
maximum values. The highest value in each case is then labeled as a harmonic and displayed.

Number of nearest 
points

Each sideband is also determined precisely using a mathematical formula. You can enter the
number  of  nearest  points  to  the  left  and  right  of  the  sideband  identified  to  be  analysed  for
maximum values. The highest value in each case is then labeled as a sideband and displayed.

Show coordinates Switched on:  The measuring value for each harmonic and sideband on the x-  and y-axes is
displayed at the vertical line.

Switched off:  The measuring values of  the  harmonics  and  sidebands  are  removed from the
display.

Show vertical lines Switched  on:  The  harmonics  and  sidebands  are  identified  in  the  diagram  using  the  cursor
symbol and a vertical line.

Switched off: The harmonics and sidebands are identified using only the corresponding cursor
symbol.

Modifying the properties of the revolutions cursor

In addition to the general cursor options described in "Modify the cursor properties" you can also modify the additional
option for the revolutions cursor – this is described below. To do this, activate or deactivate the appropriate fields in the
dialogue window or enter the appropriate value in the input field.

RPM Enter  a  rotational  speed  [rpm]  in  the  input  field.  The  Viewer  software  uses  this  value  to
calculate the corresponding frequency and positions the revolutions cursor at the appropriate
location in the diagram.



179

The FAG Viewer

6.3.8 Other tools

Copying a diagram as a graphic to the clipboard

You can use this tool to copy the current diagram view to the clipboard.

1. Click on the Copy diagram to clipboard symbol.

2. Switch to the application in which you would like to insert the image.

3. Select the Paste option from the Edit menu for the application or use the shortcut Ctrl+V

Change diagram boundaries

You can use this tool to change the minimum/maximum values displayed on the x- and y-axis.

1. Click on the Change diagram boundaries symbol.

The "Modify maximum values" dialog is displayed.

2. Enter a new minimum/maximum value for the X and/or Y axis in the appropriate boxes. Click Reset to restore values
automatically calculated by the Viewer software.

3. Select an additional option:

o Apply settings to the selected signal  only:  Only the diagram activated in  the signal  selection (see "Displaying
and removing signals" ) is changed.

o Apply settings to all diagrams with the same axis unit in the active window: The signal axis limits of the active
selected window are changed.

o Apply settings to group: All diagrams belonging to the same configuration as the selected signal are changed.

o Apply settings to all  diagrams with  the  same type:  All  diagrams of  the  same type  –  e.g.  "time signals"  –  are
changed.

o Reset all  customizations of the selected diagram:  The user settings for all  diagrams of the active window are
reset to the values automatically calculated by the Viewer software.

o Reset  all  customizations of  all  diagrams:  The  settings  for  all  diagrams  in  all  windows  are  reset  to  the  values
automatically calculated by the Viewer software.

4. Click OK.

The diagram (and other diagrams if relevant) is displayed with the chosen settings applied.

Or:

Click on Cancel to discard the changes.

Edit rotational speed

Use this tool to change the rotational speed information in an FFT or time signal. 

1. Click on the Edit rotational speed symbol.
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The "Edit rotational speed" dialog is displayed.

2. Click  on  the  signal  whose  rotational  speed  you  wish  to  change.  If  there  are  multiple  signals,  you  can  right-click  to
select or deselect them all.

3. Enter  the  appropriate  speed  in  the  Rotational  speed  box and  select  the  unit  (rpm  or  Hz).  The  rotational  speed  is
automatically converted when you change the unit.

4. Click Apply rotational speed to selection to allocate the new speed to the selected signals.

5. Click Reset select to defaults to undo the change of speed.

6. Click OK to apply the changes or Cancel to discard them.

Display signal distribution

This  tool  allows  you  to  display  the  distribution  of  signals  in  a  trend  diagram.  To  do  so,  select  a  reference
signal  for  the  X axis.  You  can  then  display  the  distribution  of  the  other  signals  in  relation  to  the  reference
signal by selecting it for the Y axis.

1. Click on the Show distribution of signal icon.

The Assign signals to axes dialog is displayed.

2. Drag the desired reference signal out of the list of available signals into the X axis field. Alternatively, you can click on

the reference point and then on  to add it to the X axis.

3. Drag one or more signals onto the Y axis field to display their distribution in relation to the reference signal.

4. To remove a signal, just drag it out of the respective field back into the list of available signals. Alternatively, you can

click on the signal and then on  to remove it.
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If you have enabled validation in the device configuration (see Configuration Manager  section "Additional channels"
), you can use the limits defined there as filter conditions.

5. To do so, select the appropriate validator in Filter options and specify a minimum and maximum. Alternatively, you
can call the threshold values defined in the validation directly by clicking V1L1-V2L2 (V1/2 = validator 1 and 2, L1/L2
= limit 1 and 2). The respective value is then copied straight to the appropriate field in the filter options.

6. Click OK.

7. The signal distribution is displayed in the preview. To display the whole diagram, click Display loaded diagrams .

The  diagram  is  then  displayed  with  the  selected  settings.  If  you  have  selected  multiple  signals  for  the  Y  axis,  the
various distributions are displayed separately.

Trend filtering

Displays  the  trend  progression  of  one  or  multiple  signals  depending  on  the  filter  criteria  of  one  or  both
validators.

1. Click on the Trend filtering symbol.

The Signal selection window is shown.

2. Drag the desired signals out of the list of available signals into the Y axis field. Alternatively, you can click on one or

multiple signals and then on  to add them to the Y axis.

3. To remove a signal, just drag it out of the respective field back into the list of available signals. Alternatively, you can

click on the signal and then on  to remove it.
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If you have enabled validation in the device configuration (see Configuration Manager  section "Additional channels"
), you can use the limits defined there as filter conditions.

4. To do so, select the appropriate validator in Filters  and specify a  minimum and a maximum. Alternatively,  you can
call  the threshold values defined in the validation directly by clicking V1L1-V2L2  (V1/2 = validator 1 and 2,  L1/L2 =
limit 1 and 2). The respective value is then copied straight to the appropriate field in the filter options.

5. Define the start and the end time.

6. Click OK.

7. The filtered trend diagram is displayed in the preview. To display the whole diagram, click Show trend data .

The diagram is then displayed with the selected settings.

Add bearing

This tool adds a bearing to the current spectrum from the bearing database.

1. Click on the Add bearing icon.

2. Select a bearing (see Configuration Manager  section "Bearing database ").

3. Enter the rotational speed conversion rate.

The characteristic bearing values are displayed in the Kinematic frequencies  box on the diagram information bar.

Calculate cepstrum

In  the  FFT  diagram  you  can  calculate  the  cepstrum  and  thus  identify  periodic  changes  more  easily.  To  do  so,  click
Calculate cepstrum from spectrum... in the Edit menu. This calls up another dialog box with the calculated cepstrum:

6.3.9 Using the diagram information bar

Displaying the diagram information bar

The  diagram  information  bar  contains  additional  information  on  the  diagram  displayed  and  outputs  the  relevant
characteristic measuring values in tabular form depending on the cursor selected. There are a number of ways in which
the diagram information bar can be displayed.

Adjusting the default setting for the diagram information bar display via the Viewer options

The  default  setting  for  the  diagram  information  bar  display  can  be  adjusted  with  the  options.  The  settings  can  be
configured  individually  for  each  diagram type  (FFT,  time signal  or  trend  data).  This  default  setting  is  used  when  new
diagrams are opened.

1. Click on the Extras menu.

2. Select the Options menu item.

The options dialog opens.
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3. Select the Diagrams  heading in  the left-hand column.  Open the navigation menu by clicking the mouse on the "+"
symbol.

4. Select the desired diagram type (FFT diagram, time signal diagram or trend diagram) you want to change the setting
for.

The options for the selected diagram type are displayed in the right-hand field.

5. Activate the Show diagram info bar at startup checkbox in the Diagram information bar field.

The changes are applied the next time this diagram type is opened.

Displaying the diagram information bar with the mouse

1. Click the mouse on the slim grey bar to the right of the diagram display.

The diagram information bar appears.

2. Once the diagram information bar is displayed, click on the narrow grey bar to the left of the diagram display.

The diagram information bar is hidden.

Displaying the diagram information bar with the keyboard

1. Use the keyboard shortcut Ctrl+I to display the diagram information bar.

The diagram information bar appears.

Displaying frequency bands

The  diagram  data  in  an  FFT  diagram  contain  important  frequency  bands  from  which  characteristic  values  may  be
determined.  The  frequency  bands  which  are  defined  by  the  higher-level  application  are  highlighted  in  colour  in  the
diagram. These frequency bands cannot be edited in the Viewer software but can be displayed or hidden as required.
Frequency bands are only displayed in FFTs.

Double-click on a frequency band to zoom in. If Select characteristic value in trend diagram is enabled, clicking on a
frequency band automatically selects the appropriate signal in the trend diagram. 

Frequency bands are only displayed in FFTs.

1. To activate or deactivate a frequency band in an FFT diagram click the checkbox  in front of the preferred frequency
band in the list.

The frequency bands selected are displayed in the diagram as coloured fields
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You can switch the display of all  frequency bands in an FFT diagram on or  off  via  the context  menu in  the frequency
band information window.

1. Right-click the mouse at any desired point in the frequency band window in the diagram information bar.

2. Click Select all in the context menu to display all available frequency bands.

Or:

3. Click Remove all in the context menu to remove all available frequency bands from the diagram.

The frequency bands are displayed or removed depending on the setting.

Kinematic frequencies

If you have added one or multiple bearings to a spectrum from the bearings database using the Add bearing  tool, the
characteristic bearing data are displayed in the Kinematic frequencies box.

The following information is displayed:

Manufacturer / Bearing designation

BPFO: Outer race frequency

BPFI: Inner race frequency

BSF / 2xBSF: Single and double roller frequency

FTF fixed outer race: Fundamental train frequency at fixed outer race

FTF fixed inner race: Fundamental train frequency at fixed inner race

If a rotational speed is available for the spectrum (see Other Tools  Add bearing ),  the Viewer software can also
display the bearing frequencies in the spectrum.

1. Check the Bearing frequencies checkbox to do so.

2. Click on the bearing frequency in the Kinematic frequencies box to display in the spectrum.

The  selected  frequency  is  displayed  in  the  spectrum.  The  bearing  frequencies  multiplied  by  the  current  rotational
speed are displayed in parentheses in the Kinematic frequencies box.

Inserting comments into the diagram

You can assign comments to individual measuring points in the diagram. The comments in the diagram are presented at
the corresponding measuring point in an information field if the display field is activated. 

You can move the comment dialog by left-clicking on the dialog and dragging it to the desired position.

1. Select the preferred measuring point using the base cursor.

2. Click the Add button in the Comments field in the right-hand section of the information area.
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3. Enter a comment for the measuring point selected at the line provided for this in the table.

The comment is displayed in the diagram next to the appropriate measuring point and can be moved by left-clicking
and dragging it.

To change the allocation of the comment to the measuring point (shift on the X axis), click on the black triangle for the
comment and drag it to the appropriate measuring point.

When you select a comment in the list, it is displayed on a coloured background in the diagram.

Hover the mouse over  a  comment  in  the list  of  comments  to  display the comment  details  in  a  tooltip  at  the mouse
position.

Displaying maximum values

The Highest peaks box shows the highest measuring values on the Y axis of the diagram. You can define the number
of maximum values displayed via the selection box. You can use the checkbox provided to display the maximum values
in the diagram view.

1. If you wish to modify the number of maximum values displayed, click the Number of maximum values radio button in
the Highest peaks box.

2. Check the Mark peaks checkbox to display the corresponding maximum values in the diagram.

Displaying the measuring values of harmonics

If the Harmonics cursor is selected, this diagram information area is displayed. The table shows the measuring values
that most closely correspond to the harmonic.

The Harmonics table displays the measuring values for each harmonics value calculated.
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Modifying the settings for the harmonics cursor

You can modify the settings used to calculate the harmonics via the harmonics cursor properties.

1. To modify the settings click on the Cursor properties symbol in the "Navigation and Tools" field .

2. Modify the settings in the cursor properties dialogue field.

Copying measuring values for the harmonics using the clipboard

You can transfer measuring values for the harmonics to other applications using the clipboard. 

1. Highlight each measuring value you wish to transfer to another application in the table or right-click on the table and
choose the Select all menu item from the context menu.

2. To copy the measuring values you have selected to the clipboard, right-click  on the table. Pick the Copy selected
values to the clipboard menu item from the context menu.

3. Switch to the other application and click the paste symbol or select the Paste menu item from the Edit menu.

Displaying the measuring values of sidebands

If the sideband cursor or HS cursor is selected this field is displayed in the information area and contains the measuring
values that most closely correspond to the defined sidebands.

The Sidebands table displays the measuring values for the relevant sidebands calculated.

Modifying the settings for the sideband cursor

You can modify the settings used to calculate the sidebands via the sideband cursor properties. 

1. To modify the settings click on the Cursor properties symbol in the "Navigation and Tools" field .

2. Modify the settings in the cursor properties dialogue field.

Copying measuring values for the sidebands via the clipboard

You can transfer measuring values for the sidebands to other applications via the clipboard. 

1. Highlight each measuring value you wish to transfer to another application in the table or right-click on the table and
choose the Select all menu item from the context menu.

2. To copy the measuring values you have selected to the clipboard, right-click  on the table. Pick the Copy selected
values to the clipboard menu item from the context menu.

3. Switch to the other application and click the paste symbol or select the Paste menu item from the Edit menu.

Hiding the diagram information bar

Adjusting the default setting for removing the diagram information bar from the display via the Viewer options

The default  setting for the diagram information bar  display can be adjusted with  the options.  The adjustments  can be
made for each diagram type individually (FFT, time signal or trend data diagrams). This default setting is used when new
diagrams are opened.

1. Click on the Extras menu.

2. Select the Options menu item.

The options dialog opens.
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1. Select the Diagrams  heading in  the left-hand column.  Open the navigation menu by clicking the mouse on the "+"
symbol.

2. Select the desired diagram type (FFT, time signal diagram or trend) you want to change the setting for.

The options for the selected diagram type are displayed in the right-hand field.

3. Deactivate the Display right diagram information bar at start up checkbox in the Diagram information bar field. 

The changes are applied the next time this diagram type is opened.

Hiding the diagram information bar with the mouse

1. Click on the narrow grey bar to the left of the diagram information bar.

The diagram information bar is hidden.

Removing the diagram information bar using the keyboard

1. Use the keyboard shortcut Ctrl+I to hide the diagram information bar in the display.

The diagram information bar is hidden.

6.3.10 Exporting diagrams and information

In  the  Viewer  software  you  can  copy  diagrams  to  the  clipboard  or  save  them  in  JPG  or  BMP  format.  The  exported
diagrams contain the cursor and measuring information and, optionally, an information text with the title of the diagram.
The diagram information bar  is  not  exported.  You can edit  the diagram dimensions  and  other  options  in  the  Program
settings .  You  can  also  copy  the  measuring  values  and  the  entire  contents  of  the  diagram  information  bar  of  a
diagram to the clipboard to insert them in another application. 

Edit the diagram settings and then continue as follows.

Copy current diagram to clipboard

Select a diagram by clicking on the diagram window.

Click Copy current diagram to clipboard in the Edit menu.

Switch to the application in which you would like to insert the diagram.

Select the Paste option from the Edit menu for the application or use the shortcut Ctrl+V.
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Copying selected diagrams to clipboard

Click Select and copy diagrams to clipboard in the Edit menu.

Or:

Click on  in the toolbar.

Select the diagrams to copy by ticking the checkbox next to the available diagrams.

If you edit the clipboard options, click "Save settings” to apply the changes in the program settings .

Click OK.

Switch to the application in which you would like to insert the diagram.

Select the Paste option from the Edit menu for the application or use the shortcut Ctrl+V.

Save current diagram as image...

Select a diagram by clicking on the diagram window.

Click Save current diagram as image in the Edit menu.

Select the directory to save to,

enter a file name and 

select the file type JPG (JPEG format) or BMP (Windows bitmap format).

Click on Save.

Copy diagram information to clipboard

You can copy all diagram information of the selected diagram to the clipboard.

Select a diagram by clicking on the diagram window.

Click Copy diagram information to clipboard in the Edit menu.

Switch to the application in which you would like to insert the diagram information.

Select the Paste option from the Edit menu for the application or use the shortcut Ctrl+V.

Copying measuring values to the clipboard

You can copy the measuring values of a diagram to the clipboard.

Select a diagram by clicking on the diagram window.

Press CTRL+E.

Switch to the application in which you would like to insert the measuring values.

Select the Paste option from the Edit menu for the application or use the shortcut Ctrl+V.
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6.3.11 ASCII export

The ASCII export only works with Dtect X1s data.

During  the  ASCII  export,  a  separate  file  is  generated  consisting  of  a  header  segment  and  a  data  segment  for  each
existing data type. The header segment contains the measurement configuration data. The information is saved in the
Windows INI file format. The measuring data is contained in the data segment. The file names are made up of the name
of  the measuring data and the file  extension.  The  file  extensions  are  assigned  automatically  according  to  data  types.
The file extensions and assignment to the corresponding data type are shown in the table below.

File extension Data type

.X1AscActTime Time signal

.X1AscActFFT FFT

.X1AscAlarmFFT Alarm FFT

.X1AscCharacteristics Characteristic value data

.X1AscAlarms Alarm data

Manual export

Using manual export, only the dataset of the currently selected diagram will be exported.

Select a diagram.

Click on  in the toolbar.

Select  the  path  to  be  used  for  the  export  of  files  in  the  "Select  export  directory"  dialogue  box  which  subsequently
opens.

Click OK to close the dialogue box.

The selected dataset is now exported using the path you selected.

6.3.12 Waterfall charts

FFTs and order  spectrums can be displayed as three-dimensional  waterfall  charts.  For  this  type  of  display,  the  same
tools  are  available  as  for  the  two-dimensional  display.  If  you  have  selected  multiple  datasets,  the  corresponding
FFTS are also displayed in a window.

You can configure the display under FFT settings with Display mode. 

Display mode

2D stacked (only in case of multiple diagrams): The diagrams are displayed two-dimensionally with separate axes
on top of each other.

2D stacked (only in case of several diagrams): The diagrams are displayed in a diagram with the same axes.

3D  Wireframe:  The  diagrams  are  displayed  spatially  behind  each  other,  sorted  by  date  (the  "oldest"  value  at  the
front). The order of the curves can be changed by pressing CTRL+F.
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3D Area: The surfaces under the signal curves are displayed in a completed fashion. The order of the curves can be
changed by pressing CTRL+F.

3D Mountains: For this type of display, the surfaces under the signal curves are displayed in a completed fashion. In
addition,  the  peaks  between  the  individual  diagrams  are  connected  by  planes.  The  order  of  the  curves  can  be
changed by pressing CTRL+F.
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Sonagram: For this type of display, the diagrams are displayed as coloured surfaces on top of each other in which
the signal values are indicated as a colour value. This type of display is especially well-suited for comparing a large
number  of  measurements  across  a  long  timeframe.  Here,  the  sonogram  makes  it  easy  to  recognize  whether  a
machine is running at a decreasing speed in a resonance range. If the speed is dropping, the peaks of the FFT will
normally be smaller; in the resonance range they will be larger.

The assignment of colours to signal  values can be changed in the colour  scale on the right-hand side of  the window.
Click  and  hold  down  the  mouse  button  in  the  colour  scale  and  drag  the  coloured  bar  up  or  down.  The  diagram  is
updated in real time. In this way you can quickly distinguish relevant areas for your analysis.

Using zoom and cursor tools

In the waterfall  diagram you have the same zoom and cursor tools as for two-dimensional diagrams (for more on this,
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see Zoom tools /cursor tools ). If multiple diagrams are displayed, you can select the signal you would like to edit
with the cursor tool in the Signal selector.

Click the preferred signal. The signal you have chosen is highlighted by the cursor signal (yellow triangle). As soon as
you have positioned the basis cursor on a diagram value, the corresponding values are connected in the other diagrams
by a transparent yellow plane.

6.3.13 Program settings

To edit the program settings for the Viewer software, click Options in the Extras menu.

Modifying the global settings

You can restore the factory settings for the Viewer software using the Global  dialogue window (status following initial
installation of the software).

Click on Reset all options to factory settings!

and confirm again with OK.

The settings are reset.
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Units

In the Measurement units dialogue window, you can specify the options for scaling units used in the diagrams.

You can find an overview of all Measurement types used in Unit selection. The preferred unit and scaling information
are also displayed. The preferred unit cannot be changed when using ISO and US units. Scaling is enabled by default in
these profiles. 
If  you select  “Custom" you can select  the preferred unit  depending on the measurement  type  and  choose  whether  to
scale this measurement type automatically.
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1. Select the units profile.

To set the preferred unit or automatic scaling,

2. select the “Custom" profile and

3. edit the settings for separate measurement types.

4. Click on OK to apply these settings.

Clipboard

You can select the options for transferring the diagrams to the clipboard in the Clipboard dialogue window.

1. Select the preferred dimensions for the diagram display in the Diagram width and Diagram height fields.

2. Activate the Copy information text  to clipboard  checkbox if  you also wish the diagram title  to  be copied  with  the
graphic.

3. Click on OK to apply these settings.

Modifying the diagram settings

In the Diagrams  dialog you can specify whether new diagram windows are automatically displayed horizontally in  the
Viewer software.

1. You can specify whether diagrams belonging to the same data set should be identified using colour in the Diagram
grouping field.

2. If required, activate the Tile diagrams horizontally, if a new diagram is displayed checkbox.

o If this option is activated the software arranges the diagram windows horizontally (below one another) and the new
diagram is opened at the lowest position in the diagram window.

o If this option is deactivated, new diagram windows are cascaded.

3. Tick the Calculate spectrum 'on-the-fly' if there is no spectrum available in database checkbox in order to create
a spectrum during the loading process.

4. Click on OK to apply these settings.

FFT diagram

You can select the various FFT diagram display options in the FFT diagram dialogue window.

1. You can  specify  the  background  colour  for  the  FFT diagram in  the  Visual  options  field.  You  can  also  define  here
whether you wish the grid to be displayed in the background and also its colour.

2. In  the  Integration  field  you  can  specify  the  measuring  point  in  the  diagram  from  which  the  integration  should  be
performed.
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3. In the Information bar  field you can specify what information (cf.  Using the diagram information bar )  to  display
when a new diagram is opened.

4. In  the  Toolbar  field  you  can  specify  whether  Signal  selection,  Preview,  Axis  settings,  FFT  settings  and  Zoom
tools should be displayed when you open a new diagram.

5. Click on OK to apply these settings.

Time signal diagram

In the dialog window Time signal diagram, you can define certain options for displaying a time signal diagram.

1. The section Display options  allows you  to  adjust  the  background  colour  of  the  time signal  diagram.  You  can  also
define here whether you wish the grid to be displayed in the background and also its colour.

2. In the Information bar field you can specify whether diagram information and comments should be displayed when
a new diagram is opened.

3. In the Toolbar field you can specify whether Signal selection, Preview, Axis settings  and Zoom tools  should be
displayed when you open a new diagram.

4. Click on OK to apply these settings.

Trend diagram

In addition to the display settings already presented with the FFT diagram  and the diagram information bar option the
settings for the trend display and smoothing can also be specified in the Trend diagram  dialogue window.

1. The section Display options  allows you  to  adjust  the  background  colour  of  the  time signal  diagram.  You  can  also
define here whether you wish the grid to be displayed in the background and also its colour.

2. In  the  Trend  display  settings  field  you  can  specify  whether  each  characteristic  value  should  be  displayed  in  a
separate  diagram  (Stacked  view)  or  whether  all  characteristic  values  should  be  displayed  in  one  diagram
(Overlapped view).

3. You can specify which function and which period length should be used to carry out the smoothing calculation in the
Smoothing field.

4. In the Information bar field you can specify whether diagram information and comments should be displayed when
a new diagram is opened.

5. In the Toolbar field you can specify whether Signal selection, Axis settings  and Zoom tools  should be displayed
when you open a new diagram.

6. In Trend limitation for loading you can configure the maximum number of recent trends and records to load.

7. Click on OK to apply these settings.

Modifying the cursor options

You can modify how each individual cursor is displayed in the dialogue windows for the various cursors.

1. Select the cursor you wish to modify from the list of cursors on the left.

2. Select the preferred cursor shape for the cursor specified above from the Symbol drop-down menu.

3. Select the symbol and colour to be used for the cursor as well as the colour for vertical cursor line.

4. Because  the  differential  and  averaging  cursors  work  in  pairs,  you  can  also  modify  the  appearance  of  the  second
cursor in this field accordingly.

5. Click on OK to apply these settings.

Modifying the signal settings

You can select measurement data display options in the signal dialogue windows.

1. If fewer than 50 measuring points are displayed in the diagram window, each measuring point can be made clearly
visible  as a dot.  If  greater  than 50 measuring points  are  displayed  in  the  diagram window,  the  display of  individual
measuring  points  is  automatically  deactivated  and  only  the  diagram  of  the  function  and  not  the  measuring  points
remains visible.

2. Click on OK to apply these settings.

Active signal / 1st–5th signal

Under the signal options you can modify the display of the individual signals.

1. Select a line type for the signal from the drop-down menu.

2. Specify a line width for the signal in pixels from the field provided.

3. Click on the palette to select a colour for the signal.

4. Click on OK to apply these settings.

182

194



196

You can also apply these settings for additional signals.

6.4 Keyboard shortcuts

Cursor selection

Key Function

F2 Activating the base cursor

F3 Activating the difference cursor

F4 Activating the RMS/AMV cursor

F5 Activating the harmonics cursor

F6 Activating the sideband cursor

F7 Activating the HS cursor (Harmonic with sideband)

F8 Activating the revolutions cursor

Move cursor

Key Function

Cursor left Moves the basic cursor left to the next measuring point

Cursor right Moves the basic cursor right to the next measuring point

Cursor up Moves the extended cursor left to the next measuring point

Cursor down Moves the extended cursor right to the next measuring point

CTRL + cursor left Moves the basic cursor to the first measuring point in the diagram

CTRL + cursor right Moves the basic cursor to the last measuring point in the diagram

CTRL + cursor up Moves the extended cursor to the first measuring point in the diagram

CTRL + cursor down Moves the extended cursor to the last measuring point in the diagram

ALT + cursor left Moves the basic cursor 10 measuring points to the left

ALT + cursor right Moves the basic cursor 10 measuring points to the right

ALT + cursor up Moves the extended cursor 10 measuring points to the left

ALT + cursor down Moves the extended cursor 10 measuring points to the right

CTRL + K Moves the cursor one micro step left (only for harmonics cursor if standard
detection is enabled)

CTRL + L Moves the cursor one micro step right
(only for harmonics cursor if standard detection is enabled)

CTRL + D Hides or shows the cursor

CTRL + P Opens the dialog for numeric cursor positioning

CTRL + O Opens the cursor options dialog

Zoom selection

Key Function

F9 Activates free mouse zoom

F10 Activates horizontal mouse zoom

F11 Activates vertical mouse zoom

F12 Activates keyboard zoom
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Keyboard zoom

Key Function

CTRL + Q Moves the start of the zoom area left

CTRL + W Moves the start of the zoom area right

CTRL + A Moves the end of the zoom area left

CTRL + S Moves the end of the zoom area right

CTRL + Y Moves the set zoom area left

CTRL + X Moves the set zoom area right

CTRL + Enter Displays the set zoom area

CTRL + Backspace Displays the previous zoom area

CTRL + Space Displays the whole diagram

CTRL + Z Opens the dialog for numeric zoom area input

Diagram scrolling

Key Function

CTRL + B Moves the diagram display left

CTRL + N Moves the diagram display right

CTRL + J Moves the diagram display up

CTRL + M Moves the diagram display down

Trend diagram

Key Function

CTRL + H Calls another record from the trend display

CTRL + G Toggle axis view between "cascaded" and "tiled".

Other keyboard shortcuts

Key Function

CTRL + R Reset comment position

CTRL + U Show/hide right info box at top edge of diagram.

CTRL + T Show/hide toolbar

CTRL + I Shows/hides the diagram information bar on the right edge of the diagram

CTRL + C Copies a screenshot of the diagram to the clipboard
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6.5 Carrying out a fault analysis

Principle of vibration analysis

Damage  in  machine  components  can  be  identified  at  an  early  stage  by  observing  characteristic  patterns  in  machine
vibration  frequency  spectrums.  Damage  in  the  outer  ring  of  a  anti-friction  bearing,  for  example,  is  characterized  for
example by increased amplitudes in the demodulation curve of the frequency spectrum for the characteristic frequency
produced  when  rollers  pass  over  a  damaged  part  of  the  outer  race  (outer  race  overrun  frequency)  and  for  integer
multiples of this frequency. The frequencies that characterize a damaged anti-friction bearing, i.e. the outer race, inner
race, roller or cage frequencies, depend on the bearing geometry and are proportional to the speed.

In order to detect damage in the anti-friction bearing at an early stage, a vibration monitoring device must generate the
demodulation curve of the frequency spectrum using the vibration signal and monitor amplitudes inside this spectrum for
selected  narrow-band  frequency  bands.  At  variable  machine  speed,  frequency  bands  must  be  monitored  speed
dependent.

Fault analysis using defective inner race as an example

A  vibration  sensor  monitors  the  acceleration  that  occurs  at  the  bearing  of  a  generator  shaft.  If  the  sensor  sends  a
conspicuous signal the measurement data is analysed in more detail. 

The spectrum and time signal of the demodulation curve at the bearing clearly show the frequency pattern of a defective
inner  race  (harmonic  with  sidebands).  The  extent  of  the  damage  in  an  inner  race  can  normally  be  established  by
determining how far the corresponding damage frequency is also evident in the raw signal. 

Due  to  the  clarity  of  the  frequency  pattern  in  the  demodulation  curve  and  the  height  of  the  amplitudes,  it  must  be
assumed in this case that the damage is advanced. The bearing was replaced at the next available opportunity.
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Fault analysis case study using defective outer race as example

In the example that follows, both roller bearings are monitored by vibration sensors. A suspicious signal  was received
from the sensor  on one side of  the roller  and a detailed  analysis  of  the  measurement  data  was  subsequently  carried
out. 

Fault analysis case study using defective outer race as example

The FFT diagram shows the typical pattern of outer race damage (harmonic of outer race damage frequency). Further, a
noticeable  rise  in  the  trend  progression  of  the  demodulation  curve  is  evident  which  indicates  that  the  damage  is
progressive. In this case the relevant bearing should therefore be replaced at the earliest possible opportunity.
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Fault analysis case study using imbalance as an example

Two vibration sensors monitor the accelerations present at the drive and output shaft of a generator coupling. 

Fault analysis case study using imbalance as an example

Extremely powerful vibrations were registered at a specific speed frequency on the A side (upper FFT in Viewer) and the
B side (lower FFT in Viewer). The corresponding speed for the revolutions cursor has been set in both diagrams.

The  cause  of  the  powerful  vibrations  in  this  case  was  an  imbalance  in  the  generator  or  generator  coupling.  The
generator rotor was therefore rebalanced before damage to the components occurred.
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7 The Remote Server

About the Remote Server

The Remote Server acts as a central monitoring point for several devices. It collects measuring data and messages sent
by  the  connected  devices  as  a  result  of  specific  events.  Possible  events  in  the  device  are  the  expiry  of  a  timer,  the
existence of an alarm and overflow of the characteristic value memory.

Communication is always initiated by the devices,  i.e.  the Remote Server  deals  with  incoming
connection requests, receives the transmitted data and writes it into XML files on the local hard
drive.

Data  Link  is  responsible  for  transferring  files  from  Remote  Server  to  the  CM  database .  It  monitors  the  data
directory  on  the  Remote  Server  and  transfers  newly  added  files  promptly  to  the  database.  The  data  can  then  be
evaluated and visualized in the Configuration Manager  or Viewer.

The Remote Server can establish connections via serial interfaces, modem/GSM modem or via a TCP/IP network and
process  these  at  the  same  time  which  means  it  can  receive  data  simultaneously  via  the  various  communication
channels selected. Further, the Remote Server logs communication, i.e. incoming connections, the event that led to the
connection being established, alarm status and measuring data transmitted as well as interaction with the user.

The Remote Server supports two operating modes:

In run mode messages and data are received from the connected devices.

Idle mode Remote Server is inactive and can be configured.

If the Remote Server is in run mode, a manual connection with devices cannot be established.
The Remote Server must first be placed in Idle  mode.

To start the program, click Start > Programs > FAG > Administrator > Remote Server.

If  you  invoke  the  program  from  the  command  line  with  the  /start_remote_server
parameter, the program automatically starts up in run mode. Otherwise, you have to start run
mode manually.

Once  the  program  has  launched,  the  program  icon  is  displayed  in  the  taskbar  information
area. If you minimise the program window, you can maximise it again by double-clicking this
icon.

If you have enabled the user management , log in  with your user name. The Remote Server is started.
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The program window of the Remote Server is divided into three sections:

Click the toolbar (directly below the menu bar) to call up the most important functions.

The configured communication channels  as well as the file directories used by the Remote Server for the storage
of data is displayed using a tree view similar to the standard Windows Explorer format in the left-hand section of the
program window.

On the right,  Remote Server  displays messages for  the  channel  currently  selected  or  the  connected  device  and
displays information about both in the messages window.

You can only edit the configuration if

the program is not in rune mode and

if  the  corresponding  rights  have  been  assigned  for  your  user  account  (see  "User
management ").

Devices must be configured for remote operation before data can be received. This is carried out in three steps:

1.  Configuration of communication ;

2.  Configuration of remote operation in the device configuration ;

3.  Configuration of monitoring configuration options .

You can then configure the relevant communication channels  in the Remote Server to receive data.

7.1 Configure communication channels

The  Remote  Server  only  accesses  correctly  installed  and  configured  devices  for  the  various
communication channels.  You should therefore ensure that  the necessary  hardware (modems
or network cards, for example) has been properly set up on your system.

Add communication channel

Click on  in the toolbar.

Or:
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Click Add communication channel in the Action menu.

You can set up a direct serial connection as follows:

Click Serial.

Select the serial interface for connecting the device to the Remote Server at Port name.

Select the baud rate to be used for communication between the Remote Server and the device from the "Baud rate"
list box. Make sure that the same baud rate for the Remote Server and the connected device  is set.

Enter a designation for the communication channel in the Name input field and click OK.

Set up a TCP/IP network connection as follows:

Click TCP/IP.

Enter the number of the port via which the Remote Server is to accept incoming connections at Port. The port number
must correspond to the number you specified  in the communication settings for the device when configuring the
COM Server for the Socket Client.

Enter a designation for the communication channel in the Name input field and click OK.

You can set up a modem connection as follows:

You can use a landline or GSM mobile radio modem on the Remote Server.

Click Modem.

Select the preferred modem from the list of device names.

Enter a designation for the communication channel in the Name input field and click OK.

Mobile  radio  modems can  only  be  used,  however,  if  no  PIN is  required  to  accept  incoming
calls.

If a TAPI driver is not available from the manufacturer of the GSM modem, install a standard
9600  baud  modem  driver  instead.  For  details  on  setting  up  a  modem  please  refer  to  the
Windows documentation.

Edit communication channel

You can edit an existing communication channel as follows:

Stop  the Remote Server if required.

Click the corresponding entry in the Communication channelconfiguration list.

Click on  in the toolbar.

Or:

Click Edit communication channel in the Action menu.
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Delete communication channel

You can delete an existing communication channel as follows:

Stop  the Remote Server if required.

Click the corresponding entry in the Communication channel configuration list.

Click on  in the toolbar.

Or:

Click Delete communication channel in the Action menu.

7.2 Data directory
Select the directory in which you want the Remote Server to save the files.

The data directory

is in the program directory of the Administrator software by default, in "Remote Server > Data".

must match the import directory configured in Data Link.

Select data directory

Click File > Change data directory.

Select a data directory.

Click OK.

7.3 Start/stop run mode

You can easily see the operating state of the program even if the program window is minimised.
The program icon in the taskbar information area changes colour depending on the state of the
program: the red square symbolises idle mode and the green arrow run mode. These icons are
also found in the program toolbar to start and stop run mode.

Start Remote Server (run mode)

The Remote Server must be started once configuration is complete in order to activate the remote monitoring.

Click on  in the toolbar.

Or:

Click Start server in the Action menu.

Once  the  Remote  Server  has  started  the  "Online  Monitoring"  window which  contains  the  activated  "Messages"  tab  is
displayed. All Remote Server operations are logged in this tab. The following messages in particular are displayed here:

start and stop of Remote Server,

when connections were accepted by devices,

reason for the remote message - i.e. which event in the device triggered the remote message,

which data were transferred,

error messages and irregularities that interfere with remote operation.

To start  the run mode the user  currently  logged in  must  have  the  required  access  rights  (see
"User management" ). After entering run mode the current user is logged off.

Stop Remote Server (idle mode)

You can stop the Remote Server as follows:

Click on  in the toolbar.

Or:

Click Stop server in the Action menu.
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To stop the run mode the  user  currently  logged  in  must  have  the  required  access  rights  (see
"User management ").

7.4 Messages

Display messages

The  Remote  Server  loads  existing  messages  and  displays  them  in  a  list  in  the  message  window.  The  following
information is also displayed in the message window:

The corresponding settings if a communication channel is selected in the tree view,

the serial number of the corresponding device when a connected device is clicked.

The  existing  messages  displayed  in  the  Remote  Server  message  window  are  always  the  messages  for  the
communication channel or device currently selected:

Display messages for communication channels

To display existing messages for all communication channels click the Communication channel configuration root
element in the tree view.

To display messages for one communication channel only click the corresponding channel in the tree view.

Show messages for connected devices

To display all  existing messages for  all  connected devices,  click  the Connected device(s)  root  element  in  the tree
view.

To display messages for one device only, click the corresponding device in the tree view.

Filter messages

You can filter messages and display them by specific channels or directories:

You can select the following options in Filter messages

All messages, to display all messages;

Progress, to display status messages only;
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Error, to display error messages only.

Please note that only the messages currently displayed are filtered. For example, if you select a
channel in the tree view, the message window only  displays messages for  this  channel  and it
therefore follows that only these messages are filtered!

Clear messages

You can use this function to delete all accumulated messages.

Click on  in the toolbar.

Or:

Click Clear messages in the Action menu.

7.5 User management

About user management in the Remote Server

The Remote Server does not have its own user management system and can be used without permissions. However,
you can use the users created in a CM database to control use of the Remote Server and of the Configuration Manager.

The  Remote  Server  creates  a  local  copy  of  the  selected  user  database.  If  you  edit  the  permissions  in  the  original
database – e.g. create new users or edit permissions – you must therefore update the user management in the Remote
Server (see "Reload user" ).

Selecting a user database

Click Select user database from the Extras menu and select the appropriate CM database (see also "The database"
).

Log in as / switch user

You can log in with another user name as follows:

Click Change user in the Extra menu.

Select a log-in name from the list of users created in the user management , enter the password and click OK.

Log off as user

Click Logout user in the Extra menu.

Refresh user

Click Refresh user in the Extras menu to synchronize the user management with the original database.

7.6 Change language
The Administrator  software can be displayed in  German,  English and Chinese.  If  you  select  a  different  language,  the
software restarts automatically. 

You can change the language as follows:

Click Change language in the Extras menu.
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Select the preferred language for the program and click OK.

Click Yes to close the program.

The program is started in the newly selected language.

7.7 Close

To close the program click File > Close.

You  can  only  close  the  program  when  it  is  not  in  run  mode.  To  stop  the  run  mode  the  user
currently logged in must have the required access rights (see "User management ").140
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8 Data Link

About Data Link

Data Link imports the files saved by the Remote Server  in a CM database . To do so, enter a directory for Data
Link to monitor. This import directory is read at program start-up and after each data import. If there aren’t any new data
to import, Data Link checks the directory once a minute.

In addition, the program can

export data in ASCII format, and

send e-mails automatically to a specified address as soon as new data have been imported.

To activate automatic e-mailing, you must configure Data Link accordingly (see "Configure e-mailing ").

Data Link has two operating states:

Run  mode  fills  the  selected  database  with  data  from  the  Remote  Server  and  sends  e-mails,  providing  the
corresponding settings have been made.

In idle mode, Data Link is inactive and can be configured.

Start Data Link as follows

Click Start > Programs > FAG > Administrator > Data Link.

Data  Link  connects  with  the  last  database  used.  If  you  installed  a  database  during  software  installation,  the  program
automatically connects to this database when you start the program for the first time. The program uses the default user
name and the default password. Further information can be found in “Change CM database" .

If  you invoke the program from the command line with  the /start_import  parameter,  the
program  automatically  starts  up  in  run  mode.  Otherwise,  you  have  to  start  run  mode
manually.

Once  the  program  has  launched,  the  program  icon  is  displayed  in  the  taskbar  information
area. If you minimise the program window, you can maximise it again by double-clicking this
icon.

The Data Link program window is divided into the following sections:

Click the toolbar (directly below the menu bar) to call up the most important functions.

Below you can define the import directory monitored by Data Link Define import directory.
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Current action displays the action currently being performed in run mode and the current state of Data Link.

The section Import messages displays import events. These messages are also saved in the program’s log directory

. Call up the context menu to copy the messages to the clipboard and paste them in a text editor. Click  on the
toolbar to delete the list of messages.

You can only edit the configuration if

the program is not in rune mode and

if  the  corresponding  rights  have  been  assigned  for  your  user  account  (see  "User
management ").

8.1 Working with directories

If  you  add  a  directory  containing  data  that  cannot  be  imported  by  Data  Link  (e.g.  program
directories), this data is moved into a separate directory and Data Link outputs an appropriate
message.  You should therefore make sure that  the directories  you  add  only  contain  data  that
can be imported by Data Link!

Select import directory

Click  in the Import directory section.

Select an import directory and

click OK.

The import directory

is in the program directory of the Administrator software by default, in “data\[version_number]
\app_standard\remote_data".

must match the data directory  specified in the Remote Server.

8.2 Change CM database
Select the database:

Click on File > Open database.

Or:

Click File > Database history to select a database from the list of recently opened databases.

The subsequent procedure is described in "Select database ".

The selected database is displayed on the status bar.

8.3 Start/stop run mode

You can easily see the operating state of the program even if the program window is minimised.
The program icon in the taskbar information area changes colour depending on the state of the
program: the red square symbolises idle mode and the green arrow run mode. These icons are
also found in the program toolbar to start and stop run mode.

Start run mode

Proceed as follows to put Data Link into run mode:

Click on  in the toolbar.

Or:
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Click Start in the Action menu.

Data Link enters run mode.

To start  the run mode the user  currently  logged in  must  have  the  required  access  rights  (see
"User management" ). After entering run mode the current user is logged off.

Stop run mode

If you wish to change the Data Link configuration, you must first stop run mode. To do this proceed as follows:

Click on  in the toolbar.

Or:

Click Stop in the Action menu.

Data Link enters idle mode.

To stop the run mode the  user  currently  logged  in  must  have  the  required  access  rights  (see
"User management ").

8.4 Configure automatic e-mailing
If you want Data Link to send an e-mail automatically as soon as data are imported from the import directory, you must
configure and activate automatic e-mailing. You can also configure whether  to  send an e-mail  only in  the event  of  an
alarm or, optionally, with the imported alarm data.

Configure e-mailing

You can configure the dispatch of e-mails as follows:

Click Options in the Extras menu.

Select Send e-mail.

Click Configure.

The “Configure” button opens the “E-mail options settings” dialog box where you can select and configure the method
used to send e-mails.

Please enter a valid e-mail address in the input box labelled “From” as the mail account to use for sending.

The e-mail address of the recipient is entered in the "To" input field.

Please enter the number of your service contract at "Contract number", if applicable.
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You can also enter a custom text "Comment" input box to append to the e-mails created.

Click Configure to set the protocol for the program to send e-mails.

Configure e-mailing

The program supports sending e-mails via Microsoft  Outlook,  MAPI  or  SMTP.  To obtain  the correct  settings consult
your network administrator.

Select the transfer method.

If you are using the SMTP protocol, you must enter either the name or IP address of the e-mail server in “host”.
Optionally  you  can  enter  a  user  name  and  password  for  SMTP  authentication.  If  you  are  using  the  TLS
encryption protocol (SMTP via SSL), you must also configure the TLS port. In "Timeout" you can define a time
range after which to automatically stop trying to make a connection.

To test the connection to the mail server, click Test connection.

Click OK to save the settings.

The Administrator software uses the separate E-MailRelay tool  for SSL encryption. You can
find this tool on the program CD.

If you want to use SSL encryption, you must enter the host of the E-MailRelay tool in SMTP. For
details refer to the section Configure e-mailing in the Administrator software .

Configure automatic e-mailing

You can configure automatic e-mailing as follows:

Select Automatic.

To activate the automatic  e-mailing,  select  the Automatically in remote service  option.  As  soon  as  the  Data  Link
imports a directory, it sends an e-mail to the chosen recipient.

In addition, you can limit  e-mails to alarm events. To do so,  select  the Only on alarms  option.  Data Link  now only
sends an e-mail if the data in the imported directory contain an alarm.

Select the Send data option to attach the file that triggered sending the e-mail.
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Click OK to save the settings.

8.5 Enable automatic data export (ASCII)
During the automatic export of data, all data sets added to the database are also exported to the specified directory.

ASCII export for Dtect X1s data

During  the  ASCII  export  for  Dtect  X1s  data,  a  separate  file  is  generated  consisting  of  a  header  segment  and  a  data
segment  for  each  existing  data  type.  The  header  segment  contains  the  measurement  configuration  data.  The
information  is  saved  in  the  Windows  INI  file  format.  The  measuring  data  is  contained  in  the  data  segment.  The  file
names  are  made  up  of  the  name  of  the  measuring  data  and  the  file  extension.  The  file  extensions  are  assigned
automatically according to data types. The file extensions and assignment to the corresponding data type are shown in
the table below.

File extension Data type

.X1AscActTime Time signal

.X1AscActFFT FFT

.X1AscAlarmFFT Alarm FFT

.X1AscCharacteristics Characteristic value data

.X1AscAlarms Alarm data

ASCII export for ProCheck data

The  ASCII  export  for  ProCheck  data  creates  a  directory  with  a  global  unique  identifier  (GUID)  for  each  export.  This
directory (e.g. {9ECEF3AA-1C3D-4137-9F44-EF56BD1A0281}) contains device information, configurations and measuring
data in XML format.

Enable automatic ASCII export as follows

Click Options in the Extras menu and then Export.

Check the Enable automatic ASCII export checkbox and select the target directory in Export path.

Once  new  data  are  delivered  by  the  remote  server,  they  are  automatically  saved  to  the  selected  directory  in  ASCII
format.

8.6 Change user
You can log in with another user name as follows:

Click Change user in the Extra menu.

Select a log-in name from the list of users created in the user management , enter the password and click OK.

8.7 Program settings

You can open the general program settings configuration window via the Tools > Options menu item.

To change the settings the user currently logged in must have the required access rights (see
"User management ").
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A tree  view is  displayed  on  the  left-hand  side  of  the  window and  shows  a  range  of  configuration  options  arranged  in
groups. You can expand the view and configuration options by clicking the symbols in front of the groups.

Information on the individual configuration options is provided or input masks are displayed on the right-hand side of the
window.

General

The Administrator  software can be displayed in  German,  English and Chinese.  If  you  select  a  different  language,  the
software restarts automatically. 

Limit daily runtime

You can use the runtime limit to define up to three time ranges in which the component should be active. Outside of the
defined time rages the software component is inactive and the message "Process sleeping" is displayed in the overview.
The option “All day long" is selected by default.

Activate automatic user login

Whenever you start the software, the program prompts you for your user name and password. You can skip this step by
configuring an auto-login for automatic user login. 

Select a user to log in automatically and enter the password. 

Click on the check mark  to check the user data.

Next time you launch the software, you will be automatically logged in with the configured user data.

Database

You can configure the database history and display information about the selected database here.

History

If this option is selected a list of all databases opened to date is displayed on the right. The entries in this list are the one
used to open databases from the File > Open database menu. You can also use this option to delete entries in this list
for clarity of overview.

To delete an alarm list entry:

Select one or (by holding the CTRL key down) multiple items from the list and

press the Delete item button to start the deletion operation.

Miscellaneous

The following information about the CM database being used is displayed:

Name of the database server

Name of the database

Used memory

Free memory

The ratio of free to used memory is also presented as a diagram.

The free memory display and the diagram can only return plausible information if the database
and database server are on the same system.

Export

The automatic export of data in ASCII format is configured and activated in this window. Further information is described
in “Configure automatic ASCII export" .

Send e-mail

The automatic export of data via e-mail  is  configured and activated in this window. Further information is described in
“Configure e-mailing" .

Contact

Our address, telephone and fax number as well as our e-mail and Internet address are provided here.
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8.8 Use Application Guard
By  default,  the  FAG  Administrator  software  is  delivered  with  Application  Guard.  Application  Guard  automatically
monitors  in  the  background  whether  a  running  program  component  of  the  FAG  Administrator  software  is  working
properly.  For  example,  if  a  program  does  not  respond  for  10  minutes,  Application  Guard  restarts  it.  This  function  is
particularly useful for programs that are permanently in run mode, for example Data Link or Email Link.

The following options are available:

Start Application Guard Select the option Application Guard in Extras > Application Guard.

Check Application Guard: Select the option Check Application Guard in Extras > Application Guard.

Stop Application Guard Select the option Stop Application Guard in Extras > Application Guard.

Application Guard uses port  11111. Please make sure that this port  is  open in  the computer’s
firewall. If necessary, ask your system administrator.

8.9 Close

To close the program click File > Close.

You  can  only  close  the  program  when  it  is  not  in  run  mode.  To  stop  the  run  mode  the  user
currently logged in must have the required access rights (see "User management ").140
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9 Email Link

About Email Link

You  can  use  Email  Link  to  receive  and  manage  e-mails  centrally,  for  example  e-mails  sent  from  Data  Link ,
Configuration Manager  or Administrator. The data contained in the e-mails is written into the selected CM database.

You can use a Microsoft  Outlook account or a POP3 account on a mail  server.  To obtain  the correct  settings,  please
consult your network administrator.

Email Link has two operating states:

Run mode checks the specified e-mail account at regular time intervals.

In idle mode, Email Link is inactive and can be configured.

You can use the runtime limit to define up to three time ranges in which the program should be
active in run mode. Outside of the defined time rages it  is  inactive and the message "Process
sleeping" is displayed. This function is found in “Options” in the “Extras” menu.

To start the program, click Start > Programs > FAGEmail Link > Administrator > .

Data  Link  connects  with  the  last  database  used.  If  you  installed  a  database  during  software  installation,  the  program
automatically connects to this database when you start the program for the first time. The program uses the default user
name and the default password. Further information can be found in “Change CM database" .

If  you invoke the program from the command line with  the /start_import  parameter,  the
program  automatically  starts  up  in  run  mode.  Otherwise,  you  have  to  start  run  mode
manually.

Once  the  program  has  launched,  the  program  icon  is  displayed  in  the  taskbar  information
area. If you minimise the program window, you can maximise it again by double-clicking this
icon.

The Email Link program window is divided into the following sections:

Click  the toolbar  (directly below the menu bar)  to  call  up the most  important  functions.  If  you import  data from the
received e-mails, a progress bar is displayed on the right of the toolbar.

Import  view  is  displayed  when you  launch  the  program.  The  current  status  of  Email  Link  and  other  information
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about data import are displayed here. Import events are logged in “Messages". These messages are also saved in the
program’s log directory . To clear the list of messages, click Clear messages in the Actions menu. 

Configuration  view   displays  the  available  Receive  options .  You  can  configure  e-mail  receipt  and  test  the
transfer channel here.

The e-mails received are displayed in a list in the Email Link mailbox .

You can only edit the configuration if

the program is not in rune mode and

if  the  corresponding  rights  have  been  assigned  for  your  user  account  (see  "User
management ").

Log file for data import

The Administrator software logs information about import processes in separate log files.

Click Show import logs in the Action menu.

Provides an overview of all import processes. 

Using  the  import  filter  you  can  filter  processes  by  “All  logs",  "Successful  imports"  and  "Not  successful  imports".  The
following information is displayed:

Field name Meaning

Read Import message already read can be ticked. Press the "Mark all as read" button to select all messages. You
can automatically delete these messages when you close the import log.

Status The import status is displayed with the following icons:

 Import was successful, all data were imported.

 Import was successful, but not all data were imported or the timestamp of the data was changed.

 Import failed, no data were imported.

Version The Version field contains information about the Administrator software version of the imported data.

Start date The Start date field contains information about the day and time the import was started.

Details Click this icon to display further details about the import process.

Message The Message field contains information about the day and time and how long the import took.

Devices
(imported, ignored)

This field contains the number, name and serial number of the device data to import. It also displays the
number of devices imported and ignored.

Measuring data
(imported, ignored)

This field contains the number of measuring data to import. It also displays the number of measuring data
imported and ignored.

File Click this icon to display the import log file in a text editor.
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9.1 Define receive settings
Change to the configuration view to set the receipt options:

Click on  in the toolbar.

Or:

Click Configuration in the View menu.

You  can  now specify  the  protocol  used  to  receive  e-mails.  The  program  supports  the  Microsoft  Outlook  and  POP3
protocols. Both transfer modes download e-mails from the mail server. If Email Link has imported e-mails or if you have
manually deleted e-mails in the mailbox, they are deleted from the POP3 server. In Microsoft Outlook, in contrast, they
are  moved  to  “Deleted  Objects"  and  must  be  deleted  manually.  To  obtain  the  correct  settings  consult  your  network
administrator.

Select the transfer mode:

Microsoft Outlook transfer mode

Click "Microsoft Outlook” in transfer mode.

Enter the MS Outlook profile from which to receive e-mails.

Enter your password for MS Outlook in Password.

Confirm the password in Repeat password.

Select the interval at which to retrieve e-mails from the mail server in Refresh every x minutes.

If  you are using a Microsoft  Outlook account,  the  E-mail  link  can  delete  the  E-mails  in  Outlook's  "Deleted  Objects"
folder after downloading them. Check the Delete E-mails in 'Deleted Objects' checkbox to do so.
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Please note the following:

Outlook always uses the current Outlook user profile of your system.

If you have defined a default profile in Outlook, the default profile is always used regardless of
which  profile  you  specify  in  Email  Link.  So  if  you  wish  to  use  a  profile  in  Email  Link,  there
must not be a default profile defined on the local computer!

Only  local  e-mails  can  be  retrieved  from the  main  Outlook  e-mail  folder  (subfolders  are  not
read).

The following message may be displayed in run mode: "A program is trying to access e-mail
addresses you have stored in Outlook. Do you want to allow this?". In this case you can allow
access for a certain time. If this is not sufficient, please contact Microsoft Support.

To save the configuration,

click on  in the toolbar.

Or:

Click Save configuration in the Configuration menu.

You can only save the configuration if the corresponding rights have been assigned in your user
account (see "User management ").

Click Test connection to check the connection to the mail server.

POP3 transfer mode

Click in the "POP3” transfer mode.

Enter the server name or the IP address of the mail server in Host.

Enter the user name.

Enter your password in Password.

Confirm the password in Repeat password.

Select the interval at which to retrieve e-mails from the mail server in Refresh every x minutes.

140



219

Email Link

To save the configuration,

click on  in the toolbar.

Or:

Click Save configuration in the Configuration menu.

You can only save the configuration if the corresponding rights have been assigned in your user
account (see "User administration ").

Click Test connection to check the connection to the mail server.

9.2 Change CM database
Select the database:

Click on File > Open database.

Or:

Click File > Database history to select a database from the list of recently opened databases.

The subsequent procedure is described in "Select database ".

The selected database is displayed on the status bar.

9.3 Start/stop run mode

You can easily see the operating state of the program even if the program window is minimised.
The program icon in the taskbar information area changes colour depending on the state of the
program: the red square symbolises idle mode and the green arrow run mode. These icons are
also found in the program toolbar to start and stop run mode.

Start receiving e-mails (Run mode)

In run mode, Email Link monitors the selected mailbox at the intervals specified in the settings and downloads new e-
mails. The data contained in the e-mails are automatically imported into the CM database.

Proceed as follows to start run mode:

Click on  in the toolbar.

Or:

Click Start receiving e-mails in the Actions menu.

Email Link enters run mode and switches to import view.

Import view displays the import process with a progress bar on the toolbar. The e-mail whose data are currently being
imported is displayed in "Importing e-mails". Further information about the import process is displayed in “Messages”.

To start  the run mode the user  currently  logged in  must  have  the  required  access  rights  (see
"User management" ). After entering run mode the current user is logged off.

Stop receiving e-mails (idle mode)

Proceed as follows to change the Email Link configuration or stop run mode:

Click on  in the toolbar.

Or:

Click Stop receiving e-mails in the Actions menu.

Email Link enters idle mode.
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To stop the run mode the  user  currently  logged  in  must  have  the  required  access  rights  (see
"User management ").

9.4 Manage e-mails in mailbox
To display downloaded e-mails, you must switch to the mailbox:

Click on  in the toolbar.

Or:

Click on Mailbox in the View menu.

In  addition  to  receiving  and  importing  e-mails  automatically,  you  can  also  download  and  import  e-mails  (run
mode)  manually in mailbox view. You can also delete  e-mails from the mailbox.

Refresh e-mails

Proceed as follows to download e-mails manually:

Switch to the mailbox .

Click Refresh e-mails.

The  e-mails  are  now downloaded  and  displayed  in  the  mailbox  (for  further  information  about  importing  data,  refer  to
“Import e-mails" ).

Import e-mails

You can only import e-mails manually if 

automatic import (run mode) is not active and

the e-mails contain data from Data Link , Configurations Manager  or Administrator (as
of version 3.x). The e-mails are displayed in blue font with an icon.

Switch to the mailbox .

Select the e-mails with data from the list of received e-mails. Use the Shift or CTRL key to select several e-mails.

Click Import e-mails manually.

Or:
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Click Import e-mails manually in the Actions menu.

Email Link switches to import view and imports the data in the selected e-mails.

You can also activate manual import in import view. To do so, click Import e-mails manually in
the Actions menu. Email Link imports the e-mail data in the Email Link mailbox.

Delete e-mails

You can only delete e-mails manually if automatic import (run mode) is not active.

Switch to the mailbox .

Select the e-mails from the list of received e-mails. Use the Shift or CTRL key to select several e-mails.

Click Delete e-mails.

Or:

Click Delete e-mails in the Actions menu to delete the selected e-mails.

The e-mails are removed from the Email Link mailbox and deleted from the mail server.

If  you  are  using  a  Microsoft  Outlook  account,  the  e-mails  are  stored  in  Outlook's  "Deleted
Objects"  folder.  To  delete  these  e-mails  completely,  tick  the  checkbox  Delete  e-mails  in
‘Deleted Objects' (see Configure receive options ).

You can also delete e-mails in import view. Click Delete e-mails in the Actions menu. Email
Link deletes all e-mails in its mailbox.

9.5 Change user
You can log in with another user name as follows:

Click Change user in the Extra menu.

Select a log-in name from the list of users created in the user management , enter the password and click OK.

9.6 Program settings

You can open the general program settings configuration window via the Tools > Options menu item.

To change the settings the user currently logged in must have the required access rights (see
"User management ").

A tree  view is  displayed  on  the  left-hand  side  of  the  window and  shows  a  range  of  configuration  options  arranged  in
groups. You can expand the view and configuration options by clicking the symbols in front of the groups.

Information on the individual configuration options is provided or input masks are displayed on the right-hand side of the
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window.

General

The Administrator  software can be displayed in  German,  English and Chinese.  If  you  select  a  different  language,  the
software restarts automatically. 

Limit daily runtime

You can use the runtime limit to define up to three time ranges in which the component should be active. Outside of the
defined time rages the software component is inactive and the message "Process sleeping" is displayed in the overview.
The option “All day long" is selected by default.

Activate automatic user login

Whenever you start the software, the program prompts you for your user name and password. You can skip this step by
configuring an auto-login for automatic user login. 

Select a user to log in automatically and enter the password. 

Click on the check mark  to check the user data.

Next time you launch the software, you will be automatically logged in with the configured user data.

Database

You can configure the database history and display information about the selected database here.

History

If this option is selected a list of all databases opened to date is displayed on the right. The entries in this list are the one
used to open databases from the File > Open database menu. You can also use this option to delete entries in this list
for clarity of overview.

To delete an alarm list entry:

Select one or (by holding the CTRL key down) multiple items from the list and

press the Delete item button to start the deletion operation.

Miscellaneous

The following information about the CM database being used is displayed:

Name of the database server

Name of the database

Used memory

Free memory

The ratio of free to used memory is also presented as a diagram.

The free memory display and the diagram can only return plausible information if the database
and database server are on the same system.

Contact

Our address, telephone and fax number as well as our e-mail and Internet address are provided here.

9.7 Use Application Guard
By  default,  the  FAG  Administrator  software  is  delivered  with  Application  Guard.  Application  Guard  automatically
monitors  in  the  background  whether  a  running  program  component  of  the  FAG  Administrator  software  is  working
properly.  For  example,  if  a  program  does  not  respond  for  10  minutes,  Application  Guard  restarts  it.  This  function  is
particularly useful for programs that are permanently in run mode, for example Data Link or Email Link.

The following options are available:

Start Application Guard Select the option Application Guard in Extras > Application Guard.

Check Application Guard: Select the option Check Application Guard in Extras > Application Guard.

Stop Application Guard Select the option Stop Application Guard in Extras > Application Guard.
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Application Guard uses port  11111. Please make sure that this port  is  open in  the computer’s
firewall. If necessary, ask your system administrator.

9.8 Close

To close the program click File > Close.

You  can  only  close  the  program  when  it  is  not  in  run  mode.  To  stop  the  run  mode  the  user
currently logged in must have the required access rights (see "User management ").140
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About Notify Link

Notify Link checks at intervals whether there are any new export data or non-response alarms in the CM database. The
condition is that automatic e-mailing of data and alarms is activated in Configuration Manager (see "Advanced settings"

). If there are any export data or non-response alarms, Notify Link sends them by e-mail straight away. 

To  activate  automatic  e-mailing,  you  must  configure  Notify  Link  accordingly  (see  "Configure  e-mailing ").  In  the
options  you can also define time slots in which to query the database. 

If you are using MS SQL Server 2005, you receive a capacity warning e-mail if the database is
nearing maximum capacity. For this purpose, you must indicate the global e-mail recipient in the
Notify Link options .

Notify Link has two operating states:

In run mode, it checks the selected CM database and sends e-mails as soon as there are any export data and non-
response alarms.

In Idle mode Notify Link is inactive and can be configured.

You can use the runtime limit to define up to three time ranges in which the program should be
active in run mode. Outside of the defined time rages it  is  inactive and the message "Process
sleeping" is displayed. This function is found in “Options” in the “Extras” menu.

Start the Notify Link as follows:

Click Start > Programs > FAG > Administrator> Notify Link.

Data  Link  connects  with  the  last  database  used.  If  you  installed  a  database  during  software  installation,  the  program
automatically connects to this database when you start the program for the first time. The program uses the default user
name and the default password. Further information can be found in “Change CM database" .

If  you invoke the program from the command line with  the /start_export  parameter,  the
program  automatically  starts  up  in  run  mode.  Otherwise,  you  have  to  start  run  mode
manually.

Once  the  program  has  launched,  the  program  icon  is  displayed  in  the  taskbar  information
area. If you minimise the program window, you can maximise it again by double-clicking this
icon.
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The Notify Link program window is divided into the following sections:

Click the toolbar (directly below the menu bar) to call up the most important functions.

Current action displays the action currently being performed in run mode and the current state of Notify Link.

Export messages displays the events. The meanings of the individual symbols are next to each message:

Icon Meaning

 Information about the state of the mail server (e.g. Mail export is enabled).

 
Information about the current action (e.g. process sleeping).

 E-mail send error messages (e.g. undefined recipient).

You can only edit the configuration if

the program is not in rune mode and

if  the  corresponding  rights  have  been  assigned  for  your  user  account  (see  "User
management ").

10.1 Change CM database
Select the database:

Click on File > Open database.

Or:

Click File > Database history to select a database from the list of recently opened databases.

The subsequent procedure is described in "Select database ".

The selected database is displayed on the status bar.
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10.2 Configure automatic e-mailing
If you want Notify Link to send an e-mail automatically as soon as data are exported by the device or a non-response
alarm is triggered, you must configure and activate automatic e-mailing.

Configure e-mailing

You can configure the dispatch of e-mails as follows:

Click Options in the Extras menu.

Select Send e-mail.

Click Configure.

The “Configure” button opens the “E-mail options settings” dialog box where you can select and configure the method
used to send e-mails.

Please enter a valid e-mail address in the input box labelled “From” as the mail account to use for sending.

The e-mail address of the recipient is entered in the "To" input field.

Please enter the number of your service contract at "Contract number", if applicable.

You can also enter a custom text "Comment" input box to append to the e-mails created.

Click Configure to set the protocol for the program to send e-mails.

Configure e-mailing

The program supports sending e-mails via Microsoft  Outlook,  MAPI  or  SMTP.  To obtain  the correct  settings consult
your network administrator.

Select the transfer method.
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If you are using the SMTP protocol, you must enter either the name or IP address of the e-mail server in “host”.
Optionally  you  can  enter  a  user  name  and  password  for  SMTP  authentication.  If  you  are  using  the  TLS
encryption protocol (SMTP via SSL), you must also configure the TLS port. In "Timeout" you can define a time
range after which to automatically stop trying to make a connection.

To test the connection to the mail server, click Test connection.

Click OK to save the settings.

The Administrator software uses the separate E-MailRelay tool  for SSL encryption. You can
find this tool on the program CD.

If you want to use SSL encryption, you must enter the host of the E-MailRelay tool in SMTP. For
details refer to the section Configure e-mailing in the Administrator software .

Automatic e-mails

Notify  Link  sends  the  data  at  the  defined  intervals,  e.g.  every  24  hours.  In  order  to  ensure  that  alarms  are  not  only
reported  during  this  time-frame,  by  default  ingoing  alarms  are  sent  automatically  e-mailed  immediately.  This  ensures
constant monitoring and you can react to an alarm without delay.

You can also deactivate this  setting.  This  makes sense,  for  example if  you only want  to  check  a  system once  a  day.
Deactivate automatic e-mails as follows:

Click Options in the Extras menu.

Select Send e-mail.

Click Automatic. You can deactivate e-mailing of ingoing alarms here:
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10.3 Start/stop run mode

You can easily see the operating state of the program even if the program window is minimised.
The program icon in the taskbar information area changes colour depending on the state of the
program: the red square symbolises idle mode and the green arrow run mode. These icons are
also found in the program toolbar to start and stop run mode.

Start run mode

Proceed as follows to put Notify Link into run mode:

Click on  in the toolbar.

Or:

Click Start in the Action menu.

Notify Link enters run mode.

To start  the run mode the user  currently  logged in  must  have  the  required  access  rights  (see
"User management" ). After entering run mode the current user is logged off.

Stop run mode

If you wish to change the Notify Link configuration, you must first stop run mode. To do this proceed as follows:

Click on  in the toolbar.

Or:

Click Stop in the Action menu.

Notify Link enters idle mode.

To stop the run mode the  user  currently  logged  in  must  have  the  required  access  rights  (see
"User management ").

10.4 Change user
You can log in with another user name as follows:

Click Change user in the Extra menu.

Select a log-in name from the list of users created in the user management , enter the password and click OK.
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10.5 Program settings

You can open the general program settings configuration window via the Tools > Options menu item.

To change the settings the user currently logged in must have the required access rights (see
"User management ").

A tree  view is  displayed  on  the  left-hand  side  of  the  window and  shows  a  range  of  configuration  options  arranged  in
groups. You can expand the view and configuration options by clicking the symbols in front of the groups.

Information on the individual configuration options is provided or input masks are displayed on the right-hand side of the
window.

General

The Administrator  software can be displayed in  German,  English and Chinese.  If  you  select  a  different  language,  the
software restarts automatically. 

Limit daily runtime

You can use the runtime limit to define up to three time ranges in which the component should be active. Outside of the
defined time rages the software component is inactive and the message "Process sleeping" is displayed in the overview.
The option “All day long" is selected by default.

Activate automatic user login

Whenever you start the software, the program prompts you for your user name and password. You can skip this step by
configuring an auto-login for automatic user login. 

Select a user to log in automatically and enter the password. 

Click on the check mark  to check the user data.

Next time you launch the software, you will be automatically logged in with the configured user data.

Database

You can configure the database history and display information about the selected database here.

History

If this option is selected a list of all databases opened to date is displayed on the right. The entries in this list are the one
used to open databases from the File > Open database menu. You can also use this option to delete entries in this list
for clarity of overview.

To delete an alarm list entry:

Select one or (by holding the CTRL key down) multiple items from the list and

press the Delete item button to start the deletion operation.

Miscellaneous

The following information about the CM database being used is displayed:

Name of the database server

Name of the database

Used memory

Free memory

The ratio of free to used memory is also presented as a diagram.

The free memory display and the diagram can only return plausible information if the database
and database server are on the same system.

Send e-mail

The  automatic  export  of  data  and  alarms  by  e-mail  is  configured  in  this  window.  Further  information  is  described  in
“Configure e-mailing" .

Contact

Our address, telephone and fax number as well as our e-mail and Internet address are provided here.
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10.6 Use Application Guard
By  default,  the  FAG  Administrator  software  is  delivered  with  Application  Guard.  Application  Guard  automatically
monitors  in  the  background  whether  a  running  program  component  of  the  FAG  Administrator  software  is  working
properly.  For  example,  if  a  program  does  not  respond  for  10  minutes,  Application  Guard  restarts  it.  This  function  is
particularly useful for programs that are permanently in run mode, for example Data Link or Email Link.

The following options are available:

Start Application Guard Select the option Application Guard in Extras > Application Guard.

Check Application Guard: Select the option Check Application Guard in Extras > Application Guard.

Stop Application Guard Select the option Stop Application Guard in Extras > Application Guard.

Application Guard uses port  11111. Please make sure that this port  is  open in  the computer’s
firewall. If necessary, ask your system administrator.

10.7 Close

To close the program click File > Close.

You  can  only  close  the  program  when  it  is  not  in  run  mode.  To  stop  the  run  mode  the  user
currently logged in must have the required access rights (see "User management ").140
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11 Transfer Link

About Transfer Link

Transfer  Link  synchronises  Remote  Server  and  Data  Link  over  the  Internet,  i.e.  via  a  directory  in  the  Cloud.  The
mechanism is as follows:

On the Remote Server side – in write mode– it synchronised the local data directory of the Remote Server with the
directory in the Cloud. Once the Remote Server is finished writing the data, it removes the * protection from the local
directory. Then, Transfer Link synchronises this local directory with the directory in the Cloud. Only when all data have
been written and a complete list of contents created does Transfer Link unlock the folder in the Cloud and delete the
data in the local directory of the Remote Server.

In  read  mode,  Transfer  Link  synchronises  the  unlocked  directory  in  the  Cloud  with  the  local  data  directory  on  the
Data Link side. After synchronising, the data are deleted in the directory in the Cloud.

To use Cloud synchronisation, you must configure Transfer Link appropriately (see "Configure transfer tasks ").

Transfer  Link  is  included,  but  is  not  automatically  installed  in  the  default  installation.  The
installation is described in section "Installing other components" .

Transfer Link has two operating states:

In Run mode, Transfer Link performs the list of transfer tasks in order. Depending on the configuration, these may be
tasks in read mode and in write mode.

In Idle mode, Transfer Link is inactive and can be configured.

Start Transfer Link as follows

Click Start > Programs > FAG > Administrator> Transfer Link.

If  you invoke the program from the command line with  the /start  parameter,  the program
automatically starts up in run mode. Otherwise, you have to start run mode manually.

Once  the  program  has  launched,  the  program  icon  is  displayed  in  the  taskbar  information
area. If you minimise the program window, you can maximise it again by double-clicking this
icon.
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The Transfer Link program window is divided into the following sections:

Click the toolbar (directly below the menu bar) to call up the most important functions.

Current action displays the action currently being performed in run mode and the current state of Transfer Link.

The Transfer status view is displayed when you launch the program. Transfer messages displays the events. These
messages are also saved in the program’s log directory . Call up the context menu to copy the messages to the

clipboard and paste them in a text editor. Click  on the toolbar to delete the list of messages.

The meanings of the individual icons are:

Icon Meaning

 
Information about the current action (e.g. process sleeping).

 Transfer task error messages.

Select View > Configuration to configure new transfer tasks  and manage existing tasks. 

11.1 Configure transfer tasks
Switch to configuration view to configure transfer tasks:

Click Configuration in the View menu.

246
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The following options are available:

Task list

This section contains the current list of transfer tasks and the available actions:

: Click here to create a new task.

: Click here to edit the selected task or to save a task that you have just created or edited.

: Click here to delete the selected task.

: Click here to display an overview of all tasks and their details.

List entries: Click on a list entry:

o to edit this task.

o to view the configuration details of the task.

o to delete the task.

Task details

This  section  displays  the  configuration  details  of  the  selected  task.  If  you  click    or  create  a  new  task  you  can
configure the task here:

Write mode: Activate this option if you want this task to synchronise the local data directory of the remote server with
a directory in the Cloud.

Read mode: Activate  this  option  if  you  want  this  task  to  synchronise  the  directory  in  the  Cloud  with  the  local  data
directory monitored by Data Link.

Name: Enter the name of the task here. This name is displayed on the left of the task list.

Directory  type:  Select  the  directory  type  Remote  Data,  both  in  Write  mode  and  in  Read  mode.  This  selection
ensures that the specific data structure is also copied over during synchronisation.

Source directory:

o Write mode: Enter the local data directory of the remote server whose data you wish to write to the directory in the
Cloud.

o Read mode:  Enter the directory in the Cloud whose data you wish to write to the data directory monitored by Data
Link.

Target directory:

o Write  mode:  Enter  the  directory  in  the  Cloud  to  which  you  wish  to  write  the  data  from  the  data  directory  of  the
remote server. If you specify two or more directories here, the data are written to both of these directories.

o Read mode:  Enter the local data directory to which you wish to write the data from the Cloud and which you wish
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Data Link to monitor. If you specify two or more directories here, the data are written to both of these directories.

You can edit the number of possible target directories in the menu in Extras > Options  in the
General > Miscellaneous section.

Create a task in write mode

Configure a new task in write mode as follows:

Click  on the toolbar.

Activate the option Write mode in Task details.

Enter a name for the task and select the Remote Data option for Directory type.

Enter the local data directory of the remote server in Source directory.

Enter the directory in the Cloud to which you wish to write the data from the source directory in Target directory.

Click  on the toolbar to save the task.

Create task in read mode

Configure a new task in read mode as follows:

Click  on the toolbar.

Activate the option Read mode in Task details.

Enter a name for the task and select the Remote Data option for Directory type.

Enter the directory in the Cloud whose data you wish to write the local Target directory in Source directory.

Enter the local data directory to which you wish to write the data from the Cloud in Target directory. This is also the
directory monitored by Data Link.

Click  on the toolbar to save the task.

Edit task

Edit an existing task as follows:

Stop  Transfer Link if necessary.

Click on the appropriate entry in the Task list.

Click on  in the toolbar.

Edit the Task details on the right and then click  again to save your changes.

Delete task

Delete a task as follows:

Stop  Transfer Link if necessary.

Click on the appropriate entry in the Task list.

Click on  in the toolbar.

You can only edit transfer tasks when Transfer Link is in idle mode.
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11.2 Start/stop run mode

You can easily see the operating state of the program even if the program window is minimised.
The program icon in the taskbar information area changes colour depending on the state of the
program: the red square symbolises idle mode and the green arrow run mode. These icons are
also found in the program toolbar to start and stop run mode.

Start run mode

Proceed as follows to put Transfer Link in run mode:

Click on  in the toolbar.

Or:

Click Start in the Action menu.

Transfer Link enters run mode.

Stop run mode

If you wish to change the Transfer Link configuration, you must first stop run mode. To do this proceed as follows:

Click on  in the toolbar.

Or:

Click Stop in the Action menu.

Transfer Link enters idle mode.

11.3 Program settings

You can open the general program settings configuration window via the Tools > Options menu item.

A tree  view is  displayed  on  the  left-hand  side  of  the  window and  shows  a  range  of  configuration  options  arranged  in
groups. You can expand the view and configuration options by clicking the symbols in front of the groups.

Information on the individual configuration options is provided or input masks are displayed on the right-hand side of the
window.

General

Language

The Administrator  software can be displayed in  German,  English and Chinese.  If  you  select  a  different  language,  the
software restarts automatically. 

Miscellaneous

Write every message to the log file: Activate this option to write all messages to the log file. By default, only faults
are written to the log file.

Number of target directories: Specify here how many target directories are available when you configure a transfer
task .

Contact

Our address, telephone and fax number as well as our e-mail and Internet address are provided here.

11.4 Use Application Guard
By  default,  the  FAG  Administrator  software  is  delivered  with  Application  Guard.  Application  Guard  automatically
monitors  in  the  background  whether  a  running  program  component  of  the  FAG  Administrator  software  is  working
properly.  For  example,  if  a  program  does  not  respond  for  10  minutes,  Application  Guard  restarts  it.  This  function  is
particularly useful for programs that are permanently in run mode, for example Data Link or Email Link.

The following options are available:

Start Application Guard Select the option Application Guard in Extras > Application Guard.

Check Application Guard: Select the option Check Application Guard in Extras > Application Guard.

Stop Application Guard Select the option Stop Application Guard in Extras > Application Guard.
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Application Guard uses port  11111. Please make sure that this port  is  open in  the computer’s
firewall. If necessary, ask your system administrator.

11.5 Close

To close the program click File > Close.

You can only close the program when it is not in run mode.
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12 The E-MailRelay tool

About E-MailRelay Tool

Since 2014, various e-mail providers have stopped accepting unencrypted e-mails. With the aid of the E-MailRelay tool
you can forward the unencrypted e-mails sent by the FAG Administrator software with encryption. The E-MailRelay tool
acts as an e-mail server.

Install the E-MailRelay tool and configure all settings as described. Finally, configure e-mailing in the FAG Administrator
software.

12.1 Install and configure the E-MailRelay tool

12.1.1 User rights and write access

To install and run the E-MailRelay tool you need special access rights. In the event of problems with the security rules of
your system, please contact your system administrator.

User rights:

To install the E-MailRelay tool you need administrator rights on your system.

Tip: Install the tool with administrator rights and then switch back to a normal user.

Write access:

The tool saves settings and log files while it is running. You therefore need write access to the following directory: 

- c:\Program Files\

12.1.2 Installation

The installation file for the E-MailRelay tool is included on the CD-ROM enclosed. Alternatively, you can download the
tool from the following link: http://emailrelay.sourceforge.net/.
Please note: The E-MailRelay tool is only available in English.

Open the directory „E-MailRelay“.

Right-click on the file emailrelay-service.exe and select Run as Administrator from the context menu.

http://emailrelay.sourceforge.net/
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A wizard guides you through the steps of the installation:

Click on Next.

Agree to the licence terms by ticking the  I agree to the terms and conditions of the licence checkbox.

Click on Next.
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Please enter the following directory paths in the next step:

- Installation directory: c:\Program Files\emailrelay

- Spool directory: c:\Program Files\emailrelay\spool

- Configuration directory: c:\Program Files\emailrelay

Click on Next.

Select SMTP server and Synchronously for synchronous message forwarding.

Click on Next.
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Enter port 25 for the local server.

Click on Next.

The next step require further information about your e-mail account. In order to send e-mails to your e-mail address, it is
necessary to enter your login data and server settings. Please contact your provider for this information.

Enter the Host name (server address) and Port.

Activate Allow TLS/SSL encryption.
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Activate Supply authentication.

Select Login as the authentication method.

Enter your e-mail address as the user name in the Name box. 

Enter the Password that you chose when you set up your e-mail address.

Click on Next.

Untick the Write to the system log checkbox.

Select Verbose logging to allow detailed data log files.

Click on Next.
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Select All interfaces to monitor all of the computer’s network cards and IP addresses.

Click on Next.

Select At system startup to activate the E-MailRelay tool at system start-up.

Click Next.
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Click Finish to launch the installation.

Wait until the installation is finished. Then

click on Close to close the Setup Wizard.
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12.2 Start the E-MailRelay tool
Next time you start up the system, the E-MailRelay tool also starts. 

To start the E-MailRelay tool right away after installation, 

click  E-MailRelay in the Start menu.

Once the program has launched, the program icon is displayed in the taskbar information area:

12.3 Configure e-mailing in the Administrator
software
In order to be able to use the E-MailRelay tool you must configure the following settings in each Administrator software
tool that sends e-mails.

Configure e-mailing as follows:

Launch the FAG Administrator Configuration Manager as follows:

Click Options in the Extras menu.

Select Send e-mail.

Click Configure.

The “Configure” button opens the “E-mail options settings” dialog box where you can select and configure the method
used to send e-mails.

Please enter a valid e-mail address in the input box labelled “From” as the mail account to use for sending.

The e-mail address of the recipient is entered in the "To" input field.

Please enter the number of your service contract at "Contract number", if applicable.

You can also enter a custom text "Comment" input box to append to the e-mails created.

Click Configure to set the protocol for the program to send e-mails.
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Select the SMTP transfer method.

Enter the name of the e-mail server in "Host": localhost.

In "Timeout" you can define a time range after which to automatically stop trying to make a connection.

To test the connection to the mail server, click Test connection.

Click OK to save the settings.

Press OK to close the options dialog.

If necessary, repeat the above steps in other FAG Administrator software components that send e-mails (e.g. Data Link
and/or Notify Link).
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13 Questions and answers

This  chapter  provides  you  with  assistance  when  solving  problems  that  arise  in  conjunction  with  the  device  and
Administrator software. If  your problem is not described here or if  the help does not lead to the desired result,  please
contact our support (cf. Contact ). Have the following information ready when you are talking to support:

Serial number

Firmware version

Version of the Administrator software

Operating system used (which service pack?)

Are you using a multiplexer?

Communication path (serial, modem, TCP/IP)

Log files

Log files and log directory

The Administrator software logs information about system messages, database actions and import/export processes in
separate log files.

For  support  purposes  you  can  automatically  assort  these  log  files  in  Configuration  Manager  and  send  them  to  our
Support .

Assort log files

Click Assort log files in the Extras menu.

Select the data to save for support purposes.

If you select "data files", the file size may be too big to e-mail the log files.

Define the start date from which to assort the files and

select a directory to save to.

Click OK.

Depending  on  the  version  of  Windows  installed  on  your  system,  the  log  directory  is  at  the
following default location:

Windows  7,  Windows  8:  In  the  "Common  Application  Data”  directory,  e.g.  c:\Program  Data
\Condition Monitoring\Administrator\logs.

Open log folder

Click Open log folder in the Extras menu.

The log directory is displayed in Windows Explorer. You can open log files in a text editor.

A number of frequently occurring problems and possible solutions are described below.

A connection could not be established with the Dtect X1s device

Direct serial connection

Is the Dtect X1s switched on?

Is the serial cable connected to the Dtect X1s device and is the COM port selected in the Configuration Manager?

Is  the same baud rate  selected  in  the  configuration  manager  and  the  Dtect  X1s  device?  You can  select  this  when
establishing the connection.  If  you no longer know the baud rate setting for  the Dtect  X1s you can reset  it  to  9600
baud by performing a total system reset (switch on Dtect X1s with all  three buttons on the device pressed and wait
until "system reset" appears in the Dtect X1s display). Once the connection has been established you can adjust the
transfer speed by right-clicking the device in the tree and selecting Baud rate.

Does the PC and the cable used support hardware handshake (RTS/CTS)? If you are using a serial cable with only
three connected lines (earth, RX and TX), the handshake lines are open. Use a cable that also connects the RTS and
CTS lines  as  a  minimum requirement.  For  more  information,  refer  to  the  technical  appendix.  Cables  with  RTS and
CTS jumpers in the plug must not be used. If it is not possible to use RTS and CTS, please contact Support.
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Connection via modem

Are you using the correct cable between the Dtect X1s and the modem? For more information, refer to the technical
appendix. 

Has  the  modem  been  detected  by  the  Dtect  X1s?  Once  the  Dtect  X1s  device  is  switched  on  it  searches  for  a
connected  modem.  If  the  No  modem  found  message  appears  in  the  Dtect  X1s  Display,  the  modem  was  not
detected. Check whether the modem is switched on and also make sure that the serial cable between the Dtect X1s
device and modem is connected correctly. Some modems do not detect the baud rate automatically. The baud rate in
this case must be the same as the Dtect X1s.

Is  the  modem  initialization  string  correct?  Select  the  required  Dtect  X1s  device  from  the  tree  in  the  configuration
manager  and  click  the  Device  settings  tab  on  the  right.  The  AT  command  set  (initialization  procedure)  may  vary
depending on the manufacturer. Refer to the manual supplied with the modem to find out the correct AT commands. 

Connection via GSM modem

Is GSM modem  entered as the communication path? To check this, click the Dtect X1s device in the Configuration
Manager  tree,  select  the  device  settings  and  make  sure  the  Dtect  X1s  device  communicates  via  GSM  modem
option is selected.

Is  the correct  PIN entered in  the Dtect  X1s? The corresponding PIN for  the SIM card used  must  be  entered  in  the
device settings for the Dtect X1s device in the Administrator software.

Connection using TCP/IP via a COM server

Is the same baud rate set in the Dtect X1s and the COM server?

Has an IP address been entered in the COM server?

Are  you  using  dynamic  IP  addresses?  Fixed  IP  addresses  are  a  mandatory  requirement  for  the  COM  server  and
Remote Server PC. You should therefore deactivate the dynamic assignment of IP addresses on both sides (DHCP or
Bootp) and set the IP address manually.

Is  the  port  number  correct?  When  the  connection  is  established,  the  port  number  set  at  the  COM  server  must
correspond to the number in the Administrator software.

Have the serial data format and hardware handshake been configured correctly? The Dtect X1s data format is 1-8-1
(1 start bit, 8 data bits and 1 stop bit). The hardware handshake or RTS/CTS must be activated.

Has the correct  gateway been entered in  the COM server? If  the COM server  and  PC are  located  in  different  sub-
networks,  the  IP  address  of  the  gateway  must  be  entered  in  the  COM  server,  otherwise  it  will  not  be  possible  to
establish a TCP/IP connection.

Are  you  using  the  correct  network  cable?  You  will  need  a  cross-over  cable  if  you  wish  to  test  the  connection  by
connecting a PC or laptop computer directly to the COM server using a network cable. You will require a normal CAT5
network cable if both are connected to a hub or a switch.

All connection paths

Is the remote server running? When the Remote Server is running the button or menu for establishing the connection
is greyed out  and a manual  connection with  the Dtect  X1s cannot  be established.  Switch the Remote Server  off  to
establish a manual connection.

Is the Dtect X1s set for remote operation? Even if you have switched off the Remote Server the Dtect X1s may still
attempt to establish a connection with it. At this point it is not possible to establish a connection manually between the
Administrator software and the Dtect X1s. Wait for a short time before trying again.

Are  the  firmware  and  Administrator  versions  compatible?  The  FAG Administrator  version  4.10.2  is  compatible  with
Dtect X1 / Dtect X1s devices as of version 3.x and with ProCheck devices as of version 1.1.6.4.

No data is being sent from the Dtect X1s to the PC although the Remote Server was started.

Is  the  equipment  communicating  properly  in  general?  If  you  cannot  connect  manually  to  the  Dtect  X1s  device  the
remote connection will also not work. Further assistance is provided under "Connection could not be established with
the Dtect X1s ".

Have you specified a remote socket for the data connection with the Dtect X1s? Open the overview of remote sockets
via the Remote -> Configuration menu. A socket must be specified for each connection path between the Dtect X1s
and  the  PC.  If  this  is  not  the  case,  add  a  socket  (see  "Set  up  communication  with  device" .  Select  the  data
connection in this case (serial, modem, TCP/IP, etc.) to be used by the Dtect X1s device to transfer data.

Are the communication settings in the Dtect X1s correct? The correct telephone number of the Remote Server must
be specified at the modem. If a COM server is used, the correct IP address and port number of the Remote Server
must be entered in the COM server.

Have the correct remote triggers been specified? The circumstances under which the Dtect  X1s should establish a
connection with the Remote Server can be specified in the Remote tab in the monitoring configuration. The settings
in Device calls at are called remote triggers.

Has the maximum number of repeat attempts been reached? The number of times a Dtect X1s device attempts to call
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if a connection is not working can be specified in the device configuration in Max. connection retries on the “Global
settings”  tab. If  this number is reached for a specific  remote trigger,  this trigger will  no longer be able to  start  a
remote connection build-up process. If another trigger initiates a connection build-up process which is successful or a
manual connection with the Dtect X1s is established, the repetition counters are reset.

Is the Dtect X1s device included in the active database? The Remote Server can only accept calls from devices that
appear in the tree, in the configuration manager. If  your Dtect X1s is not in the tree insert  it  using the configuration
manager (see "Register a new device ").

A sensor type is not displayed in the sensor list

If a sensor is not displayed in the list of available sensor types, this may be because the firmware and software version
are not compatible.

Please update:

the Administrator software and all of its components (see "Update Administrator software" )

the database (see "Update database" )

the firmware of your Dtect X1s or ProCheck device (see "Update firmware" in the device manual).

The  sensor  types  “Particle  counter",  “Viscometer"  or  “Water  sensor"  are  available  as  of  the
following versions: 

Administrator software version 4.6.0.x

ProCheck firmware version 2.0.4.x

Dtect X1s firmware version 3.6.0.x.

A connected sensor is not working

Are the sensor and cable in working order? If you connected active sensors (ICP) via a multiplexer, the LEDs for all
channels to which sensors are connected should light up green (or orange). If the LED lights up red, the connecting
cable or sensor is defective.

Is  the  earth  and  shield  correctly  connected?  The  cable  contains  one  or  two  signal  lines  and  one  or  two  shields,
depending on the sensor used. Care must be taken to ensure that ground loops are avoided. If a shield is connected
to the sensor casing it must not be connected to the Dtect X1s input. 

No measuring data is displayed although the equipment is communicating properly

Is  the  validation  being  complied  with?  If  the  validation  is  outside  the  specified  range  during  measurement,  no
measuring  data  will  be  stored  and  measurements  will  be  discarded.  It  will  not  be  possible  to  read  out  data  as  no
measuring data will be available for this monitoring configuration and therefore no data will be displayed.

Did overloading occur during the measurement? If Overload is displayed by the Dtect X1s during the measurement,
the measurement was overranged and will be discarded. If this condition is permanent, the amplifier setting must be
modified under General information in the monitoring configuration. If this is set to Automatic, it may be possible to
eliminate the overloading by adjusting the settings manually. If overloading occurs when a manual amplifier setting is
used, the next lower setting should be used.

Database

The license for the database supplied limits the size of the database to 2 GB for legal  reasons. If  you require more
space you will have to obtain a corresponding Microsoft SQL Server license.

No e-mails are sent or received

Are the e-mail settings OK and has all the necessary information been entered? Please check the e-mailing settings.
You can find them in the software options in Send e-mail > Configure and in Email Link in the Configuration view

.

Is the network/Internet connection available? Please make sure that there is a connection to the network and Internet.

In  DataLink,  NotifyLink  and  Configurations  Manager  you  can  also  stop  and  restart  the  mail  server.  This  function  is
found in the Service menu  > Mail server maintenance.

View messages for e-mailing

All information about e-mail sending is logged in Konfigurations-Manager, in Data Link and in Notify Link.

Click Show mail server results in the Service menu.
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Questions and answers

You can filter the messages by "All results", "Only sent results" and “Unsent results". If an e-mail was sent successfully,

a latter icon  is displayed; an exclamation mark  indicates an unsent e-mail. The send date, recipient and subject of
the e-mail are also displayed. In the event of an error, a detailed error message is displayed.

If  there  are  any e-mails  in  “Unsent  results”  that  could  not  be  sent,  for  example  because  the  e-mail  settings  were  not
correct, you can automatically correct and resend them.

Click Mail server maintenance> Send not sent e-mails again in the Service menu.

Microsoft Outlook message when receiving e-mails

If  you  have  selected  MS  Outlook  as  the  transfer  mode  in  the  Email  Link  software  component  ,  the  following
message may be displayed in run mode: “A program is trying to access e-mail addresses you have stored in Outlook.
Do you want to allow this?". In this case you can allow access for a certain time. If this is not sufficient, please contact
Microsoft Support.

E-mails not retrieved properly through Microsoft Outlook

If  you  have  selected  Microsoft  Outlook  as  the  transfer  mode  in  the  Email  Link  software  component,  please  note  the
following:

Outlook always falls back on the current Outlook user profile of your system.

If  you  have  defined  a  default  profile  in  Outlook,  the  default  profile  defined  in  Outlook  is  always  used  regardless  of
which profile you specify in Email Link. So if you wish to use a profile in Email Link, there must not be a default profile
defined on the local computer!

Only local e-mails can be retrieved from the main Outlook e-mail folder (subfolders are not read).
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14 Contact

Manufacturer

FAG Industrial Services GmbH

Kaiserstraße 100

52134 Herzogenrath

Germany

Tel.: +49 (0) 2407 9149-66

Fax: +49 (0) 2407 9149-59

Support: +49 (0) 2407 9149-99

Internet: www.schaeffler.com/services

Contact: industrial-services@schaeffler.com

Please send postal mail directly to FAG Industrial Services GmbH!

Subsidiary of

Schaeffler Technologies GmbH & Co. KG

PO box 1260

97419 Schweinfurt

Germany

Georg-Schäfer-Straße 30

97421 Schweinfurt

Germany

Support

Tel.: +49 (0) 2407 9149 99

E-mail: support.is@schaeffler.com

http://www.schaeffler.com/services
mailto:industrial-services@schaeffler.com
mailto:support.is@schaeffler.com
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Device configuration    74

Display alarm lists    129

Export data    132

Filter measuring data    93

Hide/show outdated configurations    126

Import data    132

Log user in    46

manual ASCII export    137

Monitoring configuration    90

Program settings    148

Refresh tree view    47

Report    151

Run program    31

Show data    93

Show/set device time [Configuration Manager]    70

Speed-dependent alarm limits    119

Update/reset alarm state    132

Validation    114

View measuring data in Viewer    93

Configuration, invalid    125

Configure additional channels, Dtect X1 [Configuration Manager]    85

Configure additional channels, ProCheck [Configuration Manager]    83

Configure alarm limits [Configuration Manager]    152

Configure communication channel [Remote Server]    202

Configure communication, serial [Configuration Manager]    48

Configure D/A channels [Configuration Manager]    79

Configure GSM modem [Configuration Manager]    50

Configure landline modem [Configuration Manager]    50

Configure modem connection [Configuration Manager]    49

Configure serial connection [Configuration Manager]    48

Configure TCP/IP connection [Configuration Manager]    55

Configuring automatic ASCII export [Data link]    212

Connect device [Configuration Manager]    58

Connection parameters, configure [Configuration Manager]    71

Connection problems, FAQ    246

Connection, settings [Configuration Manager]    71

Contact    148

Copy device configuration [Configuration Manager]    125

Copy monitoring configuration [Configuration Manager]    125

Copying diagram information [Viewer]    187

Copying measuring data [Viewer]    187

Create bearing-related characteristic values    107

Create CM database [Configuration Manager]    37

Create database, database administration    37

Create device [Configuration Manager]    59

Create device configuration [Configuration Manager]    74

Create device configuration from device [Configuration Manager]    89

Create Dtect X1 report [Configuration Manager]    137

Create monitoring config. [Configuration Manager]    90

Create ProCheck report [Configuration Manager]    137

Create report [Configuration Manager]    137

Critical data file size    63

Cursor information [Viewer]    156, 161

Cursor settings [Viewer]    195

Cursor tools [Viewer]    168

Cursor type [Viewer]    161

Cursor, Positioning of base cursor [Viewer]    174

Cursor, properties [Viewer]    175

Cursor, revolutions cursor [Viewer]    182

- D -
Data [Configuration Manager]    91

Data directory [Remote Server]    204

Data file size settings    63

Data Link    

Automatic ASCII export    212

Change language    212, 213

Change user    212

Clear import messages    209

Close program    214

CM Database    208

Configure e-mailing    210

Database information    212

Export    212

Idle mode    208, 209

Manage directory    209

Minimise window    208

Monitor directory    208

Operating state    208

Program settings    212

Run mode    208, 209

Run program    208

Select CM database    209

Send e-mail    212

Start data import    209

Stop data import    209

Data Link [Data Link]    213

Data, ASCII export [Viewer]    189

Data, ASCII export, manual [Configuration Manager]    137

Data, automatic ASCII export [Data Link]    212

Data, bearing database (see bearing database)    142

Data, filter measuring data [Configuration Manager]    93

Data, filter view [Configuration Manager]    93



253

Index

Data, hide outdated [Configuration Manager]    126

Data, import database [Configuration Manager]    135

Data, import user data [Configuration Manager]    135

Data, measuring data [Configuration Manager]    135

Data, report [Configuration Manager]    137

Database (DB), Bearing database (see Bearing database)    142, 148

Database (DB), CM database (see CM database)    33

Database (DB), demo database    14

Database (DB), MS SQL    8, 9

Database (DB), User database [Remote Server]    206

Database administration    33, 35

Backup    40

Backup database    40

Create database    37

Database files    45

Database information    45

Database properties    44

Database version    45

delete    43

Detach database    39

History    45

Language    45

Log directory    44

Refresh view    44

Register database    38

Restore database    41

Select database    34

Settings    45

Update    42

Update database    42

Database administration, database [Configuration Manager]    38

Database full, CM database [Configuration Manager]    33

Database name, CM database [Configuration Manager]    37, 38

Deactivate password protection for devices [Configuration Manager]  
 58

Default number, Cursor properties [Viewer]    176

Delete database, database administration    43

Delete device [Configuration Manager]    60

Delete device configuration [Configuration Manager]    74

Delete e-mail(s) [Email Link]    221

Delete monitoring config. [Configuration Manager]    90, 91

Demodulation    23, 24, 25, 28, 64, 91, 93, 97, 100, 110, 121

Deregister database, database administration    39

Detach CM database from server [Configuration Manager]    39

Detail report [Configuration Manager]    137, 151

Device configuration, additional channels [Configuration Manager]    82

Device configuration, analog outputs [Configuration Manager]    87

Device configuration, change name [Configuration Manager]    74

Device configuration, configure D/A channels [Configuration Manager]
   79

Device configuration, device properties [Configuration Manager]    61

Device configuration, digital outputs [Configuration Manager]    86

Device configuration, find current [Configuration Manager]    90

Device configuration, module overview [Configuration Manager]    61

Device configuration, overview [Configuration Manager]    75

Device configuration, ProCheck [Configuration Manager]    75

Device configuration, refresh data [Configuration Manager]    46

Device configuration, remote settings [Configuration Manager]    71

Device configuration, sensor properties [Configuration Manager]    80

Device configuration, settings [Configuration Manager]    77

Device configuration, slot overview [Configuration Manager]    61

Device log [Configuration Manager]    69

Device password [Configuration Manager]    56

Device passwords [Configuration Manager]    47, 56

Device properties, device config. [Configuration Manager]    61

Device settings [Configuration Manager]    63

Device version [Configuration Manager]    70

Device, device version [Configuration Manager]    70

Device, firmware version [Configuration Manager]    70

Device, read out log file [Configuration Manager]    69

Device, set up communication [Configuration Manager]    47

Device, show/set time [Configuration Manager]    70

Devices, report [Configuration Manger]    137

Diagram information [Viewer]    161

Diagram information bar [Viewer]    161

Diagram settings [Viewer]    194

Diagrams, displaying several [Viewer]    162

Difference cursor [Viewer]    170

Digital outputs, ProCheck [Configuration Manager]    86

Directory, Data directory [Remote Server]    201, 204

Directory, import directory [Data Link]    208

Directory, monitor [Data Link]    208

Directory, refresh view [Data Link]    209

Displaying frequency bands [Viewer]    183

Displaying maximum values [Viewer]    185

Download e-mail(s) manually [Email Link]    220

Dtect X1 connect with password protection [Configuration Manager]  
 57

Dtect X1, communication [Configuration Manager]    47

Dtect X1, configure device for the Remote Server    124

Dtect X1, messages [Configuration Manager]    51

Dtect X1, password protection [Configuration Manager]    56

Dtect X1, validation [Configuration Manager]    114

Dtect X1s, device properties [Configuration Manager]    61

Dtect X1s, manage device(s) [Configuration Manager]    59

Dtect X1s, sensor type [Configuration Manager]    61

- E -
Edit device passwords [Configuration Manager]    58

Edit rotational speed    93

Email Link    

Automatically start receiving e-mails    219

Automatically stop receiving e-mails    219

Change database    219

Change language    221, 222

Change user    221

Clear messages    215

Close program    223

configure    217

Database information    221

Delete e-mails    221

Download e-mails manually    220

Idle mode    219

Import e-mails manually    220

Import status    215

Import view    215

Limit runtime    222

Manage e-mails    220



254

Email Link    

Messages    215

Minimise window    215

Operating state    215

Program settings    221

Receive options    217

Refresh e-mails    220

Run mode    219

Run program    215

E-mail(s), configuration [Configuration Manager]    151

E-mail(s), configure sending [Data link]    210

E-mail(s), configure sending [Notify Link]    226

E-mail(s), receive options [Email Link]    217

E-mail(s), send automatically [Data Link]    210

E-mail(s), send data as e-mail [Configuration Manager]    134

E-service E-mail settings    67

E-service, send data [Configuration Manager]    134

Ethernet, ProCheck settings [Configuration Manager]    66

Export and send data automatically    67

Export bearings [Configuration Manager]    145

Export data [Configuration Manager]    132, 133

Export data by e-mail [Configuration Manager]    151

Export Wizard, export data [Configuration Manager]    133

Export X1 data [Viewer]    189

Export, export bearings (see Bearing database)    145

Exporting diagram(s) [Viewer]    187

Exporting, diagram(s) [Viewer]    187

- F -
Factor, ProCheck [Configuration Manager]    83

FAQ    246

Fault-tolerant search, cursor properties [Viewer]    176

FFT diagram, settings [Viewer]    194

FFT settings, ProCheck [Configuration Manager]    103

FFTs (Fast Fourier Transformation) [Viewer]    155

Filter demodulation signal    101

Filter measuring data [Configuration Manager]    93

Filter raw signal    101

Filter settings, alarm lists [Configuration Manager]    129

Filter settings, measuring data [Configuration Manager]    93

Filter view, data [Configuration Manager]    93

Firmware, retrieve version from device [Configuration Manager]    70

Firmware, version, FAQ    246

Fixed windows    101

Free zoom [Viewer]    166

Frequency bands for monitoring in frequency range [Configuration
Manager]    112

Frequency domain monitoring, overview    25

Frequency relation, Dtect X1 [Configuration Manager]    85

Frequency relation, ProCheck [Configuration Manager]    83

Frequently asked questions, FAQ    246

- G -
General settings, Dtect X1 [Configuration Manager]    77

Global e-mail recipient    151

- H -
Harmonics [Viewer]    185

Harmonics cursor [Viewer]    172

Help, free support    250

Highest peaks [Viewer]    185

History (see CM database)    150

Horizontal zoom [Viewer]    167

Hotline (free support)    250

HS cursor [Viewer]    173

Hysteresis [Configuration Manager]    84

- I -
Idle mode [Data Link]    208, 209

Idle mode [Email Link]    219

Idle mode [Notify Link]    224, 228

Idle mode [Remote Server]    204

Idle mode [Transfer Link]    235

Import bearings [Configuration Manager]    145

Import data [Configuration Manager]    132, 135

Import e-mail(s) manually [Email Link]    220

Import log    135

Import measuring data [Configuration Manager]    135

Import user data [Configuration Manager]    135

Import users [Configuration Manager]    135

Import, import bearings (see Bearing database)    145

Input channel number, Dtect X1 [Configuration Manager]    76

Insert image, device config. [Configuration Manager]    89

Insert image, monitoring config. [Configuration Manager]    125

Insert image, planning level [Configuration Manager]    46

Install bearing database    16

Install CM database    14

Install CM-Installer    20

Install Flash Updater    20

Install MS SQL database software    14

Install Net Utility    20

Install software    9

Installation method    12

Installation, CM-Installer    20

Installation, Flash Updater    20

Installation, Net utility    20

Invalid configuration    125

Invalid device configuration    74

Invalid values    125

ISO 10816    126

ISO units [Viewer]    193

- K -
Keyboard shortcuts [Viewer]    196

Keyboard zoom [Viewer]    168

Kinematic frequencies [Viewer]    184

- L -
LDF file    44

Load device configuration from device [Configuration Manager]    89

Log    246

Log directory, database administration    44

Log directory, FAQ    246

Log file, device log messages [Configuration Manager]    69

Log files    

Import data    135



255

Index

Log in user [Configuration Manager]    46

Login    46

Login dialog    46

Login, user login [Configuration Manager]    46

- M -
Mail server messages    140, 246

Main channels [Configuration Manager]    100

Manage bearings [Configuration Manager]    106, 142, 144

Manage device [Configuration Manager]    59, 60

Manage directory [Data Link]    209

Manage e-mails [Email Link]    220

Manage groups (see Bearing database)    146

Manage manufacturers (see Bearing database)    147

Manage user rights [Configuration Manager]    140, 142

Maximal data file size    63

Maximum value [Viewer]    166

MDF file    44

Measure cursor [Viewer]    169

Messages [Data Link]    209

Messages [Remote Server]    205

Messages from device log [Configuration Manager]    69

Micro steps, cursor properties [Viewer]    176

Modem, ProCheck settings [Configuration Manager]    66

Modifying the appearance of a diagram [Viewer]    163

Module overview, device configuration [Configuration Manager]    61

Monitored directory (see Directories)    209

Monitoring config., change name [Configuration Manager]    90, 91

Monitoring config., data view [Configuration Manager]    91

Monitoring config., report [Configuration Manager]    137

Monitoring configuration [Configuration Manager]    90

Monitoring types, overview    25, 30

Mouse control [Viewer]    165

MS SQL database programs    8, 9

MS SQL, information    9

MSDE, information    9

Multiplexer (MUX) [Configuration Manager]    61, 80

Multiplexer (MUX), FAQ    246

- N -
Next call is expected in    67

Next maximum, cursor properties [Viewer]    175

Normal user and default password, database    34

Notify Link    

Change database    225

Change language    229

Change user    228

Close program    230

CM Database    224

Configure e-mailing    226

Database information    229

Idle mode    224, 228

Minimise window    224

Operating state    224

Program settings    229

Run mode    224, 228

Run program    224

Send e-mail    229

Notify Link E-mail settings    67

- O -
Offset, ProCheck [Configuration Manager]    83

Online systems, introduction    24

Operating state [Data Link]    208

Operating state [Email Link]    215

Operating state [Notify Link]    224

Operating state [Remote Server]    201

Order analysis [Configuration Manager]    100, 110

Order analysis, introduction    28

Order analysis, requirements    28

Orders    28

Outdated configuration    126

Outlook, warning message, FAQ    246

Overview, device configuration [Configuration Manager]    75

- P -
Particle counter settings    126

Password protection for devices [Configuration Manager]    56

Password protection, Dtect X1 [Configuration Manager]    57

Password protection, ProCheck [Configuration Manager]    57

Password, Settings [Configuration Manager]    63

Planning level [Configuration Manager]    31

Positioning of base cursor [Viewer]    174

Power user password (see Passwords)    63

Power user password [Configuration Manager]    56

Predefined characteristic values    110, 126, 154

Preferred units [Viewer]    193

ProCheck communication [Configuration Manager]    47

ProCheck connect with password protection [Configuration Manager]  
 57

ProCheck, Alarm conditions [Configuration Manager]    63

ProCheck, Communication [Configuration Manager]    64

ProCheck, Configure connection [Configuration Manager]    64

ProCheck, Device properties [Configuration Manager]    61

ProCheck, manage device(s) [Configuration Manager]    59

ProCheck, module overview [Configuration Manager]    61

ProCheck, password protection [Configuration Manager]    56

ProCheck, Profibus module [Configuration Manager]    61

ProCheck, Slot overview [Configuration Manager]    61

Profibus channels, device configuration [Configuration Manager]    61

Profibus module, device configuration [Configuration Manager]    61

Protocol    246

- Q -
Questions and answers, FAQ    246

- R -
Raw signal    24, 25, 28, 64, 91, 93, 97, 100, 110, 121

Reboot device [Configuration Manager]    70

Refresh e-mails [Email Link]    220

Register database, database administration    38

Release memory, CM database [Configuration Manager]    33

Remote mode [Data Link]    209

Remote mode [Email Link]    219

Remote mode [Remote Server]    204

Remote operation, communication [Configuration Manager]    71



256

Remote Server    

Change language    206

Close program    207

Communication channel    202

Data directory    204

Idle mode    204

Log in as / switch user    206

Messages    205

Minimise window    201

Operating state    201

Remote mode    204

Run mode    204

Run program    201

start    204

stop    204

User management    206

Remote trigger, FAQ    246

Remote, monitoring configuration [Configuration Manager]    73

Remote, ProCheck settings [Configuration Manager]    66

Remote, settings [Configuration Manager]    71

Remove directory [Data Link]    209

Report [Configuration Manager]    137

Report, alarm list report [Configuration Manager]    129

Report, alarm report [Configuration Manager]    129

Report, logo [Configuration Manager]    151

Report, settings [Configuration Manager]    151

Reset alarm(s) [Configuration Manager]    132

Restore CM database [Configuration Manager]    41

Restore database, database administration    41

Restore e-mails    140, 249

Restore not sent e-mails    140, 249

Retrieve measuring data [Configuration Manager]    58

Revise bearing [Configuration Manager]    106

Revolutions cursor [Viewer]    161, 173

Rights, assign user rights [Configuration Manager]    142

RMS value, effective value    25

RMS/AMV cursor [Viewer]    171

Rotational speed settings    104, 114

RPM signal    28

Run mode [Data Link]    208, 209

Run mode [Email Link]    219

Run mode [Notify Link]    224, 228

Run mode [Remote Server]    204

Run mode [Transfer Link]    235

- S -
Save device configuration [Configuration Manager]    74

Saving options, monitoring configuration [Configuration Manager]  
 121

Saving, diagram(s) [Viewer]    187

Search bearing [Configuration Manager]    143

Select CM database [Configuration Manager]    34

Send data as e-mail [Configuration Manager]    134

Send data automatically as e-mail    135

Send device configuration to device [Configuration Manager]    90

Send e-mail(s), data automatically    135

Send non-response alarms    67

Sensitivity, Dtect X1 [Configuration Manager]    85

Sensor / filter combination [Configuration Manager]    101

Sensor / filter settings [Configuration Manager]    100

Sensor defect    248

Sensor is not displayed, FAQ    246

Sensor type, Dtect X1 [Configuration Manager]    76, 82, 97

Sensor type, Dtect X1s [Configuration Manager]    61

Sensor type, ProCheck [Configuration Manager]    80

Sensors [Configuration Manager]    93, 100

Sensors, introduction    24

Sensors, properties [Configuration Manager]    80

Serial, ProCheck settings [Configuration Manager]    66

Server, server name    34

Service    148

Service, ASCII export [Configuration Manager]    137

Service, manual service [Configuration Manager]    142

Service, remote service [Configuration Manager]    142

Service, report [Configuration Manager]    137

Set baud rate [Configuration Manager]    48

Set device time [Configuration Manager]    70

Set up communication [Configuration Manager]    47

Set up communication, modem [Configuration Manager]    49

Set up communication, password protection [Configuration Manager]  
 56

Set up communication, TCP/IP [Configuration Manager]    55

Set up modem [Configuration Manager]    51

Set up planning level [Configuration Manager]    46

Show alarm list... [Configuration Manager]    129

Show FFTs [Viewer]    161

Show peaks, cursor properties [Viewer]    175

Show selection information    31

Sideband cursor [Viewer]    172

Sidebands [Viewer]    186

Signal distribution [Viewer]    180

Signal settings [Viewer]    195

Slot overview, ProCheck [Configuration Manager]    61

Software installation method    12

Software installation, system requirements    9

Software, overview    8

Sonagram, waterfall charts [Viewer]    189

Speed-dependent alarm limits [Configuration Manager]    119

Speed-dependent alarms, speed-dependent alarm limits ProCheck
[Configuration Manager]    112

SQL server (MS SQL server)    34, 38

Start/stop automatic e-mails [Data Link]    209

Status report, device log messages [Configuration Manager]    69

Support    148

Support (free of charge)    250

System requirements    9

- T -
Time domain monitoring [Configuration Manager]    98

Time domain monitoring, overview    30

Time signal    24

Time signal diagram, settings [Viewer]    195

Toolbar [Viewer]    157

Tools [Viewer]    158

Transfer Link    

Application Guard    235

Change language    235

Close program    236



257

Index

Transfer Link    

configure    232

Idle mode    235

Program settings    235

Run mode    235

Transfer tasks    232

Tree item counter [Configuration Manager]    148

Trend diagram, settings [Viewer]    195

Trend filtering [Viewer]    181

Trigger [Configuration Manager]    84

Triggering, introduction    30

- U -
Uninstalling software    22

Units [Viewer]    193

Units of measurement [Viewer]    193

Update    21

Update alarm(s) [Configuration Manager]    132

Update CM database [Configuration Manager]    42

Update database, database administration    42

Update script, CM database [Configuration Manager]    42

Update software    21

Update tree view [Configuration Manager]    46, 47

Update, database    42

US units [Viewer]    193

User    46

User (Auto-login)    148

User database [Remote Server]    206

User management [Configuration Manager]    140

User management [Remote Server]    206

User password (see Passwords)    63

User password [Configuration Manager]    56

user permissions, restricted    34

User rights    10

User rights for software installation    9

User, user list [Configuration Manager]    46

Users, assign rights [Configuration Manager]    142

- V -
Validation [Configuration Manager]    114

Validation settings [Configuration Manager]    103

Validation, introduction    30

Version    246

Vertical zoom [Viewer]    167

Vibration monitoring, introduction    6, 23

View measuring data in Viewer    96

Viewer    

Acceleration signal    163, 192

Add bearing    182

ASCII export    189

Base cursor    168, 174

Calculate spectrum    169

Carrying out a fault analysis    198

Change diagram boundaries    179

Characteristic value within the Trend diagram    183

Copying diagram information    187

Copying diagrams    187

Copying measuring data    187

Cursor information    156, 161

Cursor properties    175

Cursor tools    168

Cursor type    161

Cursor, program settings    195

Defining diagram dimensions    194

Diagram    156

Diagram display    161, 163

Diagram information    161

Diagram information bar    156, 161

Diagram settings    194

Difference cursor    170

Displaying harmonics    185

Displaying several diagrams    162

Displaying sidebands    186

Edit rotational speed    179

FFT diagram, settings    194

FFTs (Fast Fourier Transformation)    155

Free zoom    166

Frequency bands    183

Harmonics cursor    172

Harmonics cursor, properties    176

Highest peaks    185

Horizontal zoom    167

HS cursor    173

HS cursor, properties    177

Inserting comments    184

Introduction    155

Keyboard shortcuts    196

Keyboard zoom    168

Kinematic frequencies    184

Maximum    166

Maximum values (Maxima)    185

Measure cursor    169

Menu bar    157

Modifying the appearance of a diagram    163

Mouse control    165

Program settings    192

Revolutions cursor    173

Revolutions cursor, properties    178

RMS/AMV cursor    171

Saving measuring data    187

Show FFT    192

Show FFTs    161

Sideband cursor    172

Sideband cursor, properties    177

Signal distribution    180

Signal settings    195

Synchronous zooming    165

Time signal diagram, settings    195

Time signals    155

Toolbar    157

Tools    156, 158, 179

Trend data    155

Trend diagram, settings    195

Trend filtering    181

Units    193

Using the mouse to control the cursor    165



258

Viewer    

Using the mouse to control the zoom function    165

Vertical zoom    167

Viewing measuring data    93, 96

Waterfall charts    189

Work interface    156

Zoom section    168

Zoom tools    166

Viewer (see Viewer)    96

Virtual channels, device configuration [Configuration Manager]    61

- W -
Warning message “lack of memory” (see CM database)    33

Warning message from MS Outlook, FAQ    246

Waterfall charts [Viewer]    189

Window options, Dtect X1 [Configuration Manager]    116

Window selection [Configuration Manager]    100

Windows authentication, database    34

Windows, Frequency bands ProCheck [Configuration Manager]    112

Write access    10

- Y -
Yellow highlight    125

- Z -
Zoom [Viewer]    165

Zoom section [Viewer]    168

Zoom tools [Viewer]    166



259



 


	Introduction
	About the Administrator software
	Installing the software
	System requirements
	User rights and write access
	Installation
	Administrator Setup Wizard
	CM database Setup Wizard
	Install additional components

	Update
	Update on Administrator version 4.10.2

	Uninstalling

	Vibration monitoring with online monitoring systems
	The principle
	The hardware concept
	Monitoring types in the frequency domain
	Monitoring with broad band characteristic values
	Monitoring with fixed frequency bands and fixed alarm thresholds
	Monitoring with fixed frequency bands and speed-dependent alarm thresholds
	Monitoring with speed-dependent frequency bands and alarm thresholds

	Order analysis
	Monitoring types in the time domain
	Triggering and validation with auxiliary signals

	Configuration Manager
	Manage databases
	Select CM database on server
	Change CM database
	Database administration
	Create database
	Attach database (register)
	Detach database (deregister)
	Backup database
	Restore database
	Update database
	Delete database
	Refresh view
	Log files
	Database properties
	Settings


	Log in as / switch user
	Set up planning level
	Set up device communication
	Direct serial connection
	The modem connection
	Connection with control computer via fixed network modem
	Connection via GSM modem at control computer
	Set up modem at device

	TCP/IP connection
	Password settings
	Connect to password-protected device
	Edit passwords
	Activate password protection
	Deactivate password protection


	Connection to a device
	Manage devices
	Device properties
	Device settings
	Communication settings
	Advanced settings
	Read out status report
	Time
	Firmware version
	Restart

	Configure device for remote server
	Communication/connection parameters
	Device configuration
	Monitoring configuration

	Device configuration
	Overview
	General settings
	D/A channels
	Sensors
	Additional channels
	Digital outputs
	Analog outputs
	Image
	Additional information
	Import device configuration from device
	Send device configuration to device
	Search for device configuration

	Monitoring configuration
	Data
	Working with measured data

	General details
	Main channels
	Additional channels
	Bearings
	Components
	Characteristic values
	Validation
	Window options
	Alarm thresholds
	Speed-dependent alarm thresholds
	Memory options
	Remote
	Image
	Additional information

	Copy configuration(s)
	Invalid configurations
	Outdated configurations
	Predefined characteristic values
	Automatic alarm level adjustment
	Alarm list management
	Alarm status
	Data export/import
	Export data
	Export and send data (E-service)
	Export and send data automatically
	Import data

	ASCII export
	Create reports
	Mail server messages
	User management
	Create/modify user
	Assign rights

	Bearing database
	Search bearing
	Add bearing
	Edit / delete bearings
	Export bearings/import bearings
	Manage groups
	Add manufacturer
	Edit / delete manufacturers
	Select different bearing database
	Close

	Program settings
	General
	Database
	Report
	Send e-mail
	Configure alarm limits
	Bearing related characteristic values

	Exit

	The FAG Viewer
	About this software
	The work interface
	Work interface areas
	Toolbar
	Tools
	Diagram display
	Cursor and measuring information
	The diagram information bar

	Working with the FAG Viewer software
	Displaying several diagrams simultaneously
	Modifying the appearance of a diagram
	Using the mouse to control the cursor or zoom function
	Zoom tools
	Cursor tools
	Positioning of base cursor
	Modify cursor properties
	Other tools
	Using the diagram information bar
	Exporting diagrams and information
	ASCII export
	Waterfall charts
	Program settings

	Keyboard shortcuts
	Carrying out a fault analysis

	The Remote Server
	Configure communication channels
	Data directory
	Start/stop run mode
	Messages
	User management
	Change language
	Close

	Data Link
	Working with directories
	Change CM database
	Start/stop run mode
	Configure automatic e-mailing
	Enable automatic data export (ASCII)
	Change user
	Program settings
	Use Application Guard
	Close

	Email Link
	Define receive settings
	Change CM database
	Start/stop run mode
	Manage e-mails in mailbox
	Change user
	Program settings
	Use Application Guard
	Close

	The Notify Link
	Change CM database
	Configure automatic e-mailing
	Start/stop run mode
	Change user
	Program settings
	Use Application Guard
	Close

	Transfer Link
	Configure transfer tasks
	Start/stop run mode
	Program settings
	Use Application Guard
	Close

	The E-MailRelay tool
	Install and configure the E-MailRelay tool
	User rights and write access
	Installation

	Start the E-MailRelay tool
	Configure e-mailing in the Administrator software

	Questions and answers
	Contact

